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Intended use of the system 

The BodyTom 64 system is intended to be used for x-ray computed 
tomography applications for anatomy that can be imaged in the 85cm 
aperture.  The CT system is intended to be used for both pediatric and adult 
imaging and as such has preset dose settings based on weight and age.  The 
CT images can be obtained either with or without contrast.  

The BodyTom 64 system can be used for low dose lung screening.  The 
screening must be performed in compliance with the approved and 
established protocols as defined by professional medical societies.  

*Please refer to clinical literature, including the results of the National Lung 
Screening Trial (N. Engl J Med 2011;365:395-409) and subsequent literature 
for further information.  

BodyTom 64 Clinical benefit 

Computed Tomography (CT) provides real time imaging of bone, soft tissue 
and blood vessels that can provide detailed information to diagnose, plan 
treatment for, and evaluate many conditions in adults and children. 
Additionally, the detailed images provided by CT scans may eliminate the 
need for exploratory surgery. 

Consumer information 

Proprietary rights 

NeuroLogica® and BodyTom 64® are registered trademarks of NeuroLogica 
Corporation, a subsidiary of Samsung Electronics Co., Ltd., in the United 
States, other countries, or both.  Catphan® is a registered trademark of 
Phantom Laboratory, Inc.  ACR Appropriateness Criteria® is a registered 
trademark of the American College of Radiology.  Image Gently® is a 
registered trademark of Society for Pediatric Radiology.    Teflon® is a 
registered trademark of E.I. DuPont and Company.  TB Quat™ is a trademark 
of ABC Compounding Co.  Wex-cide™ is a trademark of Wexford Labs, Inc., 
product number Wexcide128. 
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Legal disclaimer 

This user manual is intended as a guide for material supplied by NeuroLogica 
Corp.  It provides the operator with necessary information to carry out 
specific procedures and maintain NeuroLogica produced equipment.  Use this 
manual in conjunction with instruction and training supplied by qualified 
NeuroLogica personnel. 

Any information or descriptions contained in this manual may not be 
reproduced and released to any of the general public or used in conjunction 
with other professional instruction without written consent of NeuroLogica 
Corp., USA – a subsidiary of Samsung.  Direct any written inquiries to the 
appropriate address found in the section “Contact information” on page 24. 

Unauthorized copying of this user manual may not only infringe copyright but 
also reduce the ability of NeuroLogica Corp. to provide accurate and up-to-
date information to users: limited and restricted operators and 
administrators. 

This user manual, though complete and accurate, may not provide answers to 
undocumented changes or unexpected results that could occur from system 
anomalies. 

Contact information 

Keep user information readily available to contact Customer Service about 
general assistance or reporting on serious incidents (should they occur). 

In the case of a serious incident or adverse event, please notify NeuroLogica 
at the below contact information and establishments local competent 
authorities. 

To provide any comments, suggestions, or corrections to this user manual, 
write to and include chapter title and page number: 

NeuroLogica Corporation 

Customer Service  14 Electronics Avenue, Danvers, MA 01923 USA 

USA and Canada 1-888-564-8561 

International  1-978-564-8561 

Email support@neurologica.com 

If you have any questions about faults or errors on the system, battery or 
charge issues, or mechanical issues with the scanner, contact a Technical 
Representative. 
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If you have questions about the clinical use of your system, building protocols, 
creating MPRs, imaging artifacts, creating a clinical workflow or process, 
logging in or access issues, and general usage of the system, contact 
Customer Service. 

Winckels Medical 
Devices Expertise  

Australian Sponsor Brazilian Authorized 
Distributor 

Europe Bergerweg 18 
6085 AT Horn  

The Netherlands 

Level 8/15 Talavera 
Road 
PO Box 646 

North Ryde NSW 2113 
Australia 

M +61 (0)412 563 016 
Tel 

T +61 (0)2 8114 1535 
Tel 

F +61 (0)2 8114 1599 
Tel 

Customer Service: 
1-800 060 168 

 

VR Medical 
Importadora e 
Distribuidora de 
Produtos Médicos Ltda 

Rua Batataes, 391, 
conjs. 11, 13 e 8º andar 

CEP: 01423-010 – São 
Paulo 

CNPJ: 
04.718.143/0001-94 

Resp. Técnica: Dra. 
Cristiane Aparecida de 
Oliveira Aguirre- CRF-SP 
21079 

Registro ANVISA nº: 
80102511464 

 

+31 (0)475 582285 Tel 

+31 (0)475 582278 Fax 

 

 

 

 

Damage in transportation 

Closely examine all packages at the time of delivery.  If you see damage, 
notate “damage in shipment” on all copies of the freight bill before you 
accept or sign for delivery (by the facility receiving agent). 

Whether damage is noted immediately or concealed (noticed after delivery), 
damage must be reported to carrier immediately upon discovery, or within 14 
days after receipt, and content and containers held for inspection by carrier. 

Keep in mind – the transportation company will not pay a claim for damage if 
an inspection is not requested within the 14-day period.

 

tel:%2B61%20%280%29412%20563%20016
tel:%2B61%20%280%292%208114%201535
tel:%2B61%20%280%292%208114%201599
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User requirements 

The equipment can only be operated by users who have received professional 
medical education and training, such as radiologic technologists, physicians, 
radiologists, and other medical specialists. 

Users should be trained professionals who are certified to operate such 
systems before scanning or diagnosing patients.  This training must include 
medical and x-ray education, as well as NeuroLogica applications training. 

Everyone that uses this equipment must read, understand, and follow all 
instructions, precautions, and warnings. 

Keep this user manual near the equipment.  It is important to review the 
procedures and safety precautions periodically. 

Essential Performance 

The BodyTom 64 has the following essential performance factors mitigated by 
design:  

• Over Radiation protection 

• Re-scan prevention 

• Stray Radiation exposure prevention 

• Diagnostic performance 

About this user manual 

The instructions in this user manual describe how to use the NeuroLogica 
BodyTom 64 Computed Tomography (CT) system, manufactured by 
NeuroLogica Corp.  BodyTom 64 is the trade name for the CT system and 
NL4100 is the device model.  

This user manual does not provide medical explanations but does suggest 
potential applications for some of the software features.  This user manual 
describes potential safety problems and how to avoid them. 

Anyone who operates this system should have received training before 
attempting to scan or diagnose patients, to include medical and x-ray 
education, as well as NeuroLogica applications training. 

This manual is made available in electronic format to the customer as part of 
each product delivery. 

For electronic manuals, please go to: Forms.samsungneurologica.com. 
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Click on “Downloads” and choose “CT Manuals”. The site will ask for the serial 
number of your product and a password. The password can be provided from 
Field Service. 

Translation of this manual is available for any country that does not allow for 
English labeling. Please reach out to NeuroLogica directly if translation is 
required. 

Identified symbols and system classifications 

The specifications and details of this user manual may change to improve the 
product or to enhance its performance. 

Throughout this user manual, a yellow triangle with a black border and 
exclamation point is used to draw attention to those conditions or situations 
that fit one or more of the following criteria, which are definitions from ANSI 
Z535.5: 

 
DANGER Indicates a hazardous situation, which if not avoided will 

result in death or serious injury. 

 
WARNING Indicates a hazardous situation, which if not avoided could 

result in death or serious injury. 

 
CAUTION Indicates a hazardous situation, which if not avoided could 

result in minor or moderate injury. 

Conventions used in this user manual 

Table 1: Conventions used in this user manual 

Convention Use 

Commands to 
perform actions 

To perform a string of commands, this user 
manual will present them as follows: 
Customize > System. 

This means click Customize and then click 
System. 

Bold  

When content refers to commands, windows, 
screens, dialog boxes, popups, tabs, buttons, 
options, keyboard keys, statuses, and modes, 
these items appear in bold for faster 
identification, especially in a procedure. 

Italic 
Identifies a word that is emphasized for your 
attention. 
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Convention Use 

Numbered steps 

Numbered paragraphs represent sequential 
steps that require you to take the action in 
the sequence provided – unless otherwise 
instructed. 
Procedures that are numerical mean that the 
sequence is important to follow.  You may 
perform some procedures out of the 
recommended sequence; however, the 
results may vary. 

Note 

The appearance of a note is as such: 

Note  Indicates addit ional information to 
help you operate this product .  

Hyperlink (an 
electronic cross-
reference) 

A cross reference appears in the electronic 
(.pdf) user manual as a hyperlink.  To retrieve 
an electronic copy of this user manual (in 
.pdf), click Help > User Manual from the 
workstation. 
A hyperlink is a quick way to go to another 
area of the user manual with a simple click.  
Hyperlinks appear like this: “Understanding 
the types of users” on page 98.  In this case, 
hover the mouse pointer over the gray 
hyperlink text.  Hold the Ctrl key on your 
keyboard and click the mouse button.  After 
you click the hyperlink, the hyperlink takes 
you to the referenced area in the user 
manual. 

Click vs right-click 

In this user manual, click means to press the 
left mouse button.  This user manual never 
says ‘left click’ as it is assumed that is the 
traditional way to click; however, it does point 
out when to right click the mouse button. 

Understanding the use of “you” in this user manual 

Unless specifically noted, the implied “you”, in this user manual, is the 
user/operator.  It is assumed users/operators are certified and medically 
trained personnel, qualified to use these systems.   

The following identifies those actions each user is permitted to perform: 

Administrator 
Full access to the system and its configurations.  
Can create protocols, User ID’s, and passwords, 
as well as access all functions of the system. 
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Limited operator 

Modified access to the system.  Users with 
Limited access can modify protocols during 
scanning but cannot create and save protocols; 
has no access to system configurations. 

Restricted operator 

Users with Restricted access can scan with the 
system but are unable to make any changes to 
protocol parameters while scanning, they also 
have no access to system configurations. 

Active and inactive objects 

When a menu command, option, button, tab, field, is gray, the item is not 
active or enabled.   When an item is gray, it can mean additional or required 
tasks must be completed first or you do not have permission to access that 
option.   An active menu command, option, button, tab, and field means you 
can use the item to perform an action.  Active items are green and/or 
highlighted.  
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Chapter 1     Compliance and Safety Requirements  

It is important that you are aware of and familiar with compliance and safety 
requirements to ensure you, the patient, and the systems are safe at all 
times. 

IEC classification and symbols 

  In accordance with International Safety Standard IEC 60601-1, the 
BodyTom 64 CT scanner is classified as Type B equipment; Class 1 
equipment, internally powered equipment, and continuous 
connection to the supply mains in standby state and for specified 
loading. 

Type B equipment provides an adequate degree of protection against shock, 
regarding: 
• Allowable leakage current. 
• Reliability of the protective earth connection. 
• (In accordance with the International Safety Standard IEC 60601-1), the 

manufacturer is not responsible for any consequences caused by the 
unauthorized modification of this equipment. 

• Earth leakage current. 

 
WARNING Equipment is not suitable for use in the presence of a 

flammable anesthetic mixture with air or with oxygen or 
nitrous oxide. 

 
WARNING Equipment is not suitable for use with oxygen or oxygen 

enriched atmospheres. 

BodyTom 64 Computer Tomography systems comply with Class I- Type B 
equipment as defined in IEC 60601-1 standard. 

Mode of operation is a continuous connection to the supply mains in standby 
state and for specified loading conditions. 

The BodyTom 64 CT scanner is patient-environment equipment. 

Table 2: Applicable symbols 

Symbol  Description 

 Alternating current 

 
Protective earth (ground) 
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Symbol  Description 

 

Functional Earth 

 
Caution: consult accompanying documents 

 
Caution: risk of electrical shock 

 
Electrostatic sensitive devices 

 

Type B equipment 

 
X-ray warning 

 

 
X-ray source assembly emitting 

 
Non-ionizing radiation 

 
Warning: laser in use 

 

Warning:  Laser Radiation Do Not Stare into Beam 
Class 2 Laser Product 

 Laser Output and Standards Information Label 

 

Warning: FDA Laser Information 

 
Warning: high temperature 

 
Emergency switch 

 
Crush warning 

 
Foot/toe crush warning when lowering machine 

 System up 
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Symbol  Description 

 System down 

 

Temperature limits 

 
Keep away from rain for packaging 

 
Humidity limit for packaging 

 Warning: battery charging 

 Fuse usage 

  

Refer to instruction in user manual/booklet 

 
Medical Device Symbol 

 
Legal Manufacturer Symbol 

  

Intertek ETL (Edison Testing Laboratories) Mark  

 
European Authorized Representative Symbol 

 

CE Mark or Conformité Européenne ; number 
below CE represent Notified Body number 

 

 

WARNING This x-ray unit may be dangerous to patient and operator 
unless safe exposure factors and operating instructions are 
observed. 
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Environmental specifications  

 
CAUTION The specified environment must be constantly maintained: 24-

hours a day, seven days a week. 

Table 3: Operating environment 

Operating 

Ambient temperature 15º C to 35º C (59ºF to 95º F) 

Relative humidity 20% to 80% (non-condensing) 

Altitude 0-3048m (0-10,000 ft.) 

Storage  

Temperature -25º C to 70º C (-13º F to 158º F) 

Relative humidity 20% to 85% (non-condensing) 

Transport  

Temperature -20º C to 60º C (-4º F to 140º F) 

Relative humidity 20% to 85% (non-condensing) 

Powering system  

Time period prior to 
powering the system 

24 hours1 

Floor  

Flatness <+/1 0.120in. (3mm) per 10ft. (3.048m) 

Recommended minimum 
scan area 

10ft. x 15ft. (3.048m x 4.572m) 

 

Note  For good image qual ity, the recommended practice is to 
keep the system free from vibration and to maintain the 
f latness specif ication noted.  

 If the system is in a facility outside the noted operating temperature, it is 
recommended to allow the noted time for the system to acclimate to the 
environment. 

Table 4: System operating parameters and specifications 

 120V~ 240V~ 
Phase Single  Single  

Voltage range 
100-120V~±10% 208-240V~ ±10% 

Nominal voltage for U.S. 120, 240 

Circuit protection 20 amps 30 amps 

Facility outlet 
NEMA 5-20R NEMA 6-30R 

Outline of outlet: 
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 120V~ 240V~ 
Phase Single  Single  

  

Frequency 50 or 60Hz 50 or 60Hz 

Battery capacity Fully charged, 12 hours typical 

Typical usage  110-120V~ 60Hz 230-240V~ 50Hz 

Wiring 
125V, 2 pole, 3 wire 
grounding 

250V, 2 pole, 3 wire 
grounding 

Main power supply’s 
apparent resistance 

0.105Ω 

Heat dissipation 
(when system is not 
idle) 

55kW 

Considerations when preparing gantry for use  

 
CAUTION Check for obstructions before moving and system setup. 

 
CAUTION Monitor scanner motion to prevent collision with surrounding 

environment and foreign objects. 

 
CAUTION Press the red EMERGENCY STOP button immediately in case 

of abnormal or unexpected motion. 

 
WARNING Verify scanner is on its centipedes (fully down position) prior 

to positioning patient at scanner entrance. 

 
WARNING Make sure all extremities are not under scanner while 

lowering or raising it. 

 
WARNING In the case of a single pendant failure, the additional pendant 

is available for use to prevent loss of system function. 

 
WARNING Always keep patient in view.  Ensure that the patient can be 

seen when the operator is near the scanner control panel and 
EMERGENCY STOP button.  Never leave patient unattended 
when the patient is in the gantry. 

• NeuroLogica advises complying with local regulations and/or site 
recommendations as specified by the facility physicist or certified 
representative for the following: 
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• Use mobile x-ray protective-shielding devices.  Technologists should be at 
the correct location and consider wearing personal radiation protective 
equipment. 

• A radiation safety plan in the working area boundaries, to optionally 
include as needed, mobile x-ray protective shielding devices.  Otherwise 
assign a larger, working area to avoid radiation to the public.  Effective 
dose for people outside the working area should be less than 0.25mSv 
annually (equals to 5 uSv weekly).  The air kerma rate 0.3 meters away 
from the working area will be smaller than 2.5 uGy/h.  Have monitoring 
and personal dose management for occupational exposure and related 
public health care personnel. 

• There should be a working plan before scanning.  The plan should include 
CT condition, time, location, working area, scanning plan, and site-clearing 
method; clearly state the responsibilities of working, protection, and 
management personnel.  Keep a good record of the whole process. 

• Restrict the working control and monitor area.  Place obvious warning signs 
at the control-area boundaries to prevent unauthorized personnel from 
entering.  Installation of a working status indication light is recommended. 

• In accordance with the safety plan, self-monitor during the scanning 
process.  A certified radiation representative should monitor the working 
area and take measurements immediately if abnormal circumstances are 
detected.  Additionally, this should be reported to the local environmental 
administrative and health departments.  There should be a public notice 
at the working area, to include the nature of work, time, location, control 
area, name of the working department, person in charge of the project, 
contact telephone number, radiation report telephone number. 

Site specification 

Table 5: System operating parameters 

Operating voltage  100-240 VAC~ 

Operating frequency  50Hz-60Hz 

Apparent resistance of supply mains at 
120VAC 

0.3 ohms 

Operating current at  120VAC  13 amps 

Heat dissipation  1672 watts 
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CAUTION For domestic purposes, scanner can be powered using either 

120V~ or 240V~.  If the scanner is using 120V~, the facility’s 
circuit must be capable of providing 20 amps (single phase).  If 
the scanner is using 240V~, the facility’s circuit must be 
capable of providing 30 amps (single phase).  If other devices 
are connected to the same circuit, the facility’s circuit breaker 
may trip and, therefore, prevent the scanner from being ready 
when needed. 

Table 6: Battery operating parameters 

Operating voltage  480 to 585 VDC 

Output current ( p ea k)  100 amps 

Site specification for enclosed CT room 

Table 7: Site specification 

Issue Comment  

Receiving area Secured 

Packing material and waste 
Near availability of a trash receptacle for 
dunnage 

Room dimensions for use 
12ft. x 15ft. room with a finished level floor; 
recommended the room be well lit 

Power availability 120VAC/20amp wall outlets (2x) 

Floor flatness <± 0.120in. (3mm) per 10ft. 

Floor strength Site must be able to support product weight 

Note  Not all  beds are compatible with this system.  Please 
contact Customer Service  for assistance .  

• NeuroLogica advises complying with local regulations and/or site 
recommendations as specified by the facility physicist or certified 
representative for the following: 

• There should be enough space inside the CT room.  The area should not be 
less than 30m2.  Any side should not be less than 4m.  Leaving any 
unnecessary items inside the room is prohibited. 

• Carpet and soft material cannot be used on the floor.  There should not be 
obstacles on the floor.  Ensure flat surface area no less than 12ft. x 15ft. 
level degree <±3mm per 10ft. 

• Appropriate protection measures should be taken to protect staff and to 
ensure annual-dose-rate is less than 0.25mSv (equals to 5 uSv weekly).   
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Hazardous substances 

Table 8: Hazardous substances 

Substance/material    Weight/system 

Lead 7.69 kg (17.0lbs.) 

Cadmium 0.036kg (0.079lbs.) 

Mercury 0kg (0lbs.) 

Hexavalent chromium 0kg (0lbs.) 

PolyBrominated Biphenyls (PBB) <0.46kg (1lb.) 

PolyBrominated Diphenyl Ethers (PBDE) <0.46kg (1lb.) 

Part numbers and product-marking plates 

Table 9: Core-system-component part numbers and product-marking plate locations 

Component  Part number 
Product-marking plate 
locations 

BodyTom 64 gantry 
0-NL4100-000 
10-00345-0001 

Near the main input plug or on 
the side of the system.  See 
Figure 1: Product-marking 
plate on scanner below. 

BodyTom 64 
workstation 

40-00157-000 On the back of the 
workstation. 

QA phantom 10-00268-001 On the back of the phantom. 
 

Note  The applicable components making up the BodyTom 64 CT 
scanner is identif ied with the nameplate statement “This 
product complies with radiation performance standards, 
21 CFR sub-chapter J .”  

 
Figure 1: Product-marking plate on scanner 
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Table 10: Core-system component dimensions 

Component / mode Size L x W x H Weight  

BodyTom 
64 NL4100 

Scan 
256.5cm x 104cm x 199cm 

3510 lbs. 
1592 kg 

101in. x 41in. x 79in. 

Transport 
256.5cm x 104cm x 205.7cm 

101in. x 41in. x 81in. 

Bore 
85cm 

33in. 
 

 
Figure 2: Scanner dimensions including drive bar 

Table 11: Workstation dimensions 

Component  
Size (inches) 

L x W x H 
Size (centimeters) 

L x W x H 
Weight 

(lbs) 
Weight 

(kg) 

BodyTom 64 
Workstation 
Cart 

26.3 x 24.4 x 79.8 66.8 x 62.0 x 202.7 207 94 

Class 1 Type B medical devices  

This equipment generates, uses, and can radiate radio-frequency energy.  The 
equipment may cause radio-frequency interference to other medical and non-
medical devices and to radio communications.  To provide reasonable 
protection against such interference, this product complies with emission 
limits for Class 1 medical devices as stated in EN 60601-1-2. 
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However, there is no guarantee that interference will not occur in a particular 
installation.  If this equipment is found to cause interference (which can be 
determined by switching the equipment on and off), the user should attempt 
to correct the problem using one or more of the following measures: 
• Re-orient or relocate the affected device(s). 
• Increase the separating space between the equipment and the affected 

device. 
• Power the equipment from a source different from that of the affected 

device. 
• Consult the point of purchase or the service representative for further 

suggestions. 

NeuroLogica Corp. is not responsible for any interference caused either by 
the use of interconnect cables other than those recommended or by 
unauthorized changes or modifications to this equipment.  Unauthorized 
changes or modifications could void the user’s authority to operate the 
equipment. 

To comply with the regulations applicable to an electromagnetic interface for 
a Group 1 Class A medical device, note the following: 
• All interconnect cables to peripheral devices must be shielded and 

properly grounded. 
• Use of cables not properly shielded and grounded may result in the 

equipment causing radio-frequency interference in violation of the 
European Union’s Medical Device Directive and FCC regulations. 

 
CAUTION Ensure there is no potentially detrimental 

interaction of system’s irradiation with a patient’s 
active and implantable medical devices and/or 
body-worn and active medical devices. 

 
CAUTION Do not use devices that intrinsically transmit radio 

waves, such as a cellular phone, radio transceiver, 
mobile radio transmitter, radio-controlled toy, and 
so on.  Use of these devices near this equipment 
could cause this equipment to malfunction.  Keep 
power of these devices turned off when near this 
equipment.  Medical staff in charge of this 
equipment is required to instruct technologists, 
patients, and other people who may be around 
this equipment to fully comply with the above 
regulation. 

• Medical staff in charge of this equipment are required to instruct 
technologists, patients, and other people who may be around this 
equipment to fully comply with the above regulations. 
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Focal spot 

Nominal size is: ~1.2 x 1.4mm 

Size limit is: ~1.2 to 1.7mm width and ~1.4 to 1.9mm length. 

Testing standard for reference is as follows: 
• IEC 60336:2005 

Focal spot centering is within 1mm of center of bolt pattern.  Maximum 
motion due to gravity in X, Y, and Z axis is 0.1mm. 

Maximum motion from anode rotation is 0.1mm. 

Maximum motion from anode heating in X axis is 0.1mm.  Maximum motion 
from anode heating in Z axis is 0.3mm. 

Anode input power 

The maximum anode cooling rate is 8,750W (12,250 HU/sec). 

The maximum anode heat dissipation is 3,400W (4,760 HU/sec). 

The nominal anode input power is 42kW. 

Continuous anode input power when applied at the nominal, x-ray, tube-
voltage is 150kV, 23mA. 

Filtration 

Table 12: Filtration 

Tube Voltage (kV)  100 120 140 

Half-value layer (aluminum 
equivalent)  

6mm 7mm 8mm 

Filters consist of 0.0014in. [0.036mm] of copper and 0.086in. [2.18mm] of 
aluminum, along with a variable thickness bowtie filter made from Teflon®. 

X-ray tube’s total filtration of irremovable layers is 1.0mm of equivalent 
aluminum. 

Source to Detector distance (SID) 

The SID value is 1041.9mm. 
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Compliance statement 

Note  All  editions and years of revisions for standards noted in 
this chapter are static as of Revision  00. 

The BodyTom 64 system complies with the regulatory requirements of the 
following: 
• AAMI ES60601-1 Issue: 2005 Version - Medical Electrical Equipment, Part 

1: General Requirements for Basic Safety and Essential Performance; 
Amendment No. 2: 2010/05/30. 

• CAN/CSA-C22.2 No. 601.1-M90(R2005) Issued: 2003/11/01 Medical 
Electrical Equipment – Part 1: General Requirements for Safety; General 
Instruction No. 1: 1990, Supplement 1: 1994, Amendment 2: 1998, 
General Instruction No. 2: 2003. 

• CENELEC EN 60601-1 2nd Edition, Medical Electrical Equipment - Part 1: 
General Requirements for Safety, includes Amendment A1:1993 and 
A2:1995. 

• CENELEC EN 60601-1 3rd Edition, Medical Electrical Equipment - Part 1: 
General Requirements for Safety. 

• CSA C22.2#60601-1 Issued: 2008/02/01 Ed 3 Medical Electrical Equipment 
- Part 1: General Requirements for Basic Safety and Essential Performance. 

• IEC 60601-1 Issued: 2005/01/01 Ed 3 Medical Electrical Equipment Part 1: 
General Requirements for Basic Safety and Essential Performance. 

• IEC 60601-1-1 (2000) 2nd Edition: Medical Electrical Equipment, Part 1: 
General Requirements for Safety - Collateral Standard: Safety 
Requirements for Medical Electrical Systems. 

• IEC 60601-1-2:2014 Ed4.0 Medical Electrical Equipment - Part 1-2: General 
Requirements for Basic Safety and Essential Performance - Collateral 
Standard: Electromagnetic Disturbances 

• IEC 60601-1-3 (2008), Medical Electrical Equipment Section 1-3: General 
Requirements for Safety.  Collateral Standard: General Requirements for 
Radiation Protection in diagnostic X-ray Equipment. 

• IEC 60601-1-4 (2005), 3rd Edition Consolidated Edition, Medical Electrical 
Equipment Part 1-4: General Requirements for Safety – Collateral 
Standard: Programmable Electrical Medical Systems. 

• IEC 60601-1-6 Issued: 2008/12/08 Ed 2 Medical Electrical Equipment - Part 
1-6: General Requirements for Safety.  Collateral standard: Usability. 

• IEC 60601-2-28 (1993) Medical Electrical Equipment, Part 2: Particular 
Requirements for the Safety of X-ray Source Assemblies and X-ray Tube 
Assemblies for Medical Diagnosis. 

• IEC 60601-2-32 (1994) Part 2-32, Particular Requirements for Safety 
sections 2.32 Specification for Associated Equipment of X-ray Equipment. 
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• IEC 60601-2-44 (2009) Medical Electrical Equipment -Part 2-44: Particular 
Requirements for the Safety of X-ray Equipment for Computed 
Tomography. 

• IEC 60825-1:2007 Safety of Laser Products - Part 1: Equipment 
Classification, and Requirements 2nd Ed. 

• International Electrotechnical Commission (IEC) International Standards 
Organization, when applicable. 

• Intertek Testing Service (ITS), an independent testing laboratory. 
• Medical Device Good Manufacturing Practice Manual issued by the FDA 

(Food and Drug Administration).  Department of Health, USA. 
• NeuroLogica Corporation is ISO 13485:2016 and MDSAP certified. 

EMI/EMC terms 

Electromagnetic Compatibility  

Electromagnetic Compatibility (EMC) is the branch of electrical sciences that 
studies the unintentional generation, propagation, and reception of 
electromagnetic energy with reference to the unwanted effects 
(Electromagnetic Interference (EMI)) that such energy may induce.  The goal 
of EMC is the correct operation, in the same electromagnetic environment, of 
different equipment, which use electromagnetic phenomena and the 
avoidance of any interference effects. 

To achieve this, EMC pursues two different kinds of issues.  Emission issues 
are related to the unwanted generation of electromagnetic energy, to the 
countermeasures that should be taken to reduce such generation, and to 
avoid the escape of any remaining energies into the external environment.  
Susceptibility or immunity issues, in contrast, refer to the correct operation of 
electrical equipment in the presence of unplanned electromagnetic 
disturbances. 

Interference, or noise, mitigation, and hence EMC is achieved by addressing 
both emission and susceptibility issues, that is., quieting the sources of 
interference, making the coupling path between source and victim less 
efficient, and making the potential victim systems less vulnerable. 
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Electromagnetic Interference (EMI) 

Electromagnetic Interference (EMI), also called Radio Frequency Interference 
(RFI) is an unwanted disturbance that affects an electrical circuit due to 
electromagnetic radiation emitted from an external source.  The disturbance 
may interrupt, obstruct, or otherwise degrade or limit the effective 
performance of the circuit.  The source may be any object, artificial or natural, 
that carries rapidly changing electrical currents, such as an electrical circuit, 
the sun, or the northern lights. 

Susceptibility 

Susceptibility is the capability of an electronic system to respond to unwanted 
electrical energy. 

EMI/EMC compliance 

This equipment complies with IEC 60601-1-2 EMC standard for medical 
devices. 

The BodyTom 64 system is suitable to be used in an electromagnetic 
environment, as per the limits and recommendations described in the tables 
hereafter: 
• Emission Compliance level and limits (see Table 14). 

Note  This system complies with the above-mentioned EMC 
standard when used with supplied cables.  If  different 
cable lengths are required, contact a qualif ied service 
representative for advice.  

Table 13: Acronyms and abbreviations 

Acronym and 
abbreviation 

Definit ion 

AEC Automatic Exposure Control 

CBF Cerebral Blood Flow 

CBV Cerebral Blood Volume 

CT Computed Tomography 

CTA CT Angiography 

CTP CT Perfusion 

CTDIvol Volume Computed Tomography Dose Index 

CTDIw Weighted average Computed Tomography Dose Index 

DICOM Digital Imaging Communication in Medicine 

DLP Dose Length Product (DLP) 

DHCP Dynamic Host Control Protocol 
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Acronym and 
abbreviation 

Definit ion 

EMC Electromagnetic Compatibility 

EMI Electromagnetic Interference 

FOV Field Of View 

HIS Hospital Information System 

HU Hounsfield Unit 

IBC Iterative Bone Correction 

MAR Metal Artifact Reduction 

MIP Maximum Intensity Projection 

MPPS Modality Performed Procedure Step 

MPR 
Multi-Planar Reformation, sometimes referred to as 
Multi-Planar Reconstruction 

MTT Mean Transit Time 

PACS Picture, Archiving, and Communication System 

QA Quality Assurance 

RIS Radiology Information System 

RSO Radiation Safety Officer 

RFI Radio Frequency Interference 

SCP Service Class Provider 

SCU Service Class User 

 

 
WARNING Medical, electrical equipment needs special precautions 

regarding EMC and needs to be installed and put into service 
according to EMC information provided in accompanying 
documents. 

 
CAUTION Portable and mobile RF communications equipment can 

affect medical electrical equipment. 

 
CAUTION Do not use or stack the equipment or system with other 

equipment and if adjacent or stacked use is necessary, the 
equipment or system should be observed to verify normal 
operation in the configuration in which it will be used. 

Note The EMC tables and other guidelines included in this user 
manual provide information to the user essential in 
determining the suitabil ity of the equipment or system for 
the electromagnetic environment of use, and in managing 
the electromagnetic environment  of use; to permit the 
equipment or system to perform its intended use without 
disturbing other equipment and systems or non -medical 
electrical equipment.  
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Note  The EMISSIONS characteristics of this equipment make it  
suitable for use in industrial areas and hospitals (CISPR 11 
class A). If  it  is used in a residential environment (for 
which CISPR 11 class B is normally required) this  
equipment might not offer adequate protection to radio -
frequency communication services. The user might need to 
take mit igation measures, such as relocat ing or re-
orienting the equipment.  

Table 14: Emission declaration for BodyTom 64 systems 

BodyTom 64 system is intended for use in electromagnetic environment specified below.  
The user of the BodyTom 64 system should assure that it is used in such an environment. 

Emissions test  Compliance Electromagnetic environment guide  

RF emissions CISPR 11 Group 1 

BodyTom 64 systems use RF energy only 
for internal function.  Therefore, RF 
emissions are very low and are not likely to 
cause any interference in nearby electronic 
equipment. 

RF emissions CISPR 11 
 
Harmonic emissions, 
IEC 61000-3-2 
 
Voltage 
fluctuations/flicker 
emissions, IEC 61000-3-3 

Class A 
 
 
Class A 
 
 
Complies 

BodyTom 64 systems are predominantly 
intended for use in non-domestic 
environments, and not directly connected 
to the Public Mains Network.  BodyTom 64 
systems are predominantly intended for 
use (for example, in hospitals) with an 
appropriate power supply (see operation 
manual) and recommended shielding for 
portable use. 

 

Table 15: EMC Immunity declaration for BodyTom 64 systems 

BodyTom 64 systems are intended for use in the electromagnetic environment specified 
below.  The customer or user of an BodyTom 64 system should assure that it is used in 
such an environment. 

Immunity 
test 

IEC 60601-1-
2 
test level  

Compliance 
level  

Electromagnetic 
environment guidance  

Electrostatic 
discharge (ESD) 
IEC 61000-4-2 

±8kV contact 
 
±2kV, ±4kV, 
±8kV, 15kV air 

±8kV contact 
 
±2kV, ±4kV, 
±8kV, 15kV air 

Floors should be wood, concrete, 
or ceramic tile.  If floors are 
covered with synthetic material, 
relative humidity should be at 
least 30%. 
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BodyTom 64 systems are intended for use in the electromagnetic environment specified 
below.  The customer or user of an BodyTom 64 system should assure that it is used in 
such an environment. 

Immunity 
test 

IEC 60601-1-
2 
test level  

Compliance 
level  

Electromagnetic 
environment guidance  

Electrical fast 
transient/burst 
IEC 61000-4-4 

±2kV for power 
supply lines 
±1kV for 
input/output 
lines 

±2kV for 
power supply 
lines ±1kV for 
input/output 
lines 

Mains power quality should be 
that of a typical commercial or 
hospital environment. 

Surge IEC 
61000-4-5 

±1kV line-line 
±2kV line-
ground 

±1kV line-line 
± 2kV line-
ground 

Mains power quality should be 
that of a typical commercial or 
hospital environment. 

Voltage dips, 
short 
interruptions, 
and voltage 
variations on 
power supply 
input lines IEC 
61000-4-11 

0% UT; 0.5 cycle 
At 0°, 45°, 90°, 
135°, 180°, 
225°, 270° and 
315° 
 
0% UT; 1 cycle 
 
70% UT; 25/30 
cycles 
 
0% UT; 250/300 
cycles 

0% UT; 0.5 
cycle At 0°, 
45°, 90°, 135°, 
180°, 225°, 
270° and 315° 
 
0% UT; 1 cycle 
 
70% UT; 25/30 
cycles 
 
0% UT; 
250/300 cycles 

Mains power quality should be 
that of a typical commercial or 
hospital environment.  If the user 
of a BodyTom 64 system requires 
continued operation during 
power interruptions, it is 
recommended that the BodyTom 
64 system be powered from its 
internal batteries. 

Immunity test 
IEC 60601-1-2 
Test Level 

Compliance 
level 

Electromagnetic environment 
guidance. 

Power 
frequency (50/ 
60Hz) magnetic 
field IEC 61000-
4-8 

30 A/m, 50Hz 
or 60Hz 

30 A/m, 50Hz 
or 60Hz 

Power-frequency magnetic-fields 
should be at levels characteristic 
of a typical location in a typical 
commercial or hospital 
environment. 

Clause 8.10 Table 17 Per Table 17 IEC 60601-1-2:2014 

Clause 8.11 Table 18 Per Table 18 IEC 60601-1-2 ed4.1:2020 
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BodyTom 64 systems are intended for use in the electromagnetic environment specified 
below.  The customer or user of an BodyTom 64 system should assure that it is used in 
such an environment. 

Immunity 
test 

IEC 60601-1-
2 
test level  

Compliance 
level  

Electromagnetic 
environment guidance  

Conducted RF 
IEC 61000-4-6 

3 Vrms 150kHz 
to 80MHz 
6 Vrms in ISM 
band 150kHz to 
80MHz 
80% AM at 
1kHz 

3 Vrms 
6 Vrms 
80% AM at 
1kHz 
 

Portable and mobile RF 
communications equipment 
should be used no closer to any 
part of the BodyTom 64 system, 
including cables, than 
recommended separation 
distance calculated from the 
equation appropriate for 
transmitter frequency. 
Recommended separation 
distance: See Table 16. 

Radiated RF IEC 
61000- 4-3 
(alternative 
method: IEC 
61000-4-21) 

3 Vrms 80MHz 
to 2,7GHz 
80% AM at 
1kHz 

E1 = 3 V/m 
80% AM at 
1kHz 

Interference may occur in vicinity 
of equipment marked with the 
following symbol:  

 
 

 
 
Note: The wireless receiver operates within the following bands.  
2.412 to 2.462 GHz (11 channels)  

5.180 to 5.240 GHz (4 channels)  
5.260 to 5.320 GHz (4 channels)  
5.500 to 5.700 GHz (8 channels, excluding 5.600 to 5.640 GHz)  
5.745 to 5.825 GHz (5 channels)  
 
The preferred frequency band is 5.189 to 5.240 GHz at 40MHz 
bandwidth.  
The wireless transmitter operates within the following frequency 
bands and power.  

802.11b:  
Typ. 26±1.5 dBm @ 1 Mbps, Typ. 26±1.5 dBm @ 2 Mbps  
Typ. 26±1.5 dBm @ 5.5 Mbps, Typ. 25±1.5 dBm @ 11 Mbps  
802.11g:  
Typ. 23±1.5 dBm @ 6 to 24 Mbps, Typ. 22±1.5 dBm @ 36 Mbps  
Typ. 20±1.5 dBm @ 48 Mbps, Typ. 19±1.5 dBm @ 54 Mbps  
802.11n (2.4 GHz):  
Typ. 23±1.5 dBm @ MCS0/8 20 MHz,  



BodyTom 64 User Manual Revision 04 

 

Chapter 1    Compliance and Safety Requirements Page 48 of 412 

Typ. 18±1.5 dBm @ MCS7/15 20 MHz  
Typ. 23±1.5 dBm @ MCS0/8 40 MHz,  
Typ. 17±1.5 dBm @ MCS7/15 40 MHz  
802.11a:  
Typ. 23±1.5 dBm @ 6 to 24 Mbps, Typ. 21±1.5 dBm @ 36 Mbps  
Typ. 20±1.5 dBm @ 48 Mbps,Typ. 18±1.5 dBm @ 54 Mbps  
802.11n (5 GHz):  
Typ. 23±1.5 dBm @ MCS0/8 20 MHz,  
Typ. 18±1.5 dBm @ MCS7/15 20 MHz  
Typ. 23±1.5 dBm @ MCS0/8 40 MHz,  
Typ. 18±1.5 dBm @ MCS7/15 40 MHz  
 
The device includes 4 dBi gain antennas  

Countermeasures against EMC related issues  

Generally, it is very difficult to grapple with issues related to EMC.  It may take 
a variable amount of time and cost to identify issues causing interference. 

General countermeasures of electromagnetic interference with other 
equipment: 
• Electromagnetic interference may be alleviated by positioning other 

equipment far from the system. 
• Electromagnetic interference may be mitigated by changing relative 

location (installation angle) between system and other equipment. 
• Electromagnetic interference may be eased by changing wiring locations 

of power/signal cables of other equipment. 
• Electromagnetic influence may be reduced by altering the power-supply 

path of other equipment. 
• Electromagnetic environment specified (see Table 15 on page 45). 
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Table 16: Recommended separation distances 

Recommended separation distances between portable and 
mobile RF communications equipment and the BodyTom 64 
system 

BodyTom 64 system is intended for use in an electromagnetic environment 
in which radiated RF disturbances are controlled.  The user of the BodyTom 
64 system can help prevent electromagnetic interference by maintaining a 
minimum distance between portable and mobile RF communications 
equipment (transmitters) and the BodyTom 64 system as recommended 
below, according to the maximum output power of the communications 
equipment. 

Rated 
maximum 
output Power 
(P) if  
transmitter 
Watts (W) 

150kHz to 
80MHz 

Separation 
distance 
meters1  

80MHz to 
800MHz 

Separation 
distance 
meters1 

800MHz to 
2,5GHz 

Separation 
distance 
meters 1  

0.01 .12 .12 .23 

0.1 .38 .38 .73 

1 1.2 1.2 2.3 

10 3.8 3.8 7.3 

100 12 12 23 

For transmitters rated at a maximum output power not listed above, the 
separation distance is estimated using the equation in the corresponding 
column, where P is the maximum output power rating of the transmitters in 
Watts (W) according to the transmitter manufacturer. 

Note   At 80MHz and 800MHz, separation distance for higher 
frequency range applies.  

Note   These guidel ines may not apply in all  situat ions .  
Electromagnet ic propagation is affected by absorption 
and reflection from structures, objects, and people .  

 

 

 

1 Separation distance according to frequency of transmitter (m) 
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Table 17: Test specifications for ENCLOSURE PORT IMMUNITY to RF wireless communications 
equipment 

Test 
Frequency 
(MHz) 

Band a )  Service  a )  Modulation b )  
Max 
Power 
(W) 

Distance 
(m) 

Immunity 
Test 
Level 
(V/m) 

385 
380-
390 

Tetra 400 

Pulse 
Modulation b )  

18Hz 

1.8 0.3  27 

450 
430-
470 

GMRS 
460, 

FRS 460 

FM c )  

±5kHz 
deviation  

1 kHz sine  

2 0.3  9 

710 

704-
787 

LTE Band 
13,17 

Pulse 
Modulation b )  

217Hz 

0.2 0.3  9 745 

780 

810 

800-
960 

GSM 
800/900 

TETRA 
800, 

iDEN 820, 

CMDA 
850, 

LTE Band 
5 

Pulse 
Modulation b )  

18Hz 

2 0.3  28 

870 

930 

1720 

1700-
1990 

GSM 
1800; 

CMDA 
1900; 

GSM 
1900; 

Pulse 
Modulation b )  

217Hz 

2 0.3  28 

1845 

1970 
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Test 
Frequency 
(MHz) 

Band a )  Service  a )  Modulation b )  
Max 
Power 
(W) 

Distance 
(m) 

Immunity 
Test 
Level 
(V/m) 

DECT;  

LTE Band 
1, 3, 4, 

25; UMTS 

2450 
2400-
2570 

Bluetooth,  

WLAN, 

802.11 
b/g/n, 

RFID 
2450, 

LTE Band 
7 

Pulse 
Modulation b )  

217Hz 

2 0.3  28 

5240 

5100-
5800 

WLAN 
802.11 

a/n 

Pulse 
Modulation b )  

217Hz 

0.2 0.3  9 5500 

5785 

Table 18: Test specifications for ENCLOSURE PORT IMMUNITY to proximity magnetic fields 

Test Frequency 
(MHz) 

Modulation  
Immunity Test 
Level (A/m) 

134.2 kHz  Pulse modulation 2.1 kHz  65 

13.56 MHz Pulse modulation 50 kHz  7.5  
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Use recommendations 

This product complies with IEC 60601-1-2 standard for medical devices and 
with radio frequency emission requirements per CISPR11 Group 1 Class A 
standard limits.  The BodyTom 64 system is predominantly intended for use in 
hospitals. 

Do not use devices that intentionally transmit RF signals (cellular phones, 
transceivers, or radio-controlled products) in the vicinity of this equipment as 
it may cause performance outside the published specifications.  Keep the 
power to these types of devices turned off when near this equipment. 

Adhering to the distance separation (recommended in Table 16 on page 49) 
between 150kHz and 2.5GHz, will reduce disturbances recorded at the image 
level, but may not eliminate all disturbances; however, when installed and 
operated as specified herein, the system will maintain its essential 
performance by continuing to safely acquire controlled, radiological, x-ray 
exposures in a mobile radiography environment.  For example, a 1W mobile 
phone (800MHz to 2.5GHz carrier frequency) is put 2.3 meters apart from the 
BodyTom 64 system (to avoid image interference risks). 

The use of accessories, transducers, and cables, other than those specified, 
may result in degraded, electromagnetic compatibility of the BodyTom 64 
system. 

The medical staff in charge of this equipment is required to instruct 
technologists, patients, and other people who may be around this equipment 
to comply fully with the above equipment requirements. 

Installation recommendations 

This system complies with above-mentioned EMC standard when used with 
supplied cables.  To minimize interference risks, the following requirements 
apply. 

Cable shielding and grounding 

All interconnect cables to peripheral devices must be shielded and properly 
grounded.  Use of cables not properly shielded and grounded may result in 
the equipment causing radio-frequency interference. 
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Adjacent components and equipment 

BodyTom 64 system should not be used adjacent to or stacked with other 
equipment; if adjacent or stacked use is necessary, the BodyTom 64 system 
should be tested and verified to make sure normal operation in the 
configuration in which it is used.  Consult NeuroLogica and Facility Technical 
Support staff regarding device/system configurations. 

Static magnetic field limits 

To avoid interference on the BodyTom 64 system, static-field limits from the 
surrounding environment are specified.  The static field is specified as less 
than <1 Gauss around the unit. 

Electrostatic discharge environment and recommendations 

• To reduce electrostatic-discharge interference, install a charge-dissipative 
floor-material to avoid electrostatic charge-buildup. 

• The relative humidity must be at least 30 percent. 
• The dissipative material must be connected to the system ground-

reference. 

Facility IT-NETWORK 

The BodyTom 64 system utilizes the IT-NETWORK for the customer (as 
applicable) to communicate with the modality worklist and for supplemental, 
image-storage space.  As part of the installation, the applicable IT-NETWORK 
is reviewed to create the appropriate setup for the system.  Setup is done to 
ensure no potential concerns arise with the system. 

 
CAUTION It is possible that the IT-NETWORK connection from the system 

could result in previously unidentified issue(s) to the 
respective population.  Should this occur, contact Customer 
Service right away to identify, analyze, evaluate, and resolve 
the issue(s). 

 
CAUTION It is possible that any changes to the IT-NETWORK made by the 

facility could introduce a new issue where Customer Service 
needs to be contacted to address the concern, right away. 

Changes to the IT-NETWORK include – but are not limited to the following: 
• Changes in network configuration 
• Connection to additional items 
• Disconnection to items 
• Updating equipment 
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• Upgrading equipment. 

Hazard information 

Review this material before using the system and observe basic, common-
sense safety rules when operating this scanner. 

General safety considerations and statements 

Review the following before using the system (Scanner and Workstation (as 
applicable)) to observe basic, common-sense safety rules when operating the 
scanner: 
• Become familiar with the functional hardware to help recognize serious 

problems. 
• Do not use scanner or workstation if it appears damaged or fails. 
• Wait for qualified personnel to correct any problem. 

Note The scanner is provided with a video-camera monitoring-
system to help navigate the unit while being transported 
within a facil ity.  

 
WARNING The health software is installed on a medical device and is 

required for its operation. In order to securely remove the 
software from use, the system must be decommissioned. 

 
WARNING Modification of this equipment is not allowed. 

 
WARNING Equipment maintenance of non-medical electrical equipment 

should not be performed in the patient environment. 

 
CAUTION All non-medical electrical equipment will comply with 

relevant IEC and ISO safety standards. 

 
CAUTION Federal law restricts the use of this device without a 

prescription by a physician. 

 
CAUTION Always store and/or use unit in a well-ventilated area.  Keep 

air pollution to a minimum.  Keep floor clean at all times. 

 
CAUTION Do not touch parts of non-medical electrical equipment in 

patient environment and patient simultaneously. 

 
CAUTION For disposal of any material emanating from the system; 

follow local regulations. 

 
CAUTION This system was designed for use by individuals trained in CT 

system operation.  The user should be familiar with this user 
manual before scanning patients. 
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CAUTION It is the user’s responsibility to make sure that after 

installation or subsequent modification, the system is in 
compliance with the requirements of collateral standard IEC 
60601-1. 

 
WARNING Installation of this product is performed in accordance with 

Installation Manual (1-NL4100-059).  All installation processes 
and qualified personnel are outlined in that document. 

 
WARNING Proper disposal of batteries is required to ensure compliance 

with environmental safety guidelines.  Contact authorized 
NeuroLogica representative for instructions. 

 
WARNING Observe safety-exposure factors and operating procedures to 

protect patient from physical harm during contact with this x-
ray scanner. 

 
WARNING Observe safety requirements to prevent excessive dose 

exposure to patient and/or operator. 

 
CAUTION Improper system (including workstation) usage could 

endanger patients and/or users and void the warranty if not 
operated correctly. 

 
CAUTION Should the workstation encounter a computer related virus, 

be sure to contact Technical Support for assistance with 
removing said virus from the equipment. 

 
CAUTION Radiation dose exposure to patients should not exceed 

maximum of 1Gy CTDI. 

 
CAUTION For proper disposal of material at equipment’s end-of-useful 

life; contact NeuroLogica for instructions. 

 
WARNING Equipment in which protection against electric shock relies on 

basic insulation only, should not be used in this system. 

 
WARNING If the system fails to move due to loss of power, the patient 

can be easily removed from the scanner by moving the 
patient bed. 

Four, foot crush hazard labels are affixed to the scanner in four places, above 
the four soft bumpers.  The following shows a safety label: 
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Figure 3: Identifying the scanner’s safety label(s) – foot-crush-hazard label(s) 

Laser safety 

There are four lasers used with the BodyTom 64 system as indicated in Figure 
4 on page 57:  1 laser (Sagittal) at position 1, 1 laser (Axial or Transverse) at 
position 2 (which is mounted internally and spins within the system’s bore), 
and 1 set of external lasers (Coronal and Transverse/Axial) at position 3.   

 
WARNING Viewing the laser output with certain optical instruments (for 

example, eye loupes, magnifiers, and microscopes) within 
100mm may pose an eye hazard. 

 
WARNING Complies with 21 CFR 1040.10 and 1040.11 except for 

conformance with IEC 60825-1 Ed. 3., as described in Laser 
Notice No. 56, dated May 8, 2019. 

 

Laser parameters 

• Lasers 1 and 3 (see Figure 4):  
• Wavelength = 650nm 
• Output Power  = 1mW 

• Laser 2 (see Figure 4): 

• Wavelength = 650nm 
• Output Power = 4mW 
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Figure 4: Laser aperture’s direction 
 

 
CAUTION Instruct the patient to close his/her eyes before turning ON 

the alignment light. 

 
CAUTION Closely monitor infants and infirm patients to prevent them 

from accidentally staring into the beam. 

 
CAUTION Class 2 laser radiation when open.  Do not stare into the 

beam or view directly with optical instruments. 

 
CAUTION Use of controls or adjustments or performance of procedures 

other than those specified herein may result in hazardous 
radiation exposure. 

 
CAUTION The warning label for “laser in use” is located on the front of 

the scanner cover and inside the scanner to identify the 
presence of a laser. 

 

Scanner mobility safety 

 
CAUTION Due to the mobility of the system, an external interlock is not 

available; however, a prescribed scan can, at any time, be 
terminated from the scanner or the workstation.  When the 
user activates the scan, a 10-second, countdown-clock, scan 
delay (adjustable to 99 seconds) triggers.  This countdown 
allows the user time to perform needed tasks before the scan 
begins. 
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CAUTION To prevent healthcare provider injuries, a single healthcare 

professional should not move the scanner and workstation.  
Although one person can drive the BodyTom 64 when moving 
the scanner about the facility, NeuroLogica recommends two 
people move the scanner (lengthwise, only) to ensure no 
collisions occur when maneuvering through tight hallways 
and around corners.  Be especially cautious when moving the 
system about an inclined floor. 

 
WARNING To prevent involuntary movement, do not position scanner 

on an incline while in Transport mode. 

 
WARNING Do not move the system right or left if transport on an incline 

becomes necessary.  Always keep the system in a straight 
motion. 

 
WARNING Contact Technical Support for assistance when movement is 

required on an incline. 

Note  Be sure there are no obstacles in front of  the scanner 
while you move the scanner .  

 If  the system needs to be moved over a threshold it  is 
crit ical that the scanner be oriented so that it  is driven in 
the forward or reverse direction.  The scanner does not 
have the capability of moving lateral ly over thresholds .  

 
CAUTION Check to ensure proper clearance is provided to allow removal 

of patient from scanner in case of a power failure.  This is 
accomplished by moving patient’s support (after unlocking 
wheel-locks) away from scanner. 

 
CAUTION To prevent patient entrapment or entanglement with 

accompanying equipment, slowly move scanner away from 
patient by using control panel switches or pendant controls 
while observing patient. 

 
CAUTION The scanner is equipped with a video camera to help the 

operator prevent collisions when transporting system to 
different locations that could otherwise result in personal 
injury or facility damage. 

 
CAUTION Do not station or operate the system on an uneven floor.  The 

flatness requirement is 0.12in. over 10ft. or 3mm over 305cm. 
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CAUTION Prior to transporting the scanner, verify that the power cord is 

unplugged from wall to avoid damage to cord and outlet, and 
avoid tripping.  Verify that the ethernet cable is unplugged 
from the workstation to avoid damage to the cable and 
connector. 

Floor level  

For proper operation, the system must be operated on an even, level, hard 
surface. 

Carpeting 

Do not use the system on a carpeted floor.  Poor image quality could result 
due to unevenness of the floor. 

Electrical safety 

 
WARNING The system’s external AC power cord should be checked prior 

to use to verify there are no exposed wires or damaged 
insulation/prongs.  Damaged prongs could result in sparking 
and fire.  In case of such damage, contact Customer Service, 
immediately. 

 
WARNING To separate the device from AC power simply disconnect the 

power cord from the wall and turn off the main breakers, 
located on the same side of the scanner as the power cord. 

 
WARNING Access to the main breaker is critical for safety.  Do not 

position the scanner so that the access to the breaker is 
diminished. 

 
CAUTION Check to ensure the AC outlet is working properly before 

plugging in the system’s AC power cord.  NeuroLogica 
recommends using a dedicated outlet for powering the 
BodyTom 64 system, only. 

 
WARNING To prevent electrical shock, do not connect items that are not 

specified as part of the system, including the workstation. 

 
WARNING To prevent electrical shock, do not remove the covers from 

the equipment.  The covers protect the user and the patient 
from moving parts or electrical shock.  Hazardous voltages are 
present within this equipment.  The covers provide protection 
from radiation exposure given off from the x-ray tube.  The 
covers also protect the equipment. 
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WARNING An electrical shock hazard: no user should apply serviceable 

parts; refer to qualified service personnel for any service. 

 
WARNING Always electrically isolate this equipment from the main 

electrical supply before cleaning and disinfecting it to prevent 
short-circuiting or possible electrical shock. 

 
WARNING Never position the mobile system and/or workstation in a 

manner that prohibits access to unplugging it or prohibits 
pressing the EMERGENCY STOP button. 

 
WARNING To minimize shock hazard, the system chassis must be 

connected to an electrical ground.  The system is grounded 
through the ground conductor of the supplied, three-
conductor power cord.  The power cord must be plugged into 
a three-conductor electrical outlet receptacle.  Do not alter 
the ground connection. 

 
WARNING Avoid all contact with any electrical conductor as follows: 

• Allow only qualified personnel who know the proper 
procedures and use the proper tools to install, adjust, 
repair, or modify the equipment. 

• Only use this equipment in rooms or areas that comply 
with all applicable laws (or regulations having the force of 
law) concerning electrical safety for this type of 
equipment. 

• Always electrically isolate this equipment from the main 
electrical supply before cleaning and disinfecting it. 

• The detachable cord is the disconnecting device, which is 
used to remove mains power from the wall socket. 

• The system is internally powered. 

 
WARNING For Class 1 equipment (for example, the workstation, AC 

power cord, and so on) using an alternate internal source: a 
warning to use the alternate source if the integrity of the 
protective earth conductor is in doubt. 

 
WARNING Do not position the system so that it is difficult to access the 

AC power cord. 

 
CAUTION Protect the system power cord against mechanical damage. 

Where the integrity of an external, protective conductor, in the installation or 
its arrangement, is in doubt, equipment is operated from its internal, 
electrical power source. 
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Parts of non-medical electrical equipment in the patient environment that, 
after removal of covers, connectors, and so on, without the use of a tool, may 
be contacted by the operator during routine maintenance and calibration, will 
operate at a voltage not exceeding 25VAC or 60VDC or peak value supplied 
from a source that is separated from the supply mains in accordance with one 
of the methods described in IEC 60601-1. 

 
CAUTION All systems within the patient environment will provide the 

same level of safety as medical equipment complying with IEC 
60601-1. 

 
CAUTION To help prevent tripping hazards, use care in the arranging of 

any cords (for example, AC cord, ethernet cable, and so on) 
when connecting to the system/workstation. 

 
CAUTION To prevent damaging electrical outlet cords, check to ensure 

they have been removed and properly stored before 
transporting the scanner. 

 
WARNING The BodyTom 64 CT scanner contains high-voltage circuits for 

generating x-rays.  Only trained and qualified personnel 
should be permitted access to the internal parts of this 
equipment. 

 
CAUTION Use the Universal Serial Bus (USB) terminal located near the 

EMERGENCY-STOP (E-STOP) button for archiving to USB, only.  
Do not use the USB terminal located near the E-STOP for 
connecting any other device to equipment. 

 
CAUTION For proper disposal of material at the end of the useful life of 

the equipment, contact NeuroLogica for instructions. 

Mechanical safety 

 
WARNING In case of unwanted movement or motion, press the 

EMERGENCY STOP (E-STOP) button. 

 
WARNING Physically assist all patients on and off the bed and into 

position on the scan board.  Adjust the bed to the specified 
height for patient loading and unloading (see “Positioning the 
patient” on page 94). 

 
WARNING Adjust scanning platform to specified height for patient 

loading and unloading; see “Positioning the patient” on page 
94. 

 
WARNING When positioning the scanning platform, be careful when 

moving the scan table to avoid having it hit the scanner 
covers. 
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WARNING Position any lines (IVs and so on) attached to the patient so 

the lines cannot catch on the scanner during scanner travel. 

 
CAUTION Prevent pinching or crushing of the patient’s extremities.  

Keep patient’s hands on the side of his/her body.  Always 
watch the patient and equipment carefully during scanner 
movement. 

 
CAUTION To prevent pinching or crushing of the operator’s feet/toes, 

be sure extremities are not positioned under the scanner 
when it is being lowered from Transport mode to Scan mode. 

 
WARNING Equipment maintenance of non-medical electrical equipment 

should not be performed in the patient environment. 

 
WARNING Maintenance checks and all service must be performed by 

NeuroLogica trained service personnel. 

 
CAUTION Ask patient to scoot up into universal scan board or manually 

aid them into position. 

 
CAUTION When the scan board is in place, be especially careful when 

moving the bed to avoid driving it into the gantry covers. 

 
CAUTION Periodically check all accessories for damage and remove 

them from service if damaged or cracked. 

Radiation safety 

Two Dangerous to patient and operator labels are affixed to both sides of the 
scanner, just above the operator controls.  See Figure 5 on page 63. 
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Figure 5: Dangerous-to-patient/operator safety-warning label location (left) and 
label (close-up, right) 

 

 
WARNING Improperly used x-ray equipment may result in unwanted 

radiation exposure.  Read and understand the instructions in 
this user manual before attempting to operate this 
equipment. 

 
CAUTION Use technique factors prescribed by the radiologist or 

diagnostician.  Use a dose that produces the best diagnostic 
results with the least x-ray exposure. 

 
CAUTION All persons authorized to use the equipment must 

understand the dangers posed by excessive x-ray exposure.  
NeuroLogica recommends use of protective materials and 
devices. 

 
WARNING Everyone having anything to do with x-ray must take 

adequate steps to insure protection against injury. 

 
CAUTION The use of this device requires its users to receive proper 

training in accordance with local and national laws. 

 
CAUTION Never perform calibration with patients in the scanner or 

while personnel are present in the vicinity of the scanner to 
prevent exposure to unwanted radiation. 

 
CAUTION Amber indicator lights (on the top of the scanner) illuminate 

during x-ray exposure. 
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CAUTION Ensure that there is no potential for detrimental interaction 

of the system’s irradiation with a patient’s active implantable 
medical devices and/or body-worn, active, medical devices. 

X-rays can only be produced during the following conditions: 
• The scanner is in the Scan mode position. 
• The workstation is connected. 
• The START button is activated when the patient is registered, the protocol 

is selected, the Begin button is clicked, and the protocol is prepared.  The 
START button on the scanner’s control panel illuminates when the 
scanner is ready to begin.  See Figure 7 on page 65 to identify the START 
button. 

Fire and explosion safety 

 
DANGER This equipment is not suitable for use in presence of a 

flammable anesthetic mixture with air or with oxygen or 
nitrous oxide. 

 
DANGER This equipment is not suitable for use in the presence of 

oxygen or oxygen-enriched atmosphere. 
• Fire regulation for the type of medical area being used 

should be fully applied, observed, and enforced.  Fire 
extinguishers should be provided for both electrical and 
non-electrical fires. 

• All operators of the BodyTom 64 scanner should be fully 
aware of and trained in the use of fire extinguishers and 
the firefighting equipment, and in local fire procedures. 

 
WARNING Only use extinguishers on electrical or chemical fires that are 

specifically labeled for those purposes.  Using water or other 
liquids on an electrical fire can lead to fatal or other serious 
injury. 

If it is safe to do so, attempt to isolate the equipment from 
electrical and other supplies before attempting to fight a fire.  
This will reduce the risk of electrical shocks. 

EMERGENCY STOP button 

 
CAUTION Check the EMERGENCY-STOP (E-STOP) button at least one 

time a month to ensure proper function. 

 
CAUTION Every user should take a few minutes to locate the E-STOP 

before scanning the first patient. 
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CAUTION In case of emergencies, stop scanner movement immediately 

by pressing the E-STOP red push-button located on the 
scanner, below the control panel. 
 

 
Figure 6: BodyTom 64 E-STOP locations (right and left) 

 
Figure 7: Close-up of the scanner control panel and the E-STOP button 

Note  When the E-STOP  button is activated, the moving gantry 
may overrun by less than 10mm.  

Battery safety and information 

The System battery capacity icon shows an indication of the scanner’s battery 
capacity, which is identical to the indicator on the scanner.  The user should 
always check the indicator on the scanner to verify the batteries’ status; there 
are 145 lithium-ion batteries in the scanner; 144 are used for scanning and 
the remaining battery is used for moving the scanner while in transport mode.  

 
CAUTION The system unit contains batteries and will always be charging 

when plugged into AC mains. 
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CAUTION In case of battery leakage, do not handle the batteries 

themselves nor continue to operate the system.  Contact 
NeuroLogica for service.  See “Contact information” on  
page 24. 

Battery replacement and disposal 

 
WARNING Battery replacement is to be performed by authorized and 

trained NeuroLogica service personnel, to ensure proper 
disposal of hazardous material. 

 
WARNING Dispose batteries in accordance with federal, state, and local 

regulations. 

 
WARNING Do not incinerate batteries. 

 
WARNING Contact an authorized NeuroLogica representative for 

appropriate, product-disposal instructions. 

Scanner battery capacity 

The range is 0 to 100.  Battery voltage and current are used to calculate the 
system’s battery capacity based on charging state.  

 

 
 

Figure 8:  Scanner battery capacity icon   

Run time operation 

During normal, run-time operation, the battery capacity is calculated one 
time, per second.  The battery capacity indicator is updated on the scanner’s 
display screen as well. 

Note  The battery capacity indicator on the scanner’s display 
screen is displayed in 5% increments when above 10% .  
When 10% and below, the displayed capacity is in 1% 
increments.  That is,  above 10% capacity,  the displayed 
value is always rounded to the closest multiple of 5 (for 
example, 93 gets rounded to 95, 42 gets rounded to 40, 47 
gets rounded to 45, and so on).  
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State changes 

After each periodic update, capacity is checked to make sure it does not fall 
below certain thresholds, as follows: 
• Low voltage alarm state 

When battery capacity goes below 25%, a periodic alarm will sound.  It will 
remain in this state until the battery capacity has gone back up to 27% or 
higher.  The Start and Cancel buttons when scanning will not illuminate if 
the battery is too low. 

• Low voltage lock-out state 
When the battery capacity goes below 1%, the scanner screen-display 
buttons are disabled and starting a scan is prohibited; for example, the 
ability to move the scanner and certain protocol buttons are disabled.  It 
will remain in this state until the battery capacity has gone back up to 2% 
or higher.  The low voltage alarm will continue to be active in this state. 

Predictive scanning 

Before each scan, battery usage for that scan is predicted based on the 
selected load factors (for example, kV, mA, scan time) and is compared 
against the available battery capacity.  If there is not enough battery capacity 
to scan, a popup appears on the workstation screen.  The user can cancel the 
scan at that time or continue the scan, with the understanding that the scan 
may abort due to a low-power fault. 

Under voltage protection 

When the system battery voltage drops below the low-voltage cutout-level 
while unplugged, a system power-down sequence is initiated. 

Workstation 

The Workstation battery capacity icon shows an indication of the 
workstation’s battery capacity.  On the workstation’s main screen, place the 
mouse pointer over the battery icon to see the capacity of the battery, 
ranging from 0 to 100%.    The user should always check the screen to verify 
the status of the batteries. 

 
Figure 9: Workstation battery capacity icon 

Note  The workstation does not report proper battery capacity 
and status if  a network connection is not made.  
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          If  the scanner’s display screen  is black, the system is          
not charging and/or the batteries are permanently 
damaged.  A service call  is required.  

 
CAUTION In newer workstations, the workstation reports battery 

capacity on the workstation remote power display (under the 
monitor).  The battery system is designed to be replaced by 
authorized and trained NeuroLogica service personnel, only. 

 
CAUTION The workstation will not report the proper battery capacity 

and status if a network connection is not made. 

 
CAUTION The system can only be charged from a correctly rated wall 

outlet.  A rating information plate is located on the product 
system label (lower backside panel or lower left side panel, see 
Figure 1: Product-marking plate on scanner on page 37). 

 
CAUTION The system (including the workstation) should be plugged in at 

all times, when not in Transport mode, being transported or in 
scanning use, to help maintain battery life and proper system 
operation.  Failure to do so could result in permanent battery 
damage, which will require a service technician to repair. 

  
CAUTION The system may not complete a scan when below 25% battery 

capacity while unplugged. 

 
CAUTION If the system is unplugged and battery capacity reports to be 

0%, permanent battery damage can occur. 

 
CAUTION The power cord selection must not be less than 110v/12A 

(USA) and 220v/7.5A (EU and Asia), made of 2.08mm 
(diameter) copper wire in accordance with local power supply 
cable standards. 

Note  Medical grade power cords should be used at all  t imes.  

Scanner X-ray tube capacity 

The percentage of the tube capacity required for a scan = ((kV x mA x scan 
time(s))/180000) x 100%.  Approximately 0.11% capacity is regained each 
second during cooling. 

 
Figure 10:  Scanner X-ray tube capacity icon 
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Maintenance and service 

 
WARNING Equipment maintenance of non-medical electrical equipment 

should not be performed in the patient environment. 

 
WARNING Maintenance checks and all service must be performed by 

NeuroLogica trained service personnel.   Service personnel 
use Service manual (1-NL4100-062) to effectively perform 
needed service and preventive maintenance and inspection 
of the system.  See “Contact information” on page 24 for 
NeuroLogica’s contact information. 

 
WARNING The only calibration performed by the user on this system is 

called daily calibration and is described in detail later in this 
user manual.  All other calibration needs that arise must be 
performed by trained service personnel at NeuroLogica Corp.  
See “Contact information” on page 24 for NeuroLogica’s 
contact information. 

 
CAUTION Service personnel must complete training at NeuroLogica 

Corp. for the system and its accessories prior to conducting 
any service activities. 

Users are not to perform service or maintenance on the 
system at any time.  This includes battery maintenance. 

Note  NeuroLogica recommends that a quarterly preventive 
maintenance be conducted by NeuroLogica’s service 
personnel/trained facil ity bioengineer .   

 Instruct ions for replacing serviceable parts are identif ied 
in the Service Manual (1 -NL4100-062).  

Cybersecurity 

 
WARNING Upon detection of a cybersecurity threat to the system or 

workstation, do the following: 
• Immediately contact Technical Support. 
• Discontinue use of system (enabling the EMERGENCY-

STOP if needed). 
• Remove any ethernet and/or wireless connection that 

has been made with the facilities’ IT-network. 
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Continued use of the system can occur after Technical 
Support has assessed the situation and provided the go-
ahead to do so. 

Note NeuroLogica Corp. recommends the customer facil ity 
util ize an IT-network that provides sufficient means of 
cybersecurity control to help maintain the requirements of 
HIPAA.  

Contraindication(s)  

There are no contraindications associated with CT scanning. 

Personnel privileges and terminology  

Qualified operator 

The operator as determined by the healthcare facility and assigned by a user 
with administrative privileges – who by their education, certification, 
experience, and training, are sufficiently qualified to competently perform 
clinical scans on the CT system.  See “Understanding the types of users” on 
page 98 for a description of the types of users. 

Operator of record 

The operator of record is an operator or health care professional currently 
logged onto the CT system with a unique User ID and password identifier. 

Scanning privileges 

Scanning privileges are granted to a qualified operator, assigned by a user 
with administrative privileges, to conduct clinical scans on the CT system.  This 
privilege level allows use of all clinical protocols to scan the patient. 

Protocol privileges 

Protocol privileges are granted to a qualified healthcare professional, as 
determined by the healthcare facility, and assigned to users with 
administrative privileges, who by their education, certification, experience, 
and training, is sufficiently qualified to competently save or modify clinical 
protocols on the CT system.  A healthcare professional with protocol 
privileges does not necessarily need scanning privileges on the CT system. 
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Administrative privileges 

Administrative privileges are granted to qualified healthcare professionals as 
determined by the healthcare facility who by their education, certification, 
experience, and training, are sufficiently qualified to competently assign, 
maintain, and oversee the assignment of personnel to scanning privileges 
and/or protocol privileges on the CT system they administer.  Healthcare 
professionals with administrative privileges do not necessarily need scanning 
privileges or protocol privileges on the CT system. 

Clinical operation 

CT system operation that involves scanning patients and/or creating or editing 
protocols intended for use on patients. 

Clinical scanning 

CT system operation that involves scanning of patients. 

Clinical protocol  

A protocol on the system intended for use on patients. 

Kernel 

The kernel or filter is defined as the reconstruction algorithm or mathematical 
equation used for convolution of the attenuation profiles and reconstruction 
of the CT images.  The choice of the kernel determines the noise level and the 
contrast resolution of the reconstructed images. 
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Chapter 2     System Overview 

The BodyTom 64 CT system lets you scan patients in a room or ward, an 
Emergency Room (ER), Operating Room (OR), Radiology, and procedure 
rooms. 

This chapter provides a brief introduction to the BodyTom 64 system.  
You will learn how to use the BodyTom 64 system (to see an illustration, 
see Figure 11 on page 73) – in subsequent chapters. 

Note  Whether you turn on the scanner or the workstat ion 
f irst does not matter; however, it  is advised to power 
up the BodyTom 64 system hardware f irst ,  to allow 
time for the scanner to warm up.  

BodyTom 64 system 

The BodyTom 64 is a 64-slice, mobile, battery-operated CT scanner and 
software system with Axial, Helical, and Dynamic, capabilities. 

The BodyTom 64 core system consists of the scanner, the workstation, 
and the phantom holder.  Consider the following: 
• The scanner and workstation communicate using a wireless 

connection.  They communicate using an ethernet connection, if 
necessary. 

• The BodyTom 64 workstation is a computer with custom software 
that allows the user to employ pre-defined, system protocols or 
devise unique protocols for performing patient studies.  It also allows 
the user to update patient information and store images.  The 
viewing portion of the BodyTom 64 workstation allows the user to 
view images in more detail and includes tools to help facilitate 
diagnosis by a physician. 

• The maximum scout length is 2000mm. 
• The scanner can create a slice-thickness of 0.6mm, 1.2mm, 2.4mm, 

4.8mm, and 9.6mm in Axial mode. 
o In Axial mode, the BodyTom 64 scans 9.6mm of anatomy with 

each rotation. 
o The maximum scan-range in Axial mode is 900mm.   

• The scanner can create a slice-thickness of 0.6 x 0.6, 1.2 x 0.6, 1.2 x 
1.2, 2.4 x 1.2, 2.4 x 2.4, 4.8 x 2.4, and 4.8 x 4.8 in Helical mode.   
o In Helical mode, the BodyTom 64 scans 30.7mm of anatomy at a 

pitch of 0.8.   
o The maximum scan-range in Helical mode is 2000mm. 
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• In Dynamic mode, the BodyTom 64 scans 38.7mm of anatomy. 
• The scanner is compatible with surgical navigation, HIS, RIS, and 

PACS. 

 
Figure 11: BodyTom 64 system configuration 

For information on cleaning and storing the scanner, see “Cleaning the 
scanner and workstation” on page 346 and/or “Storing the system” on 
page 348. 

Overview of the scanner control panels  

Control panels appear on the right and left side of the scanner.  The 
scanner control panel allows the operator to start and stop a scan.  All 
motion and x-ray generation can also be quickly stopped using the 
EMERGENCY STOP button.  After the patient is registered and you select 
a protocol, you must start the scan from the scanner control panel, 
which is located under the scanner’s display screen.  The operator 
control panel lets you power on the scanner, lift, and lower the scanner, 
and lock scanner functions. 

Note To determine where personnel should stand during a 
scan, consult with the hospital physicist .  See “ Scatter 
radiation” on page 236. 

1 QA stand and phantom 
2 BodyTom or gantry 
3 BodyTom workstation 
4 Bed with patient near bore 
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Controls on the left  end of the scanner 

 
Figure 12: Left end of the scanner 

Table 19: Left end of the scanner 

Scanner control  Description 

 

Video camera shows what is in 
front of the scanner during 
transport. 

 

The scanner’s display screen 
shows the status of the scanner 
and workstation (see Table 25 on 
page 112 for a list and description 
of each status symbol). 
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Scanner control  Description 

 

START and CANCEL buttons (to 
the left) and the EMERGENCY-
STOP (E-STOP) button (to the 
right) on the scanner control 
panel. 

 

Ethernet port to connect to the 
workstation, and four additional 
data-access ports on the data 
interface panel. 

 

120VAC/20A and 240VAC/30A 
plugs. 

 

The pendant; see “Overview of 
the pendant” on page 79 for 
more information. 
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Controls on the right end of the scanner 

 
Figure 13: Right end of the scanner 

Table 20: Right-end of the scanner 

Scanner control  Description 

 

The scanner’s display screen 
shows what the video camera 
captures and where the scanner 
is moving during transport. 

It also shows the status of the 
scanner and workstation (see 
Table 25 on page 112 for a list 
and description of each status 
symbol). 
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Scanner control  Description 

 

START and CANCEL buttons (to 
the left) and the EMERGENCY-
STOP (E-STOP) button (to the 
right) on the scanner control 
panel. 

 

Drive bar and enable bar 
(arrow). 

 

Key lock, the Power-ON and 
Power-OFF buttons for scanner, 
and the Rocker-Switch-Lift Up 
and Down buttons on the 
operator control panel. 

 

The pendant; see “Overview of 
the pendant” on page 79 for 
more information. 
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Identifying operator control panel buttons 

 
Figure 14: Operator control panel buttons and indicators 

 
Table 21: Operator control panel buttons and indicators 

Operator 
control panel 
buttons and 
indicators  

Name Description 

 
LOCK 

Use the key to lock or unlock the 
operator control panel buttons.  If 
the key is in the locked position all 
scanner buttons are disabled.  If 
the key is in the unlocked position 
all scanner buttons are enabled. 

 

OFF 

Press to power down the entire 
scanner. 

During shutdown, the light blinks 
until the shutdown task is 
complete. 

 

TRANSPORT 

Press to activate Transport mode. 
Use the Rocker-Switch-Lift Up and 
Down buttons to put the scanner in 
Transport mode and the drive bar 
to transport the scanner. 

 

ON 

Press to power up the scanner. 

During power-up, the light blinks 
until power-on task is complete. 

 

BATTERY 
BARS 

Indicates the scanner’s battery 
charge level. 

Each bar represents 10% of charge.  
If plugged into an AC outlet, the 
last bar blinks indicating the system 
batteries are charging. 
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Operator 
control panel 
buttons and 
indicators  

Name Description 

 

Rocker-
Switch-Lift 
Up and 
Down 
buttons 

Press and hold the UP or Down 
Rocker-Switch-Lift button to raise 
or lower the scanner. 

Lowering the scanner to floor level 
makes the scanner ready to scan.  
Raising the scanner makes the 
scanner ready for transport. 

When the button is inactive, it is 
dim; when the button is active it is 
illuminated. 

Overview of the pendant 

The pendant lets you move the scanner, turn on and off the lasers, zero 
reference the scanner, and program scan and rest positions for the 
scanner.  See Table 22 for a list of what each button activates. 

Table 22: Pendant buttons 

Pendant Button Description Action 

 
POWER 

Illuminates when 
power is supplied to 
pendant. 

 

LASER 

Turns on all 
positional lasers.  
While the lasers are 
on, the scanner 
spins for the 
internal laser to be 
seen within the 
scanner opening. 

 

GO TO SCAN 
PLANE 

Moves the scanner 
forward 
approximately 
30cm.  This is the 
distance between 
the internal and 
external lasers. 
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Pendant Button Description Action 

 

 

ZERO 
REFERENCE 

Sets the scanner to 
zero before starting 
a scout or a scan. 

 

MOVE 
BACKWARD 
(slow) 

Pressing and 
holding moves the 
scanner backward 
10mm per second. 

 

MOVE 
FORWARD 
(slow) 

Pressing and 
holding moves the 
scanner forward 
10mm per second. 

 

MOVE 
BACKWARD 
(fast) 

Pressing and 
holding moves the 
scanner backward 
60mm per second. 

 

MOVE 
FORWARD 
(fast) 

Pressing and 
holding moves the 
scanner forward 
60mm per second. 

 
SET MEMORY 

Allows the user to 
program Scan and 
Rest positions for 
the scanner. 

 

SCAN 
POSITION 

Moves the scanner 
to the Scan Position 
saved using the Set 
Memory feature. 

 

REST 
POSITION 

Moves the scanner 
to the Rest Position 
saved using the Set 
Memory feature. 

 
DANGER Store the pendant in its holder when not in use to prevent 

accidental and/or unintentional contact by patient and/or 
users. 
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Figure 15: BodyTom 64 remote-control pendant 

The scanner’s position appears on the positional display on the front of 
the scanner.  You can use the pendant to zero reference the scanner.  
The display shows a positive or negative positional number. 

 
Figure 16: Scanner’s positional display 

Note  The two light panels on either side of the scanner’s 
position indicate x-ray is active, when lit .   The scanner 
produces an audible alert during scanning.  
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Overview of the workstation 

 
Figure 17: Workstation with leaded-glass shield (optional installation) 

The workstation is an accompanying part of the scanner; it is the 
computer and control unit that operates most functions of the system.  
All basic information related to the workstation (for example, operating 
distance, warnings and cautions, connectivity, functionality, etc.) appear 
in Chapter 4    Basic Workstation Operations.  The workstation includes 
the computer, monitor, ethernet connections, and the remote controls.  
The workstation also includes the Uninterruptable Power Supply (UPS).  
The workstation can be installed with an optional leaded-glass shield 
(shown in Figure 17) for additional protection. 

The workstation enables you to easily move it wherever you need it to 
go.  The workstation is designed to let you navigate in and out of 
elevators, over doorway thresholds, or on any type of floor including 
carpet, with ease. 

The workstation can be set up either wirelessly or hardwired to the 
scanner.  The administrator makes sure wireless is enabled before you 
create a wireless connection between the workstation and the scanner 
(with System Configuration > Scanner Setup).  See “Remote Support 
Setup” on page 130 to learn how the administrator enables the wireless 
connection. 

Note  Wireless connections can be slower than a hardwired 
connection.  If  an unexpected delay or disconnection , 
due to environmental/bandwidth interference , occurs 
when using wireless,  it  is recommended to hardwire an 
ethernet cable to the scanner for continued 
communication.  
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 After respect ive peripherals are properly plugged in, 
make sure al l  applicable power switches are in the on 
position before using the system.  

 For any devices connected to an AC outlet, make sure 
the outlet is providing required power.  

 

 
CAUTION When not in use, the scanner and workstation should always 

be plugged into power outlets to ensure maximum efficiency. 

The system should be stored in an area with limited access to 
prevent inadvertent damage. 

See “Powering on and off the BodyTom 64 system” on page 
87. 

Note  Be sure to keep the workstat ion plugged in when it  is 
not in use to charge the battery.  Charge time while 
off  is  ~ (approximately) 2  hours; while in use, charge 
time is ~ 8 hours.  

 
CAUTION Verify that the ethernet cable is unplugged from the 

workstation to avoid damage to the cable and outlet during 
transport. 

Note Before using the workstation, be sure to read and 
understand how to clean and maintain it .   See  
“Cleaning the scanner and workstat ion” on page 346 .  

The product safety coverage of the workstation (Safety Certified to IEC 
60950 standards) was evaluated and deemed acceptable for use with the 
BodyTom 64 to appropriate IEC 60601-1 and/or IEC 60601-1-1 
harmonized national standards. 

The workstation will be kept outside the patient environment as defined 
by IEC 60601-1-1.  BodyTom 64 is suitable for use inside a patient 
environment. 

 
CAUTION Do not connect or use equipment beyond what is specified by 

NeuroLogica Corp.; this practice may lead to a reduced level of 
system safety. 
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The recommended distances, provided in Figure 18, relate only to 
distances specified by IEC 60601-1 and do not relate to specific distances 
required for ionizing radiation and/or stray radiation protection for 
operators and bystanders. 

 
Figure 18: Workstation safe distance location (two views) 

Workstation remote power controls  

The following are found on the workstation: 
• Remote power controls 
• Microphone and controls 
• Speaker and controls 

 
Figure 19: The remote power display 
 

See “Using the workstation” on page 98. 

Note The microphone and speaker are plugged in to the USB 
port on the back of the monitor.  If  the port is 
changed, you will  need to reboot the workstation.  
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Workstation UPS 

The workstation uses an Uninterruptable Power Supply (UPS) to supply 
power to the workstation for approximately (~) 6-8 hours when the 
workstation is unplugged.  The UPS is located inside the workstation.  
This feature allows the new workstation to run when it is not plugged in 
to a wall outlet. 

Workstation considerations before use  

Before using the workstation, consider the following: 
• If a problem is detected with the workstation, make sure repairs or 

adjustments are made to it before using it. 
• Make sure the workstation operates easily and freely, and all parts 

work smoothly. 
• Check for excess noise, vibration, or a change in the ease-of-use. 

o Noise, vibration, or change in ease-of-use can be signs of a 
problem and a need for servicing. 

• Be sure to read its warnings carefully and completely before using the 
workstation.  Do not attempt to service the workstation.  Only skilled 
service personnel are permitted to service the workstation.  See 
“Hazard information” on page 54. 

 
CAUTION Users are not to perform service or maintenance on the 

system at any time.  This includes battery maintenance. 

 
CAUTION Failure to heed these warnings may cause injury to the user, to 

others, or damage to the equipment. 

Note  NeuroLogica recommends that a quarterly preventive 
maintenance be conducted by NeuroLogica’s service 
personnel/trained facil ity bioengineer .  

 Instruct ions for replacing serviceable parts are 
identif ied in the Service Manual (1 -NL4100-062).  

Keyboard and mouse 

The workstation comes with a keyboard and a mouse (1 for left-mouse 
button; 2 right-mouse button). 

        
Figure 20: Workstation keyboard and mouse 
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Workstation power cord 

The power cord lets you power up the workstation. 

Consider the following: 
• Plug style will vary depending on factory installed elements based on 

geographic location and voltage requirements. 

 

 
CAUTION The power cord selection must not be less than 110v/12A (USA)  

and 220v/7.5A (EU and Asia), made of 2.08mm (diameter) 
 copper wire in accordance with local power supply cable standards. 

Note  Medical grade power cords should be used at all  t imes.  

Parts that potentially come into contact with the 
patient 

While you use the system, be mindful that the patient may come into 
contact with the following parts: 
• The BodyTom 64 system, especially the painted, external surfaces of 

the system’s covers. 
• Universal transfer board, if purchased. 
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Chapter 3     Basic Scanner Operations  

Basic scanner skills include powering on and off the scanner, learning how to 
use and navigate the operator and scanner control panels, how to use E-
STOP, and how to use the Rocker-Switch-Lift UP and DOWN buttons to lift 
and lower the scanner. 

Scanning basics you should know before scanning a patient include how your 
system should be set up, how to position the scanner and the patient before 
the scan, and how to start a scan from the operator control panel. 
 

Note It  is recommended that the scanner is on for at least 60 -90 
minutes prior to performing the daily air  calibration or 
scanning patients.  

 It  is recommended practice that the scanner is plugged in 
and turned on even when it  is not in use.  

Powering on and off the BodyTom 64 system 

The BodyTom 64 is not intended to be turned on and off; however, if the 
system should lose power, it is advised to power on the scanner first, to allow 
time for the scanner to power up. 

To power up the scanner 

 Press the Scanners Power-On until the green light blinks. 

 
Figure 21: Scanner Power On button 

2. Wait until the scanner is fully powered up, prior to powering up the 
workstation. 

To power down the scanner 

 Press and hold the scanners Power-Off button until the greenlight blinks.  
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Figure 22: Scanner Power Off button 

Note  The Scanner’s tube heat must be below 20% before the 
scanner powers down.  If  the tube is too hot, a message 
will  display on the LCD scanner control panel instructing 
you to wait until  the tube heat is low enough to safely 
power off the scanner.    

Consider the following: 
• Make sure the scanner is properly plugged in whenever possible; be sure 

the outlet(s) provide the required power.  Plugging the electrical cord into 
the wall charges the batteries; the batteries are the only power source 
that allows the scanner to perform scans.  

• When plugging in the scanner, make sure the cable lays flat on the floor to 
ensure the safety of hospital personnel.  In addition, make sure that the 
floor behind the scanner is free of any obstructions or debris that could 
interfere with the centipedes during scanning. 

  
Figure 23: AC cord and storage on scanner (120V left plug in or 240V right plug out) 

 

 

 
Figure 24: Scanner’s power cord receptacle for 120VAC and 240/VAC 

Be sure to keep the workstation plugged in when it is not in use to charge the 
battery.  Charge time while off is ~2 hours; while in use, charge time is ~8 
hours. 
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Checking a connection between the workstation and the 
scanner 

To check if a wireless connection exists between the scanner and the 
workstation, look for the Wireless connection icon on the scanner’s display 

screen: . 

Note  You must be logged into the workstation before this icon 
is visible on the scanner ’s  display screen.  

If the workstation is connecting to the scanner by hardwire, check if the 
supplied ethernet cable is connected between the workstation and scanner. 

 
Figure 25: Scanner hardwired to the workstation with an ethernet cable to data-
access ports 

The administrator makes sure wireless is enabled when creating a wireless 
connection between the workstation and the scanner (with System 
Configuration > Scanner Set Up, through the workstation).  See “Remote 
Support Setup” on page 130. 

Note  Make sure that  the wireless setup in System Configuration 
has been done before making a wireless connection 
between the workstation and the scanner.  See “ Scanner 
Setup”  on page 129 and “Remote Support Setup”  on page 
130. 

 Wireless connections can add lag time when compared 
with a hardwired setup.  If  an unexpected delay or 
disconnection occurs when using wireless, it  is 
recommended to hardwire an ethernet cable to the 
scanner for continued communication.  
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Moving and transporting the scanner 

To move the scanner, the scanner must be in Transport mode.  The Rocker-
Switch-Lift UP and DOWN buttons are located on the side of the scanner, on 
the operator control panel.  These UP and DOWN buttons prepare the 
scanner to move up for transporting or down for positioning the scanner 
before scanning a patient.  To set the scanner in Transport mode, go to the 
operator control panel and follow the procedure below. 

Note  If  the scanner has been calibrated for multiple rooms, you 
must select the room prior to scanning to ensure the 
correct f loor-calibration f i le is loaded.  See “ Selecting a 
room for the BodyTom 64 ” on page 184. 

 
CAUTION Before transporting the scanner, verify that the ethernet 

cable is unplugged from the workstation to avoid damage to 
cable and receptacle.  Verify that the power cable is 
unplugged from the wall to avoid damage to the cord and 
outlet. 

 Press the Transport button. 

 
Figure 26: Transport button on the operator control panel 

 Press and hold the Rocker-Switch-Lift UP button to raise the scanner off 
the centipedes for transport. 

  
Figure 27: Rocker-Switch-Lift UP (top) and DOWN (bottom) button 

Note  Hold the top Rocker-Switch-Lift  UP  button until  the 
scanner is completely raised and on its castor wheels .  The 
top Rocker-Switch-Lift  UP  button i l luminates when it  is in 
the up position as shown in Figure 27.  

 Grip the drive bar with both hands. 
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Figure 28:  Drive bar front 

    
Figure 29: Drive bar 

Note The drive bar  is equipped with an enable bar .   The enable 
bar is a darker soft rubber material located on front of the 
drive bar.  While holding the drive bar, squeeze the 
rubberized enable bar  to activate system motion.  If  you 
let go of the enable bar ,  the scanner stops.  

 Move the scanner. 

The following points explain how to hold the drive bar to move it forward, 
backward, left, and right: 

• Push forward with both hands and use equal pressure to move the 
scanner forward. 

• Push with the right hand to turn the scanner left; push with left hand 
to turn the scanner right. 

• Pull back on the drive bar to move the scanner in reverse. 

Note A three-point driving technique is required to turn in 
smaller spaces.  

 

 
CAUTION NeuroLogica recommends two people move the scanner 

within the facility: one to steer and another, in front of the 
scanner, to insure there are no obstacles.  Two people 
ensures there are no collisions while maneuvering through 
tight hallways and around corners. 
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WARNING If a loss of control is encountered while moving the system, 

release the enable bar to stop ALL movement. 

 
WARNING When transporting, use the video camera and scanner’s 

display screen as guides to avoid hitting objects. 

 
CAUTION To prevent potential for injury from overbalancing and/or 

tipping, do not attempt to turn this system on an incline 
during transportation. 

 
WARNING Do not move the system right or left if transporting on an 

incline becomes necessary.  Always keep the system in a 
straight motion.  Contact Technical Support for assistance 
when movement is required on an incline. 

 
CAUTION The BodyTom 64 scanner is larger than most medical 

equipment.  Therefore, NeuroLogica recommends proper 
training and practice. 

Drive direction of scanner  

 
Figure 30: Scanner drive direction (right side view) 

Safety bumper system 

The scanner’s transport system is equipped with an active, safety-bumper 
system.  Each safety bumper is electronically controlled to terminate motion 
in the direction in which the system is moving when the bumper is activated.  
If a bumper is pressed due to a collision, the drive system is disabled in that 
direction.  All other directions are still enabled to allow you to reposition the 
scanner away from any impact area.  The activation force needed to trigger 
the bumper system is approximately 7lbs. 
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Figure 31: Bumper system 

Positioning the scanner before a scan 

 
WARNING Never raise or lower the scanner when the patient is 

positioned in the system’s bore.  Always move the patient 
and table away from the bore before raising or lowering the 
system itself. 

 Ensure the scanner is in Scan mode. 

To move the scanner, see “Moving and transporting the scanner” on page 
90.  See also “Performing a scan” on page 255. 

 To lower the scanner, press and hold the Rocker-Switch-Lift DOWN button 
until the scanner is completely lowered on its centipedes. 
The Rocker-Switch-Lift DOWN button illuminates when the scanner is 
completely lowered on the centipedes. 

 Align the patient and table with the scanner, ensuring the patient is in the 
center of the Field Of View (FOV), also ensure that the scanner will not 
collide with the patient, patient support and/or any life supporting devices 
prior to scanning.   

Note  Be sure the f loor is clear of debris or anything that can 
cause interference with the scanner’s centipedes.  

 Make sure the patient scan table is locked. 
 

 
CAUTION Make sure to lock the patient bed or scan table to prevent it 

from moving during the scan. 

 Adjust the scan table height so that the patient is centered within the 
bore. 
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Figure 32: Patient centered in bore (height positioning) 

Positioning the patient using the laser lights 

 
WARNING Before scanning, position the patient in such a way that 

extremities, hair, life-support equipment, etc. have sufficient 
clearance to prevent contact with scanner and or when used 
with accessories and options, such as head frames, scan 
boards, etc.  

 
WARNING Make sure the patient is supported properly when positioned 

(both height and alignment) to prevent injury during 
scanning. 

 
WARNING Make sure the foot pedal brake on the scan table/bed is 

engaged to prevent it from moving during the scan. 

 
WARNING Never raise or lower the scanner buttons on the operator 

control screen when a patient is positioned in the system’s 
bore.  Always slide the scan table away (by disengaging its 
brake) from the system before raising or lowering the system 
itself. 

 
CAUTION The following-instructions for patient positioning should be 

performed in accordance with NeuroLogica Corp.’s clinical 
training. 

 
CAUTION If the patient becomes nauseated or is unable to be still 

(motionless), stop the scanner immediately using the E-STOP 
button. 

Note  To determine where personnel should stand during a scan, 
consult with the hospital physicist.  NeuroLogica 
recommends a distance of 8 -10 feet.  
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The scanner provides a rotating laser-light to guide you to properly position 
the patient.  The laser indicates the center of the scan plane.  The laser light is 
always centered on the actual x-ray beam.  For multi-slice protocols, this 
means that the laser light will indicate the middle position of all simultaneous 
acquisitions being acquired.  There is no offset between the laser-light plane 
and the actual scan-plane.  The accuracy of the position of the laser plane, 
with respect to the scan plane, should be +/- 2mm. 

There are four laser lights: one Sagittal, one Axial or Transverse (which is 
mounted internally and spins within the system’s bore) and one set of 
external Coronal and Transverse/Axial lasers.  Keep the following in mind: 
• To adjust vertical or horizontal positions, use table and bed controls, only. 
• To adjust Z axis, walk the scanner to position using the pendant. 

See “Overview of the pendant” on page 79 to see how buttons act. 

 Position the patient on the bed. 

 Align the bed to the scanner and make sure there is sufficient clearance 
around the patient by positioning the patient in the center of the FOV. 

 
Figure 33: Phantom positioned in center of FOV 

 Use the pendant positioning buttons to center the patient within the bore. 
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Figure 34: Pendant use for positioning lasers upon patient 

 On the pendant, press the LASER button to turn on all positional lasers. 

 
Figure 35: Positioning lasers upon patient 

See the laser precautions in “Laser safety” on page 56. 

 Use the scanner’s positional display to identify the position of the scanner. 

 
Figure 36: Positional display 

 Consider the following: 
• If the patient is conscious, request the patient remain still with eyes 

closed throughout the entire scan. 
• If the patient is unconscious, secure the patient. 
• Follow the appropriate facility guidelines when scanning unconscious 

patients if the patient’s eyes remain open. 

Operating the E-STOP button 
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Figure 37: BodyTom 64 E-STOP locations (right and left)  

 
Figure 38: E-STOP button on the scanner control panel on both the left and right 
sides of the scanner 

 Press the E-STOP button to perform the following: 
• Stop the system (if it loses control). 
• Stop all system motion and x-ray. 
• Remove power to the gantry drives and x-ray system. 
• If the scanner starts to move unexpectedly. 

 Make sure to resolve the situation. 

Note  When E-STOP  is activated, the moving gantry may overrun 
by less than 10mm.  

Restoring the system from E-STOP 

If you have pressed the E-STOP button to stop the system, follow these steps 
to restore the system, using E-STOP. 

 Make sure any hazard is removed. 

 Twist the E-STOP button clockwise until the button pops out to restore 
the system after pressing the E STOP button. 
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Chapter 4     Basic Workstation Operations  

Basic workstation information includes understanding the different kinds 
of user access, learning how to power on and off the workstation, and 
getting familiar with the workstation screen, its menus, and tabs. 

Note  Whether you turn on the scanner or the workstat ion 
f irst (see Chapter 4) does not matter; however, it  is 
advised to power up the BodyTom 64 system hardware 
f irst,  to al low time for the scanner to warm up.  

Understanding the types of users  

There are three User Levels available on the workstation: administrator, 
limited operator, and restricted operator.  User ID’s and passwords can 
be created for individual users, and specific User Levels can be assigned 
to each user.  The following define the access levels for each User Level.  

Administrator 
Full access to the system and its configurations.  Can 
create protocols, User ID’s, and passwords, as well as 
access all functions of the system. 

Limited 

Modified access to the system.  Users with Limited 
access can modify protocols during scanning but 
cannot create and save protocols; has no access to 
system configurations.  

Restricted 

Users with Restricted access can scan with the 
system but are unable to make any changes to 
protocol parameters while scanning, they also have 
no access to system configurations. 

Using the workstation 

The workstation uses an Uninterruptable Power Supply (UPS) to supply 
power to the workstation for ~6-8 hours when the workstation is 
unplugged.  The workstation includes a computer, the remote power 
display, and a microphone and speaker. 

Identifying the workstation’s remote power display 

The Power On button on the remote power display allows you to power 
on the workstation. 
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Figure 39: Workstation remote power display 

The following describes the action of each workstation power-control 
button. 

Table 23: Workstation power-control buttons 

Workstation 
power-
control  
button 

Button or 
indicator name 

Description 

 
UPS battery level 

Shows the battery usage; each 
LED represents 20 percent of 
battery power. 

 
Power-On 

When the system has power, the 
LED light illuminates. 

 
Alarm 

When the system is at or less 
than 20 percent battery power, 
an alarm sounds, and the LED 
light illuminates to warn you. 

 

Power-On and 
Power-Off  

Press and hold the Power-On / 
Power-Off button for 3-5 
seconds to turn on and off the 
workstation. 

 
Mute 

Press this button to silence the 
alarm. 
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Identifying the microphone, speaker, and controls 

 
Figure 40: Microphone, speaker, and controls 

Table 24: Speaker control buttons 

Microphone 
button 

Name Description 

 

Microphone 
mute 

Press the Mic Mute button to 
mute the microphone. 
NeuroLogica recommends using 
the Mute button located on the 
bottom right of the workstation 
screen. 

 
Mute 

Click the Mute button, on the 
bottom right of the workstation 
screen to mute the microphone 
and speaker. 

 
Speaker 

The Speaker button appears on 
the bottom right of the 
workstation screen when the 
speaker is activated to hear the 
patient. 

   
Volume 

Press the “-“ button on the left 
side of the speaker to decrease 
the volume, press the “+” button 
on the right side of the speaker 
to increase the volume.  The 
speaker has illuminated volume 
lights to indicate volume level. 
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Powering the workstation 

 
Figure 41: Remote power display on workstation 

Note  Depending on the workstation, the Power-On  and/or 
Power-Off  button may not be in this location.  

To power up the workstation 

 Press and hold the workstation’s Power-On/Power-Off button on the 
remote power display until the green light blinks. 

To power down the workstation 

 Press and hold the workstations Power-On/Power-Off button on the 
remote power display until the green light blinks. 

 

Note  The workstat ion does not allow you to wait for the 
computer to shut down before communicating to the 
workstat ion to shut down; this is because the workstation 
sends a toggling signal to the computer.  If  the computer is 
off,  it  wil l  turn back on.  The workstation must already be in 
the process of shutting down by the time the computer is 
fully turned off.  
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Logging in to the workstation 

To gain access to the workstation application, you must provide the 
system with credentials.  These credentials consist of a User ID and 
password.  Make sure you have a valid User ID and password before you 
log into the system. 

If you do not have a valid User ID and password, ask your supervisor or 
administrator for one. 

 Click the User ID dropdown and select your User ID.  

 
Figure 42: User ID dropdown box 

 
Figure 43: User ID dropdown list 

 Click in the Password field and type your password.  Passwords are 
case sensitive.  
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Figure 44: Password text box 

 Click the Login button. 
If the User ID and/or password are invalid, a prompt appears to re-
enter the information. 

Note  You have a l imited number of login attempts before 
the system locks the account .  An administrator can 
unlock the account .  See “System and User 
Configurat ion and Setup”  on page 117 for more details 
about unlocking an account.  

When the User ID and password are verified, you are logged into the 
system. 

The main screen to the workstation software appears with the Patient 
Registration tab open. 

 
Figure 45: Patient Registration tab 
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 Verify that the correct User ID appears at the top center of the 
screen. 

 
 

 

 

 

 

 

Figure 46: User ID, current date, and time 

If the correct User ID does not appear, contact your supervisor or 
administrative user to verify the account. 

Locking and unlocking the workstation 

The Lock button indicates whether your system is in Lock or Unlock 
mode.  This button is a toggle, if the workstation is locked, the Unlock 
button shows, if the workstation is unlocked, the Lock button shows.   

To prevent unwanted personnel from accessing the system, you should 
lock the workstation if you intend to leave the area for any period.  When 
you lock the workstation, it remains on, but no one can access it without 
supplying a User ID and password. 

Using Lock if you need to step away from the workstation 

 Click the Lock button located at the top-and center of the 
workstation screen. 

 
Figure 47: System Lock button 

 
The Lock/Unlock System popup appears. 
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Figure 48: Lock/Unlock System popup to lock the workstation 

 

 Enter the User ID and password by selecting the option from the 
dropdown and entering information in the Password field. 

 Do one of the following: 
• Click the Lock button to lock your system. 

When you select this option the Lock button changes to the 
Unlock button.  

• Click the Cancel button to return to your work. 

Using Unlock to view your work 

 Click the Unlock button. 

 
Figure 49: Unlock button 
 

The Lock/Unlock System popup appears. 
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Figure 50: Lock/Unlock System popup to unlock the workstation 

 Enter the User ID and password by selecting the options from the 
dropdown and entering information in the Password field.  

 Do one of the following: 
• Click the Unlock button to unlock your system. 

When you select this option, the button changes to the Lock 
button. 

• Click the Cancel button to return to your work. 

Navigating around the workstation’s main screen  

The workstation screen shows similar information, even if the screen 
elements change when you perform different actions.  These constant 
screen elements are as follows: 

Main menu options 
Appears in the top left corner of the screen and 
shows the File, Tools, Customize, and Help 
commands. 

User, date, and time 
Appears in the center of the screen and displays 
a greeting for the user, the signed-in user’s 
name, the current date, and time. 

Scanner and 
workstation status 

Appears in the top right corner of the screen 
and displays status information for both the 
scanner and workstation. 

The main screen to the workstation software always opens with the 
Patient Registration tab. 
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Brief overview of the main menu 

The main menu provides you access to the basic functions from the 
commands: File, Tools, Customize, and Help. 

The main menu appears on every screen and is always located in the 
same location, regardless of what you are doing. 

 
Figure 51: Main menu 

Note  To select commands,  cl ick the f irst command and the 
subsequent commands.  For example,  if  you see 
Customize > System  that means, cl ick Customize  from 
the main menu and then click System .  

Brief overview of the File menu 

When you log off, restart, or shutdown the application and/or the 
workstation, you must use your User ID and password to log back in. 

Logging off the system 

 Click File from the main menu. 

 
Figure 52: File menu 

The File dropdown appears. 

 
Figure 53: File > Log Off 

 Click Log Off from the dropdown to Log Off the workstation software.    
The Login popup appears. 
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Figure 54: Login popup 

This is also the login and shutdown portal.  You can login or shutdown the 
workstation from this popup. 

Restarting the application  

You can restart the application software using the following steps.   

 Click File from the main menu. 

 
Figure 55: File dropdown menu 

 Click Restart Application. 

The following Restart Application popup appears. 

   
Figure 56: Restart Application popup 

 Perform one of the following: 
• Click the Yes button to restart the application software.  
• Click the No button to return to the screen. 
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Brief overview of the Tools menu 

This menu provides you with tools to store and print, set up protocols, 
and test your system to ensure it is operating as specified.  

 
Figure 57: Tools dropdown menu 

 Click Tools from the main menu. 

 Click one of the following from the dropdown: 

Store/Print Queue 

The Store/Print Queue displays the status of 
studies being archived.  You will learn more 
about how to store to various media later in 
this user manual; see page 117. 

Protocol Manager 

Allows users with Administrative privileges 
to create, modify, delete, and/or upload 
protocols to the scanner.  You will learn 
more about how to use Protocol Manager 
later in this user manual; see page 185. 

Quality Assurance 
(QA) 

The tool that verifies the system is at its 
optimum performance.   You will learn more 
about QA later in this user manual see page 
216. 

Brief overview of the Customize menu 

This menu provides you with tools to set up the system as well as define 
user profiles. 

 
Figure 58: Customize dropdown menu 

 Click Customize, then one of the following sub commands from the 
drop-down list: 

System 

Allows users with Administrative privileges  to 
customize site-related settings; see “Chapter 5    
System and User Configuration and Setup” on page 
117. 

User 
Allows you to customize layouts in the system as 
well as set the password.  See “Chapter 5    System 
and User Configuration and Setup” on page 117. 
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Select Room 

Allows you to identify and select the room the 
scanner will be used in.  See "Selecting a room for 
the BodyTom 64Selecting a room for the ” on page 
184. 

Getting Help from the Help menu 

NeuroLogica Help includes an online user manual and information about 
the system.  It also provides remote support from NeuroLogica Technical 
Support for file transfer, remote upgrades, or system review and 
support.  When you enter a six-digit number, Technical Support will take 
control of the system to retrieve files or review the issue in question. 

 
Figure 59: Help dropdown menu 

Getting an online user manual 

To open a .pdf version of this user manual: 

 Click Help from the main menu. 

 Click User Manual from the dropdown list. 
A PDF version of this manual will be opened.  

Getting remote support 

 Click Help from the main menu. 

 Contact NeuroLogica Technical Support. 
See “Contact information” on page 24. 

 Click Remote Support from the dropdown list. 
The Support Connection window appears. 
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Figure 60: Support Connection browser window 

When connected to Remote Support, a NeuroLogica Technical 
Support representative will supply a six-digit code to start a remote 
support session, which allows the support representative to review 
your system and troubleshoot the issue. 

Getting information about the product and NeuroLogica 

To get additional information about the product and NeuroLogica: 

1. Click Help from the main menu. 

2. Click About from the dropdown list. 
The About Us popup appears. 

 
Figure 61: About Us popup 

The following information is found: 

Version(s) 
Identifies the current software versions for the 
system. 
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Licensed To Identifies who the product is licensed to.  

Station AE 
Title 

Identifies the title for your workstation (for PACS 
purposes). 

Licensed 
Packages 

Identifies any licensed packages available on the 
system.  

Getting to know the status bar 

The status bar appears in the top-right portion of the screen.  The status 
bar provides a quick view of the system’s current state.   Details for the 
icons on the status bar are in the tables below.  

 
Figure 62: Scanner and workstation status bar 

Table 25: Status bar icons 

Status bar 
icon 

Status bar icon 
name 

Status description  

 
Radiation status 

Identifies x-ray as on or off. 
The icon changes from a 
gray/black icon when x-ray is off, 
to a rotating yellow/black icon 
when x-ray is on. 

 
System state 

Identifies the system’s current 
state. 
The orb changes color depending 
on the state the system is in. 
See Table 26 on page 114 for a 
list of the different orb colors and 
system states they identify.  

 
Scanner position 

Identifies the system’s current 
position relative to its zero 
reference.  

 

System E-STOP 
status 

Identifies when E-STOP is 
engaged.  The icon will flash 
when E-STOP is pressed. 
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Status bar 
icon 

Status bar icon 
name 

Status description  

 

System tube heat 
status 

Indicates the current X-Ray tube 
heat status. The values are color 
coded as follows: 
Blue           0% - 19% 
Yellow         20% - 50% 
Orange        51% - 75% 
Red          76% - 100% 
 
NOTE: The scanners tube heat 
must be below 20% before the 
scanner powers down. If the 
tube is too hot, a message will 
display on the LCD scanner 
control panel instructing you to 
wait until the tube heat is low 
enough to safely power off the 
scanner.  

  

Scanner battery 
capacity status 

Indicates the remaining scanner 
battery percentage available. The 
capacity values are color coded 
as follows:  
Green           100% - 51% 
Yellow          50% - 25% 
Red               24% - 0% 

 
System air 
freshness status 

Indicates the air freshness status; 
it is recommended that an air 
calibration be performed:  

• Every eight (8) hours. 

• When the air freshness 
status falls below 50%. 

• If the scanner is moved to an 
area with a dramatic change 
in humidity and/or 
temperature. 

The calibration status values are 
color coded as follows: 
Green          100% - 51%  
Yellow         50% - 25%  
Orange        24% - 0%   

After calibration it returns to 
100%. 
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Status bar 
icon 

Status bar icon 
name 

Status description  

 

Workstation 
battery capacity 
status 

Indicates the remaining 
workstation battery capacity 
available. The capacity values are 
color coded as follows:  
Green           100% - 21% 
Yellow          20% - 11% 
Red           10% - 0% 

You will be prompted to plug the 
workstation into an outlet to 
charge if the battery capacity is 
low; a scan cannot complete 
when the battery capacity is 10% 
or lower.  

When the workstation reaches 
the red capacity range, the 
system will shut down.  A 
message informs you that the 
system will shut down due to low 
battery. 

The lightning bolt icon signifies 
that the workstation is currently 
charging and goes away when 
unplugged. 

 
Image storage 
space status 

Indicates the available disk space 
for image storage. The available 
space values are color coded as 
follows: 
Green           100% - 51%  
Yellow          50% - 20%  
Red           19% - 0%  

The system changes states as it performs different actions.   The 
following table indicates what state the system is in and the colored orb 
that correlates to that state. 

Table 26: System state orbs 

Orb Color  State 

 
Dark gray The system is in an unknown state. 

 
Light gray The system is powering up or down. 
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Orb Color  State 

 
Dark purple The system is busy. 

 
Purple The system is completing air calibration. 

 
Light purple The system is archiving. 

 
Blue The system is idle. 

 
Green The system is ready to perform a scan. 

 
Light yellow The system is planning. 

 
Dark yellow The system is preparing. 

 
Light orange The system is reconstructing. 

 
Dark orange The system is scanning. 

 
Pink The system is not ready. 

 
Red The system is in fault. 

The workstation tabs 

To perform a patient examination, you will use the following five tabs on 
the workstation: 

 
Figure 63: Workstation tabs to perform a patient examination 

The tabs include active tabs which will be green, and inactive tabs which 
will appear gray.   The active tabs are Patient Registration, Post 
Reconstruction, and Patient Browser.  The Acquisition and Viewing tabs 
require additional steps to be performed before they become active.   
The following actions are available in each tab: 

Patient 
Registration 

Allows you to register a patient either manually or 
from the hospital’s database sites.  
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Acquisition 
Allows you to select a protocol and perform the 
examination.  This tab is inactive until a patient is 
registered. 

Post 
Reconstruction 

Allows you to manipulate raw data in different 
parameters and settings after your scan is 
completed. 

Patient Browser 
Allows you to view, manipulate, and archive scans 
already performed. 

Viewing 
Allows you to view patient images.  This tab is 
inactive until a study is loaded from Patient Browser.  

In the following chapters, you will learn how to perform necessary steps 
to conduct a patient examination and learn how to manipulate and store 
the data you acquire. 
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Chapter 5     System and User Configuration and 
Setup 

A user with administrative privileges must set up the BodyTom 64 system 
configurations for other users.  System configuration is used to set up the 
scanner to meet site-specific needs.  Most windows contain self-explanatory 
instructions and refer to elements that are known to the administrative user 
with radiological education and training.   

Configuration includes setting up user permissions, or access privileges to 
manage other users, as well as servers, what is available through settings, 
presets, and other preferences for the use of the system at a site.   Many 
system configurations are permissible to the administrator, only.  While 
other configurations are permissible to users without administrator access. 

Note  You must have administrative access privileges and be 
logged in as an administrator to set configurations for 
the site.  

 Incorrect changes to the system configuration may make 
the system inoperative.  

The following table shows the System Configuration options that appear 
when you click Customize > System and provides a brief description of each.   

Table 27: System configuration tabs 

Tab name Description 

General 
Settings 

Allows the administrator to set system configurations 
such as hospital name, wireless settings, and dose 
report settings.   

User 
Accounts 

Allows the administrator to create and edit user 
accounts and permissions. 

DICOM 
Servers 

Allows the administrator to set up DICOM servers for 
archiving, such as PACS or HIS/RIS. 

DICOM 
Setting 

Allows the administrator to view and configure DICOM 
tags for HIS/RIS, MPPS, and Patient, Study, Series, and 
Image modules. 

Audio 
Configuration 

Allows the administrator to upload default audio files 
with protocols; also lets the administrator record, play, 
and remove audio files. 

Dose 
Configuration 

Allows the administrator to set up dose notifications, 
dose alerts, and configure dose limits for specific scans. 

Windowing 
Presets  

Allows the administrator to view and modify kernel and 
window width and window center presets. 
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Tab name Description 

Audit Trail 
Viewer 

Allows the administrator to view and log all changes as 
well as actions in the system, including user logins, 
patient registrations, and series updates. 

Image 
Orientation 

Allows the administrator to view and modify how 
images are oriented in the system. 

Filter Kernels 
Allows the user to activate custom kernel options for 
both Axial and Helical scans. 

Setting user accounts 

Only a user with administrative access can update another user’s account, 
add a new user, delete a user, and lock or unlock a user’s access. 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the User Accounts tab. 

 
Figure 64: User Accounts tab 

 

 For the User ID field, enter the User ID name. 

 For the User Level field, enter one of the following user levels: 

Administrator 
Full access to the system and it’s configurations.   
Can create protocols, User ID’s, and passwords, 
as well as access all functions of the system. 
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Limited operator 

Modified access to the system.   Users with 
Limited access can modify protocols during 
scanning but cannot create and save protocols; 
has no access to system configuration. 

Restricted 
operator 

Users with Restricted access can scan with the 
system but are unable to make any changes to 
protocol parameters while scanning, they also 
have no access to system configuration. 

 For the Last Name field, enter the user’s last name. 

 For the Enter First Name field, enter the user’s first name. 

 For the Password field, enter the user’s password. 

Note  The password must contain 8 to 12 characters, and must 
include one number,  one symbol and one letter.  

 
 For the Verify Password field, re-enter the user’s password to confirm 

the password. 

 
Figure 65: User account fields filled in 

 Click the Save button. 
The user is added to the list.  
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The Save Aborted popup appears if your password does not meet the 
rule for passwords.  If this is the case, return to the step above, and 
fulfill the password rule.  

 

 

 

 

 

 

Figure 66: Save aborted popup message – Password requirements 
 

 Click the Close button to exit. 
 

Setting or updating a user’s information  

 Click Customize > System, from the main menu. 
The System Configuration dialog box appears. 

 Click the User Accounts tab. 

 Select a user from the list of users. 

  
Figure 67: List of users 
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 Modify the user’s information; for example, password, or user’s first and 
last name. 

Note  The password must be 8-12 characters and include at 
least a letter, number, and symbol.  

The user’s changes take effect after clicking the Update button.  It is 
recommended that you log off and log back on and check that the 
password is working. 

 Click the Update button to keep the change(s). 

The Update Aborted popup appears if your password does not meet the 
rule for passwords.  If this is the case, return to the step above, and 
fulfill the password rule.  

 
Figure 68: Update Aborted popup message – Password requirements 

 Click the Close button to exit. 
 

Unlocking a user account 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the User Accounts tab. 

 Select the user to unlock from the list of users in the panel. 
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Figure 69: List of users not selected 

 Click the Unlock button. 

The user’s changes take effect after clicking the Update button.  It is 
recommended that you log off and log back on and check that the 
password is working. 

Deleting a user 

Note  The administrator user cannot be deleted.  

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the User Accounts tab. 

 Select the user to delete from the list of users. 
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Figure 70: List of all available users 

 Click the Delete button. 
The Action Succeeded popup box appears. 

 Click the Ok button in the Action Succeeded popup. 

 Click the Close button to exit. 

Modifying the order of the users in the accounts list  

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the User Accounts tab. 

 Select the user order to modify from the list of users in the panel. 

 Click the Down arrow to move the user down the list. 
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Figure 71: Down arrow 

 Click the Up arrow to move the user up the list. 

 
Figure 72: Up arrow 
 

The Up arrow will not activate until you move down the list of users. 

 Click the Save button under the user list to keep the new user list order. 
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Figure 73: Save button for list order 

 Click the Save button next to the Update button to keep other changes. 

 Click the Close button to exit. 

Assigning general settings 

Perform the following to set how the hospital, workstation’s application, 
scanner, and remote support are configured. 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the General Settings tab. 
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Figure 74: General Settings tab 

 The following tabs are only available to the administrator: 

Hospital Setup Sets up hospital information specific to the site. 

Application 
Setup 

Sets up application information the user will 
experience. 

Scanner Setup Sets up scanner IP address information. 

Remote Support 
Setup 

Sets up IP address information to allow 
NeuroLogica remote support. 

The following sections provide detailed information related to the 
options available in the General Settings tabs. 

Hospital Setup sub tab 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the General Settings tab. 

 Click the Hospital Setup sub tab. 
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Figure 75: General Settings > Hospital Setup subtab 

 Enter the institution name in the Institution Name field. 

Note  The name appears on all  images.  

 Enter the department name in the Department Name field. 

 Enter the institution address in the Institution Address field. 

 Click the following options that are applicable: 
• When Auto Store is selected and you Finalize a scan, the system will 

automatically send the images to the Default PACS server defined on 
the DICOM Servers tab. (see System Configuration > DICOM Servers 
> Servers).  The status of your export will appear in the bottom right 
of the Patient Browser screen. 

• Click the Use Device AE in Server Setting option to apply the 
BodyTom 64 AE title tag to DICOM when the operator archives the 
image data to PACS. 
o If enabled when sending images to PACS, this option will include 

the BodyTom 64 AE setting as a DICOM tag. 

 Enter the system name (for example BodyTom 64) in the Station AE Title 
field. 

 Enter the name you want to call the archive option in the “Push To” 
Text box. 
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 Click the Save button to keep your changes. 
The Save Successful popup appears. 

 Click the Ok button in the Save Successful popup. 

 Click the Close button to exit. 

Application Setup subtab 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the General Settings tab. 

 Click the Application Setup sub tab. 

 
Figure 76: General Settings > Application Setup subtab 

 Click and/or enter information for the following options that apply: 

Auto Lock 

The Auto Lock feature can be used to 
automatically lock the workstation 
screen after a user defined Idle Time is 
reached. 

Automatically Show 
Store/Print Queue 

Allows the user to automatically display 
the Store/Print Queue status when 
images are set to archive to a network 
device.  

Show Dose Report 
Displays the Dose Report on the screen 
when the Finalize button is clicked. 
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A dose report will not be generated until 
the operator clicks the Finalize button 
on the Acquisition tab. 

Automatically Generate 
Dose SR 

Generates a Dose SR (Structured Report) 
along with the dose report when the 
Finalize button is clicked. 

Show Stored Query Results 
Displays the Stored Results at the 
bottom of Patient Registration. 

Prompt for Auto 
Reconstruction 

Allows the user to automatically start 
any additional reconstructions added to 
a scan series after the exam is 
completed.  

Allow Manual Patient 
Registration 

Allows the user to manually register a 
patient. 

Default Pediatric Patient 
Type 

If selected, the Protocol Manager will 
default to the pediatric protocols. 

Change Password Interval 
(Days) 

Sets the number of days before a 
password change is required. 

 Click the Save button to keep your changes. 

 Click the Close button to exit. 

Scanner Setup subtab 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the General Settings tab. 

 Click the Scanner Setup sub tab. 
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Figure 77: General Settings > Scanner Setup subtab 

 Click and/or enter information for the following options that apply: 

Scanner IP address Sets the scanner’s IP address in the field(s). 

Point to Point Wireless 

Sets up wireless information regarding the 
connection from the workstation to the 
scanner. 
For Scanner Network Adapter, enter the 
adaptor, for example, Wireless to Scanner. 
For Scanner Wireless Profile, enter the 
wireless identifier in the field. 

 Click the Save button to keep your changes. 

 Click the Close button to exit. 

Remote Support Setup subtab 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the General Settings tab. 

 Click the Remote Support Setup subtab. 
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Figure 78: General Settings > Remote Support Setup subtab 

 Click the Remote Support Network Connection dropdown to select one 
of the following network connections: 
• Wireless to Scanner 
• Wired to Network 

 Click the Use Static IP option to enter the Static IP Setup data for the 
following: 
• System IP Address 
• System Subnet 
• System Gateway 

 Enter the DHCP Setup to enter IPs for the following: 
• DNS Server (Preferred)  
• DNS Server (Alternate)  

 Click the Save button to keep your changes. 

 Click the Close button to exit. 
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Managing DICOM servers 

Digital Imaging Communication in Medicine is the definition of the 
acronym DICOM.  DICOM servers are used to export images from the 
scanner.   The System Configuration > DICOM Servers tab allows a user with 
administrative rights to access all the DICOM devices connected to the 
scanner.   

See DICOM standards on the NEMA.org website for a full description of 
settings and actions that are available. 

Note  You must have administrative privileges and be logged in 
as an administrator to access and modify DICOM servers.  

 Incorrect changes to the DICOM servers may make the 
system inoperative.  

DICOM servers are set up by the field-service engineer and the appropriate 
IT person at the hospital. 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the DICOM Servers tab. 

 
Figure 79: DICOM Servers tab 
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The following tabs appear: 

Servers 

Lists existing servers based on type:  
Store and Worklist   
Store: Identifies a storage server. 

Worklist: Identifies servers in a database you can 

query from. 

Also displays server details and options, with 
controls for saving, updating, deleting, and echoing 
servers. 

PACS List 
Displays a list of PACS by Server Name, Type, and In 

List – to send to by default.  

Options 
Displays controls for PACS Options and HIS/RIS 

Options. 

 
Figure 80: DICOM Servers tabs 

 Go to the following sections to assign specific actions to the DICOM 
server. 

Assigning a server as a store or worklist server 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the DICOM Servers tab. 
The Servers tab is active. 
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Figure 81: DICOM Servers > Servers tabs 

 Click one of the following options: 

Store 

A storage server, typically a PACS server that archives 
images and patient information.  The images and data 
can later be imported from the server to another 
system or the same system.  It is partly a backup and 
partly a waypoint for transferring data from the system 
the scans were acquired on to another system for 
viewing. 

Worklist 

A database of patient information that can be queried 
to generate a list of patients based on name, modality, 
procedure date, and other variables.  These patients 
are usually hosted on a server within the facility and 
the information can be imported from the server when 
trying to acquire all a patient’s information before a 
procedure is run.  This eliminates the need to manually 
enter patient information at the time of the procedure. 

 Under Details, enter the server’s name in the Server Name text box. 

 For the HIS/RIS and PACS Network Connection, click the dropdown to 
identify the following: 
• Wireless to Scanner  
• Wired to Network 

 Click the Point to Point Wireless check box if it applies. 
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 Click the Wireless Profile dropdown to select the appropriate profile. 

 In the Server AE Title text box, enter the server AE title. 

 In the Device AE Title text box, enter the BodyTom 64 AE title. 

 In the Server IP Address text boxes, enter the server IP address. 

 In the Port text box, enter the port identifier. 

 In the Connection Timeout text box, enter the number of seconds 
before the connection timeout is activated. 

 Click the Use Static IP option to identify the following: 
• System IP Address 
• System Subnet 
• System Gateway 

 To set the server as a default server, click the Default Server check box. 

 To set the server as the default surgical navigation server, click the 
Default Navigation check box. 

 To enable the storage commitment, click the Enable Storage Commit 
check box to send a message back to system that confirms the storage 
was successful; it is an extra confirmation from PACS that the images 
were received. 

 To gather responses, click the Listen for Responses check box. 
For every image that is sent, the system will wait for acknowledgement 
before sending the next image. 

 To gather 12-bit images, click the 12-bit Images check box. 

 Click the Save button, to keep your work. 

 
Figure 82: Action Succeeded popup message – Server saved 
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The new server should appear in the list box to the left. 

 Click the Ok button. 

 Click the Close button to exit. 

Modifying a server 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the DICOM Servers tab. 

 Click server type: Store or Worklist. 

 Select a server from the list. 

 Modify the parameters. 
See “Assigning a server as a store or worklist server” on page 133. 

 When all your changes are made, click the Update button. 
A message appears that explains the update was successful and includes 
the update(s). 

 
Figure 83: Action Succeeded popup message – Server updated 

 Click the Ok button. 

 Click the Close button to exit. 
 

Echoing a server  

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the DICOM Servers tab. 



BodyTom 64 User Manual Revision 04 

 

Chapter 5    System and User Configuration and Setup Page 137 of 412 

 Click a server type: Store or Worklist. 

 Select the server to echo from the list. 

 Click the Echo button. 
The status of the server appears. 

  
Figure 84: Echo Successful and Echo Failed popups  

 Click the Ok button. 
If the echo was unsuccessful, determine why and repeat step 5 until you 
are successful. 

 Click the Close button to exit. 
 

Deleting a server  

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the DICOM Servers tab. 

 Click a server type: Store or Worklist. 

 When the server you want to remove is available, click the server from 
this list. 

 Click the Delete button. 
The server is removed from the list; the Action Succeeded popup 
appears. 

 Click the Ok button. 

 Click the Close button to exit. 
 

Moving a server up and down the server list  

 Click Customize > System from the main menu. 
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The System Configuration dialog box appears. 

 Click the DICOM Servers tab. 

 Click a server type: Store or Worklist. 

 Select the server to move up or down the list. 

 Click the Up arrow to move the server up the list; click the Down arrow 
to move the server down the list. 

 
Figure 85: Up and Down arrows to move up and down server list 

 Click the Save button to save the server order. 
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Figure 86: Save button 

The Action Succeeded popup appears. 

 Click the Ok button. 

 Click the Close button to exit. 
 

Saving DICOM servers to a PACS list  

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the DICOM Servers tab. 

 Click the PACS List tab to view available servers. 
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Figure 87: DICOM Servers > PACS List tab 

 Double-click the light-gray checkmark under In List. 
Each checkmark adds the server to the PACS listing.  The checkmark 
turns green when active. 

 Click the Save button. 
The PACS List Saved popup appears. 

 
Figure 88: PACS List Saved popup message – PACS saved 

 Click the Ok button. 

 Click the Close button to exit. 
 

Selecting PACS options 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 
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 Click the DICOM Servers tab. 

 Click the Options tab. 

 
Figure 89: DICOM Servers > Options tab 

 Under PACS Options, click the Enable Storage Commit to verify that 
patient information and data archived to the PACS server was received. 
• If Enable Storage Commit is not selected, it is assumed and accepted 

that the data was received.   
• If Enable Storage Commit is selected, the workstation sends a 

request to the PACS server to verify that the data was received. 

 If the Enable Storage Commit check box is selected, perform the 
following: 
• Enter the appropriate title in the System Called AE Title text box. 
• Enter the port identifier in the Port text box. 
• Enter the number of seconds before a connection timeout in the 

Connection Timeout (secs) text box. 
• Enter 30 seconds or 60 seconds. 

 Under Purge Options, make selections based on the understanding that 
any studies archived to the PACS server are deleted from the 
workstation on a regular basis, depending on the selected interval; 
identify the following: 
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Purge Interval 

Select one of the following from the dropdown: 
Everyday, Weekly, or Monthly. When you select 
the first Purge Interval dropdown and select 
Weekly or Monthly, the inactive dropdown is 
active to let you select the day of the week or the 
first of the month. 

Time 

Changes the hour, minute, and second interval; 
use the buttons to increase those time elements. 

  
Figure 90: Time (increase and decrease time) arrows 

 
 Under the HIS/RIS Options, enter the maximum number of results sent 

back from a query worklist in the Query Max text box. 
There is no maximum limit. 

 Click the Send MPPS check box to apply a service that allows a modality 
to better coordinate with image storage servers by giving the server a 
list of objects to send before or while sending such objects. 

 Under Import Options, click the Use C-GET check box to pull information 
from a PACS server when importing from the server (as opposed to 
archiving to it). 
The administrator sets this to pull from PACS from anywhere, so the 
machine does not have to be set up as a reliable destination on the 
PACS machine.  PACS, typically needs to equate a computer’s IP address 
with an AE title; however, C-GET accepts that the calling IP is a 
legitimate device. 

The NeuroLogica BodyTom 64 scanner automatically uses C-Move when 
importing from PACS.  If the operator wants to use C-GET instead, the 
user can select C-Get. 

 Click the Save button. 
The PACS List Saved popup appears. 

 
Figure 91: PACS List Saved popup 
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 Click the Ok button. 

 Click the Close button to exit. 

Assigning DICOM settings 

DICOM settings include many kinds of settings.  The administrator can add 
or remove optional information to be displayed using actions described in 
this section. 

See DICOM standards on the NEMA.org website for a full list and 
description of DICOM tags. 

Note  You must have administrative privileges and be logged in 
as an administrator to access and modify DICOM settings.  

  Incorrect changes to the DICOM settings may make the 
system inoperative.  

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the DICOM Settings tab. 

 
Figure 92: DICOM Settings tabs (six) 
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 Click the HIS/RIS Query tab to select the types of HIS/RIS query results 
the user will see when performing a HIS/RIS query.  
See “Selecting PACS options” and go to step 6, for more information. 
 

Note  Even numbered DICOM  tags are public DICOM  tags as per 
the DICOM  standard.  Odd numbered DICOM  tags are 
vendor specif ic.  

 Green checkmarks are optional DICOM  tags and orange 
checkmarks are required per the DICOM  standard and 
cannot be modified .  

 
Figure 93: DICOM Settings > HIS/RIS Query 

 Click the Modality Performed Procedure Step (MPPS) tab to select the 
types of MPPS information the user will see. 
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Figure 94: DICOM Settings > MPPS 

 Click the Patient Module tab to select the types of Patient Module 
information the user will see.   

 
Figure 95: DICOM Settings > Patient Module 

 Click the Study Module tab to select the types of Study Module 
information the user will see.   
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Figure 96: DICOM Settings > Study Module 

 Click the Series Module tab to select the types of Series Module 
information the user will see.   

 
Figure 97: DICOM Settings > Series Module 

 Click the Image Module tab to select the types of Image Module 
information the user will see.  
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Figure 98: DICOM Settings > Image Module 

 Click the Save button to save your changes. 

 Click the Close button to exit. 

Assigning audio configuration 

Default audio files are installed on the workstation.  Audio files can be 
attached to protocols and sent to the scanner.  Each audio file has an 
indication if it has been sent to the scanner.  

Note  You must have administrative privileges and be logged in 
as an administrator to access and modify audio 
configurat ions.  

 Incorrect changes to the audio configurations may make 
the system inoperative.  

Finding and listening to audio files 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Audio Configuration tab. 
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Figure 99: Audio Configuration tab 

 Review the audio files that exist on the Workstation. 

 
Figure 100: Audio files list 

 To listen to an audio file, select the name from the workstation list and 
click the Play button. 

 To exit the Audio Configuration, click the Close button. 
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Recording and saving an audio file  

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Audio Configuration tab. 
The available audio files appear under Workstation. 

 
Figure 101: Audio files list 

 Enter the name of your new audio file in the File name text box. 

 Click the Record button. 

 Record your audio file. 

 Press the Stop button. 

 To review, highlight your new recording and press the Play button. 
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Figure 102: New audio file 

 When you like your recording, highlight the file, and press the Transmit 
button to copy the file into the audio folder for your scanner protocols.   

 Click the Close button to exit. 
 

Transmitting an audio file  

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Audio Configuration tab. 
The available audio files appear under Workstation. 

 Select the audio files under Workstation audio files to transfer to the 
scanner. 

 Click the Transmit button. 
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Figure 103: Audio files transmitted to save to the scanner 

 Click the Close button to exit. 
 

Deleting an audio file  

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Audio Configuration tab. 
The available audio files appear under Workstation. 

 Select the audio file you want to delete from the list.  

 Click the Delete button. 

 Click the Close button to exit. 

Assigning dose report 

The dose report is created at the end of the scan and can be customized to 
include DICOM specific tags. 

Note  You must have administrative privileges and be logged in 
as an administrator to access and modify dose report 
settings.   
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 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Dose Configuration tab. 

 Click the Dose Report tab. 

 
Figure 104: Dose Report tab 

 Select the DICOM tags you want to see in the dose report. 
A dose report is generated after the exam is finalized; the black area 
includes dose report information like the following. 

 
Figure 105: Generated dose report 

 Click the Save button. 

 Click the Close button to exit. 
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Applying dose configuration 

Note  You must have administrative privileges and be logged in 
as an administrator to access and modify dose 
configurat ions.  

 Incorrect changes to dose configuration settings may 
make the system inoperative.  

Note  You can check the Audit Trail  to review the audit log that 
details what dose l imit was removed, by whom, and the 
date and time it  took place.  

Dose configuration consists of both Dose Notifications and Dose Alerts. 

Dose Notification 
Notifies the user when the planned CTDIvol and/or 
DLP value of a single series will exceed the defined 
value.  

Dose Alert 

Notifies the user when the planned CTDIvol and/or 
DLP value from the combination of all planned 
series will exceed the defined value set in System 
Configuration.  Dose Alerts represent a value 
which would be well above an institution’s 
established CTDI/DLP range to the given 
examination and warrant a more stringent review 
and consideration before proceeding. 

 

Setting Dose Check 

See Appendix A on page 380 for information on protocols, CTDIvol, and DLP. 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Dose Configuration tab. 

 Click the Dose Check tab. 
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Figure 106: Dose Configuration > Dose Check 

 Click one of the following Dose Check Type options: 

Dose 
Notification 

Notifies the user when a pre-defined 
CTDIvol or DLP value will be exceeded on 
a series-by-series basis.  

Dose Alert 

Notifies the user when a pre-defined 
CTDIvol or DLP value will be exceeded 
from a combination of all planned series 
or scans.  

Note  The default Dose Alerts which are set at 1000mGy 
CTDI and 5000mGy*cm DLP are designed to prevent the 
patient from receiving any possible deterministic effects 
due to excess dose.  However, the system allows these 
values to be modified by the user.  Any modificat ions to the 
Dose Alerts should be done by qualif ied medical personnel.  

 Click one from the following Scan Type options. 

All Identifies all scan types. 

Axial Identifies only Axial scan types. 

Helical Identifies only Helical scan types. 

Dynamic Identifies only Dynamic scan types. 

 Define the Dose Limit by entering the following: 
• Enter the CTDIvol (mGy) value in the text box. 
• Enter the DLP (mGy.cm) value in the text box. 
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 Click the Save button. 
The Save Successful popup appears. 

 
Figure 107: Save Successful popup – Dose Check successfully saved 

 

 Click the Ok button. 

 Click the Close button to exit. 
 

Assigning Dose Configuration to a patient protocol 

Dose Configuration limits are used to prevent users from selecting kV or mA 
values that are not appropriate for the given patient types, such as 
pediatrics etc.  

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Dose Configuration tab. 

 Click the Dose Configuration subtab. 

   
Figure 108: Dose Configuration > Dose Configuration for adult and pediatric 

 

 Click one of the following: 

Adult 
Selecting Adult shows the pre-defined adult 
protocols, stored by anatomical area. 
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Pediatric 
Selecting Pediatric shows the pre-defined pediatric 
protocols, stored by anatomical area. 

Trauma  
The Trauma orb can be used to store protocols 
commonly used for emergency scans.  

 Click the colored orb that marks the anatomical region to apply the dose 
to. 

 
Figure 109: Anatomical orbs 

 Click a scan type from the following list: 

Axial Identifies only Axial scan types. 

Helical Identifies only Helical scan types. 

Dynamic Identifies only Dynamic scan types. 

 Enter a description for the Dose Configuration in the Description text 
box. 

 For Pediatrics enter the Minimum and Maximum Weight and Length 
information. 

 Under the Max Power settings, click the kV dropdown and select the 
maximum allowed kV. 

 Click the mA dropdown and select the maximum allowed mA.   
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Figure 110:  Pediatric Dose Configuration Parameters 

 Click the Save button to save your work. 
If the level overlaps an existing level, you are prompted to adjust. 

 
Figure 111: Invalid Parameter popup message – Dose setting kV already exists 

If the save is successful, the Save Successful popup appears. 

 
Figure 112: Save Successful popup message – Maximum dose saved 
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 Click the Ok button. 

 Under the Saved Doses list box, check that your dose configuration 
appears, if so, go to the next step. 

 Click the Close button to exit. 
 

Updating saved dose 

To modify a saved Dose Configuration.     
See “Setting Dose Check” page 153 and/or “Assigning Dose Configuration to 
a patient protocol” on page 155. 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Dose Configuration tab. 

 Select the desired Saved Dose from the Saved Doses list.  

                       
Figure 113:  Saved Doses List 

 Modifying values causes the Update button to become active. 

 Click the Update button. 
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Figure 114: Save Successful popup message – Maximum dose saved 

 Click the Ok button. 

 Click the Save button to save your work. 

Note  If  the level overlaps an existing level,  you are prompted 
to adjust.  

 Click the Close button to exit. 

Deleting a saved dose limit 

To remove a saved Dose Configuration.  

  Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Dose Configuration tab. 

 
Figure 115: Dose Configuration > Dose Check tab 

 Click an already-saved dose, under the Saved Doses list. 
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 Perform one of the following: 
• To delete a saved dose from the Saved Doses list and clear the 

restriction, select the dose, and click the Delete button. 
• To delete all the saved doses in the Saved Doses list and clear all 

restrictions saved, click the Delete All button, which returns all 
settings for that selection to the maximum scanner default. 

Note  If  there are no saved doses or l imits, the operator will  be 
able to scan using the maximum 140kV and 300mA 
avai lable on the scanner.   

 Click the Save button. 
The save success message appears and, because the CTDIvol (mGy) and 
DLP (mGy.cm) are empty, there is no longer a limit applied. 

The Save Successful popup appears. 

 
Figure 116: Save popup message – Maximum dose saved 

 Click the Ok button. 

 Click the Close button to exit. 

Applying Windowing Presets 

Windowing presets allow you to define window width and center presets 
for specific anatomical locations as well as specific reconstruction kernel 
presets.  An Administrative User can delete or update the default Window 
Presets as well as create new Windowing Presets.  

Note  You must have administrative privileges and be logged in 
as an administrator to access and modify the windowing 
presets.   
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Editing kernel presets 

Note  Kernel presets are pre-installed in the system; kernel 
presets can be set and modified.  

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Windowing Presets tab. 

 
Figure 117: Windowing Preset tab 

 Click the Kernel Presets tab. 
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Figure 118: Windowing Presets > Kernel Presets tab 

 Click the Scan Type dropdown to select one of the following scan types: 
• Axial 
• Helical 

 Click the Sharpness dropdown to select a sharpness from the list. 
Sharpness is the reconstruction algorithm, and the available Sharpness 
values are based on the scan type.  

 
Figure 119: Sharpness dropdown 
 

 Enter the Window Width in the Width text box. 
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Window Width describes the range of Hounsfield units, or shades of 
gray, displayed across the image.  The Window Width controls the 
contrast of the image. Low Hounsfield numbers below the range are 
displayed as black, while High Hounsfield numbers above the range are 
displayed as white.  

 Enter the Window Center in the Center text box. 
Window Center describes the Hounsfield number in the center of the 
Window Width.  Window Center controls the brightness or density of 
the image. 

 Click the Save button to save your work. 
The Action Succeeded popup appears. 

 
Figure 120: Action Succeeded popup message – Preset saved 

 Click the Ok button. 

 Click the Close button to exit. 
 

Setting Window Presets 

Window presets allow you to define Window Width and Window Center 
presets for specific anatomical locations, such as bone, brain, lung, and soft 
tissue. 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Windowing Presets tab. 
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 Click the Window Presets subtab.

 
Figure 121: Window Presets tab 

 Enter the name of the window preset in the Name text box. 

 
Figure 122: Window Presets > Name 

 Enter the width of the window preset in the Width text box. 
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Figure 123: Window Presets > Width 

 Enter the center for the window preset in the Center text box. 

 
Figure 124: Window Presets > Center 

 Click the Save button to save your work. 
The Action Succeeded popup appears. 



BodyTom 64 User Manual Revision 04 

 

Chapter 5    System and User Configuration and Setup Page 166 of 412 

 
Figure 125: Action Succeeded popup message – Preset saved 

 Click the Ok button. 

 Click the Close button to exit. 
 

Editing a window preset 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Windowing Presets tab. 

 Click the Window Presets subtab. 

 Click a preset that exists in the Window Presets listing. 

 
Figure 126: Listing update 
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 To edit the preset, make your changes in the Name, Width, and/or 
Center text boxes. 

 Click the Save button to save your changes. 
The Action Succeeded popup appears. 

 
Figure 127: Action Succeeded popup message – Preset saved 

 Click the Ok button. 

 Click the Close button to exit. 
 

Deleting a preset 

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Windowing Presets tab. 

 Select the preset. 

 Click the Delete button. 
The Action Succeeded popup appears. 

 
Figure 128: Action Succeeded popup message – Preset deleted 

 Click the Ok button. 
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 Click the Save button to exit. 

Setting up the Audit Trail Viewer 

The Audit Trail Viewer gives a user with administrative access the ability to 
view all activities performed by anyone logged into the system.  This 
includes changes to protocols, deletion of images, as well as 
acknowledgement of alerts etc. 

Note  You must have administrative privileges and be logged in 
as an administrator to access the Audit Trail  Viewer.   

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Audit Trail Viewer tab. 

 
Figure 129: Audit Trail Viewer tab 

 From the Audit Trail Viewer tab, use the calendar to select a date range 
to view.  
• To select a single date, position the mouse pointer in the top box 

and click the date on the calendar to find audits for that date.   
• To select a date range, click the desired start date on the calendar.  

This will automatically populate the top box of the From range.  Click 
the desired end date on the calendar, which automatically fills the 
bottom box of the From range.  
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Figure 130: Adding a date or a date span 

 Click the Audit Type dropdown to select the type of audit you are 
searching. 

 
Figure 131: Audit Trail Viewer > Audit Type dropdown 

 From the User ID dropdown, click the type of user to track. 
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Figure 132: Audit Trail Viewer > User ID dropdown 

 Click the View button to see the result of audits that met your criteria. 

 
Figure 133: Audit results 

 Perform one of the following: 
• Click the Clear button to remove the audit results. 
• Click the Export button to export the audit result that you selected 

to the audit backup file on the system. 
• Click the Export All button to export the audit results to the audit 

backup file on the system.  
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 Click the Close button to exit. 

Setting image orientation 

NeuroLogica describes patient orientation as if the viewer were looking 
towards the front of the gantry.   In other words, if the patient is lying face 
up with their head in the gantry, the image orientation displays the patient’s 
Right side on the Left side of the Viewer.    If the patient’s feet are going into 
the gantry, the image orientation displays the patient’s Left side on the Left 
side of the Viewer.  

Note  You must have administrative privileges and be logged in 
as an administrator to modify image orientation settings.  

 Changes to image orientation settings wil l  modify the 
displayed orientation markers on the images.   

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Image Orientation tab. 

 
Figure 134: Image Orientation tab 
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The top half of the Image Orientation screen shows the available 
patient orientations.  The black image orientation square represents the 
viewing area and shows four different orientation markers: A = anterior, 
L = left, P = posterior and R = right.  If you do not see letters in the image 
orientation box, select an image orientation from the list. 

 Select the appropriate orientation from the list. 
For example, select, Head First Supine.  In the figure below, the 
highlighted selection shows the current orientation in the Current Flip 
Orientation field, which is not changeable; however, the New Flip 
Orientation lets you change the orientation. 

 Click the New Flip Orientation dropdown to select one of the following 
new-flip orientations: 
• NONE 
• LEFT_AND_RIGHT 
• TOP_AND_BOTTOM 
• BOTH 

 
Figure 135: Image Orientation > New Flip Orientation dropdown 

 Click the Save button to save changes. 

 The Settings Saved popup appears. 
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Figure 136: Settings Saved popup message – Image orientation settings saved 

 Click the Ok button. 

 Click the Close button to exit. 
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Setting Filter Kernels 

Filter kernels allow you to activate custom kernel options for both Axial and 
Helical scans to control the sharpness and smoothness of the images.  

 Click Customize > System from the main menu. 
The System Configuration dialog box appears. 

 Click the Filter Kernels tab. 

 
Figure 137: Filter Kernels tab 

 Perform one of the following: 
• To add new Axial kernels, select the Axial radio button, then double-

click the Value cell next to the desired Axial kernel. 
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Figure 138: Selected Axial kernel 

To add new Helical kernels, select the Helical radio button, then double-
click the Value cell next to the desired Helical kernel.

 
Figure 139: Selected Helical kernel 

 Click the Save button. 
The Success popup appears. 

 Click the Ok button. 

 Click the Close button to exit. 
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User configuration 

User configuration allows users with either Administrator or Limited 
Operator access to change the password for their own account.   
 

Updating your user account 

 Click Customize > User from the main menu. 
The User Configuration dialog box appears. 

Note  You must have administrative or l imited operator 
privileges to access and modify user accounts.  

  Incorrect changes to user accounts may cause users to be 
unable to access the system. 

The Update Accounts tab is the default selection. 

 Modify the following fields associated with your user account by 
entering relevant information: 
• Last Name 
• First Name 
• Password 
• Verify Password 

 
Figure 140: Last Name, First Name, Password, and Verify Password fields 
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 Click the Update button. 

 The Update Succeeded popup appears. 

 
Figure 141: Update Succeeded popup message – Account updated 

 Click the Ok button. 

 Click the Close button to exit. 

Applying column settings to HIS/RIS Query 

Allows you to customize the columns of information that appear when 
viewing the Hospital Information System (HIS) and/or Radiology 
Information Systems (RIS) information that is queried. 

All users can access user configuration and make changes to the column 
settings; however limited and restricted operators cannot make their 
changes to the column headings the default.  Only users with administrative 
access can make column settings a default, using the Make Default option.   

 Click Customize > User from the main menu. 
The User Configuration dialog box appears. 

 Click the Column Settings tab. 

 There may be no entries that appear, initially. 

Note  When an option is selected (for example HIS/RIS Query  
or Patient Browser ),  a table is created that l ists the 
columns, along with a check  box to indicate whether it  
wil l  be displayed within the table .  Required columns 
cannot  be unchecked and are colored orange instead of 
the default green.  

 Click the HIS/RIS Query option. 
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Figure 142: Column Settings dialog box with HIS/RIS Query option 

 Double click the Checkmark under Displayed column for the row you 
want to display or remove if it is already selected.  

 
Figure 143: Column Settings with a selected query in HIS/RIS 

 Notice that the Up and Dwn buttons are active when a row is selected.  

 Click the Up or Dwn buttons to move the active selection up or down 
the list.   
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Figure 144: Column Settings with HIS/RIS Query option using Up and Dwn 
buttons 

 If you have administrative privileges, click the Make Default option to 
make the selected column display the default for all users. 

 
Figure 145: Make Default option 

 Click the Save button to keep changes. 

 Click the Close button to exit. 
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Applying column settings to Patient Browser 

Allows you to configure the columns of information seen in the Patient 
Browser. 

 Click Customize > User from the main menu. 
The User Configuration dialog box appears. 

 Click the Column Settings tab. 

 Click the Patient Browser option. 

 
Figure 146: Column Settings with Patient Browser option 

 Click one of the following options: 

Patient/Study 
Information that appears on the top portion of the 
Patient Browser that defines patient specific 
information. 

Series 
Information that appears on the lower portion of the 
Patient Browser that defines series specific information. 

 Double click the Checkmark under Displayed column for the row you 
want to display or remove if it is already selected.  

 Notice that the Up and Dwn buttons are active when a row is selected.  

 Click the Up or DWN buttons to move the active selection up or down 
the list.  
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Figure 147: Column Settings with Patient Browser Series option – using Up and 
Dwn buttons 

 If you have administrative privileges, click the Make Default option to 
make the selected column display the default for all users. 

 
Figure 148: Make Default option 

 Click the Save button to keep changes. 

 Click the Close button to exit. 
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Viewing Scan Dosage Report 

 Click Customize > User from the main menu. 
The User Configuration dialog box appears. 

 Click the Scan Dosage Report tab. 

 
Figure 149: Scan Dosage Report tab 

 To view Dosage Reports, click the date or date range on the calendar.  

Note  If  the date is left blank –  al l  doses for all  dates are 
retrieved.  

 Click the Protocol dropdown to select a protocol. 

Note  If  the protocol is left  blank –  a l l  doses for all  protocols 
are retrieved.  

 Click the mA Range dropdown to select the mA range. 
The mA Range default is 20-30; it can be changed after data is retrieved. 
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Figure 150: Date, Protocol, and mA Range filled 

 Click the View button to display a graph showing dosages performed by 
the scanner using the selected filters.  

 
Figure 151: Scan Dosage Report results 

Note  If  you adjust the mA range, the graph displays those 
ranges within the retrieved data.  
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 To clear the filters selected, click the Clear button. 

 

Selecting a room for the BodyTom 64  

Selecting a room ensures that the correct calibration is loaded or used when 
the scanner has been calibrated in more than one location. 

 Click Customize > Select Room. 

 A list of the rooms available appear in the cascading menu. 

 
Figure 152: Available rooms before moving the scanner 

 Click the room in which the scanner will be used. 

 Move scanner to the selected room. 
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Chapter 6     Protocol Manager  

Note  You must have administrative privileges  and be logged 
in as an administrator, to access the Protocol 
Manager.   

Protocol Manager allows a user with administrative privileges to create 
new protocols, modify existing protocols and delete protocols from the 
system.  Protocol Manager provides three patient options: Adult, 
Pediatric, or Trauma  patient. 

Table 28: Protocol Manager command buttons 

Button Action 

 
Allows you to create a new protocol. 

 

Allows you to create a new protocol from an 
existing protocol.  

 
Allows you to modify protocols. 

 
Deletes a saved protocol. 

 

Imports previously exported protocols into the 
workstation. 

 
Exports protocols to a media device. 

 
Closes the Protocol Manager dialog box. 

  

 

Moves a protocol up or down the ordered list. 

 

Saves the order of the protocol list. 
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Note:  Protocol parameters are customized to your 
requirements in conjunction with local and nationally 
recognized published guidelines.  These protocols 
must be  approved by your faci l ity physicist before  the 
system’s acceptance.  

 
WARNING Any modification to an existing protocol, or any new protocol created, 

should be reviewed, and approved by a radiologist and/or residing 
medical physicist.  Failing to do so could cause a patient to receive an 
excessive and/or unnecessary dose of ionizing radiation.   

  Resources for radiation protection of pediatric patients appear below 
and are for referring physicians with a focus on radiation exposure: 

• American Academy of Pediatrics (AAP), https://www.aap.org: 
Search for radiation risk to children from Computed 
Tomography 

• Federal Drug Administration (FDA), 
https://www.fda.gov/search   

Search for guidelines for pediatricians regarding medical 
radiation safety 

• American College of Radiology (ACR): 
      https://www.acr.org/Clinical-Resources/Clinical-Tools-and-

Reference/Appropriateness-Criteria 

• Image Gently® and CT scans 

https://www.imagegently.org/Procedures/Computed-
Tomography 

• Image Gently/FDA Digital Radiography Safety Checklist: 
https://www.imagegently.org/Portals/6/Procedures/Attachme
nt%20D.CR.DR%20%20checklist.pdf 

Creating a new protocol  

 Click Tools >Protocol Manager from the main menu. 
The Protocol Manager dialog appears. 

https://www.aap.org/
https://www.fda.gov/search
https://www.acr.org/Clinical-Resources/Clinical-Tools-and-Reference/Appropriateness-Criteria
https://www.acr.org/Clinical-Resources/Clinical-Tools-and-Reference/Appropriateness-Criteria
http://www.imagegently.org/Procedures/Computed-Tomography
https://www.imagegently.org/Procedures/Computed-Tomography
https://www.imagegently.org/Procedures/Computed-Tomography
http://www.imagegently.org/Procedures/Digital-Radiography/Quality-Improvement
https://www.imagegently.org/Portals/6/Procedures/Attachment%20D.CR.DR%20%20checklist.pdf
https://www.imagegently.org/Portals/6/Procedures/Attachment%20D.CR.DR%20%20checklist.pdf
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Figure 153: Protocol Manager for adult and pediatric 

 Click one of the following: 

Adult 
To create and/or scan with adult scan protocols, 
which are stored by anatomical location. 

Pediatric 
To create and/or scan with pediatric scan protocols, 
which are stored by anatomical location.  

Trauma  
 The Trauma orb can be used to store protocols 
commonly used for emergency scans. 

 

By selecting either an Adult or Pediatric patient, the 
corresponding list of saved protocols becomes 
available. 

 Click the colored orb corresponding to the appropriate body part. 

  
Figure 154: Adult and pediatric anatomical orbs, with Chest orb selected 

Existing protocols in the selected Orb will appear in the Protocol list 
box as seen below.  The New button will become active.  
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Figure 155: Adult and pediatric protocol lists 

 Click the New button to create a new protocol.   
The New Protocol dialog box appears. 

 
Figure 156: New Protocol dialog box 

  Enter Protocol Information in the text boxes: 

Protocol Description 

The name of the protocol as it will be 
displayed in protocol manager.  Reference 
Protocols begin with the letters NL and 
cannot be deleted from the system.   

Anatomical Reference 
References the anatomy that will be 
scanned.  

Default Study Description 
The DICOM image tag; if entered, this 
description will also appear in PACS as a 
Study Description DICOM tag (0008,1010). 
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 Under Patient Position, select one of the following scanning positions 
from the dropdown: 

HFS Head First-Supine 

HFP Head First-Prone 

HFDL Head First-Decubitus Left 

HFDR Head First-Decubitus Right 

FFS Feet First-Supine 

FFP Feet First-Prone 

FFDL Feet First-Decubitus Left 

FFDR Feet First-Decubitus Right 

You can also move the rotating positional handles by hovering the 
mouse pointer over the handle and clicking to select a position.   
• The arrows at the feet rotate the patient orientation from Head 

First to Feet First.   
• The arrow above the patient rotates the patient orientation from 

Supine to Prone to Decubitus.  

 
Figure 157: Patient position handles 

 Under Protocol’s Series, click the New button. 
The New Series dialog box appears. 
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Figure 158: New Series dialog box 

 For Scan Type, select one of the following: 
• Axial 
• Helical 
• Dynamic 
• Reference 
• Scout 

Note  For Helical  scanning,  the exposed area is extended by 
at least ½ rotation to 1 full  rotation at the start and 
end of the planned scan, based on the sharpness 
selected.  

 For Scout Type, select one of the following: 
• AP 
• PA 
• Lateral 
Scout Type is not available for Axial, Helical, Dynamic, and Reference 
scan modes. 

 For kV (scan voltage), select one of the following: 
• 80  To set the scan kV to 80. 
• 100  To set the scan kV to 100. 
• 120  To set the scan kV to 120. 
• 140  To set the scan kV to 140. 
kV is not selectable when using the Dynamic and Reference scan 
modes. 
See “Identifying load factors” on page 228. 
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 For mA (scan current), select the desired value from the dropdown.  
The available mA range is 30 to 300 with an increment of 5mA.  
mA is not selectable when using the Reference scan mode. 

 For Slice Thickness/Spacing, select the desired value from the 
dropdown.   
Slice Thickness/Spacing is not available for Scout and Reference scan 
modes. 

 For Sharpness, select the image reconstruction kernel from the 
following list of kernels: 
• Low Noise QA – Not for Clinical Use 
• Soft Tissue – Available for Axial Scan Type only 
• Soft Tissue – Head – Available for Helical Scan Type only 
• Soft Tissue – Abdomen – Available for Helical Scan Type only 
• Pos. Fossa/Vessel – Available for Axial Scan Type only 
• Sharp – Available for Axial Scan Type only 
• Bone (No AEC) – Available for Axial Scan Type only 
• Bone – Head (No AEC) – Available for Helical Scan Type only 
• Bone – Abdomen (No AEC) – Available for Helical Scan Type only 
• Sharp Lung (No AEC) – Available for Axial Scan Type only 
• High-Res QA (No AEC) – Not for Clinical Use 
Sharpness is not selectable when using the Reference and Scout scan 
modes. 

Note  The Low Noise QA  and High-Res QA (No AEC)  options 
should not be used for clin ical scanning.  

 For Resolution, which also refers to scan time, select one of the 
following options:  
• 1 Second(s) 
• 2 Second(s) 
Resolution in only available for Axial Scan Types.  

 For Pitch, which describes how fast the scanner is moving during one 
rotation of the x-ray tube, select one of the following options:  
• 0.4 where the scanner will move 15.36mm per second.  
• 0.8 where the scanner will move 30.72mm per second.  
Pitch is only available for Helical Scan Types. 

 For Body Part Examined, select the appropriate Body Part from the 
drop-down menu.  

 For Window Width, enter the range of CT numbers that are 
distributed over the viewable gray scale of the display device or film. 
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 For Window Center, enter the CT number in the center of the 
viewable gray scale. 

 For Description, enter the desired study description. 

 For Start Position, enter the start scan position. 

 For End Position, enter the end scan position. 

 Coverage is a calculated value that automatically fills based on the 
Start and End position values.  

 For Contrast, enter the type of contrast given for example.  

 For Contrast Volume, enter the amount of the contrast given. 
Contrast is not available for Reference and Scout scan modes. 

 For Delay, enter the delay time that will occur after clicking the 
START button on the scanner control panel. 

 Number of images is a calculated value based on the Slice 
Thickness/Spacing and length of the scan.  

 Scan Time is a calculated value based on the protocol parameters 
selected.  Scan time is affected by Resolution, Pitch and Scan Length.  

 For CTDIvol (mGy), if applicable, the calculated number appears here, 
depending on other selections. 
CT Dose Index Volume (CTDIvol) represents the dose for a specific 
scan protocol, which considers gaps and overlaps between the 
radiation-dose profiles from consecutive rotations of the x-ray 
source.  The CTDIvol is calculated differently for both the Axial and the 
Helical scan modes: 
• For Axial scan mode: CTDIvol = [(N x T)/I] x CTDIw 
• For Helical scan mode: CTDIvol = 1/pitch x CTDIw 

  Dose Length Product (DLP (mGy.com)), is the measure of ionizing 
radiation exposure during the entire acquisition of images.  
Therefore, DLP (mGy.cm) = CTDIvol (mGy) x irradiated length (cm). 

 Select the following options, if applicable.  See Scanning with special 
features for more details. 

Step & Shoot 

Allows you to manually start the Axial scan 
acquisition from the workstation when 
scanning a patient who is unable to remain 
still. 
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Bolus Tracking 

A CT angiography technique that allows you 
to monitor the administration of contrast 
to initiate the scan at peak contrast 
enhancement.  

Enable AEC 

Allows you to automatically adapt the tube 
current according to the patient’s body 
habitus to achieve the specified image 
quality at the lowest possible dose. 

 
 To add a secondary reconstruction for the protocol, click the New 
button in the Recons section.   

 
The New Reconstruction popup appears. 

 
Figure 159: New Reconstruction popup 

 Complete the following in the New Reconstruction popup: 
• Enter a description in the Description text box to identify the new 

reconstruction. 
• Click the Slice Thickness/Spacing to select a slice thickness and 

spacing. 
• Click the Sharpness dropdown to select a sharpness from the list. 
• Enter the window width in the Window Width text box. 
• Enter the window center in the Window Center text box. 
• If needed, enter the FOV width in the FOV Width text box. 
• If needed, enter the FOV top left x location in the FOV Top Left X 

text box. 
• If needed, enter the FOV top left y location in the FOV Top Left Y 

text box. 
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 Perform one of the following: 
• Click the Save button to save the reconstruction protocol to the 

list. 
o The dialog box closes, and your changes are added to the 

Recons area. 
• Click the Reset button to reset the fields to their original data. 
• Click the Cancel button to remove your changes and return to the 

previous dialog box. 

 Click the Save button on the New Series dialog box. 

 
Figure 160: Edit Series dialog box 

 Repeat the steps 6 thru 33 to add additional scans to the protocol.  

 When all required series have been created click the Save button on 
the New Protocol dialog box.  

 
Figure 161:  Save New Protocol 
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 Click the Close button to exit.  
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 162:  Close Button 

Using Build From to create a new protocol  

The Build From button is used in Protocol Manager when you want to 
create a new protocol from an existing protocol.   

 Click Tools >Protocol Manager from the main menu. 
The Protocol Manager dialog appears. 

 Click one of the following: 

Adult 
To create and/or scan with adult scan protocols, 
which are stored by anatomical location. 

Pediatric 
To create and/or scan with pediatric scan protocols, 
which are stored by anatomical location.  

Trauma  
The Trauma orb can be used to store protocols 
commonly used for emergency scans.   

 

By selecting either an Adult or Pediatric patient, the 
corresponding list of saved protocols becomes 
available. 

Note  Protocol parameters are customized to your 
requirements in conjunction with local and nationally 
recognized published guidelines.  These protocols 
must be  approved by your faci l ity physicist before  the 
system’s acceptance.  
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WARNING Any modification to an existing protocol, or any new protocol created, 

should be reviewed, and approved by a radiologist and/or residing 
medical physicist.  Failing to do so could cause a patient to receive an 
excessive and/or unnecessary dose of ionizing radiation.   

  Resources for radiation protection of pediatric patients appear below 
and are for referring physicians with a focus on radiation exposure: 

• American Academy of Pediatrics (AAP), https://www.aap.org: 
Search for radiation risk to children from Computed 
Tomography 

• Federal Drug Administration (FDA), 
https://www.fda.gov/search   

Search for guidelines for pediatricians regarding medical 
radiation safety 

• American College of Radiology (ACR): 
      https://www.acr.org/Clinical-Resources/Clinical-Tools-and-

Reference/Appropriateness-Criteria 

• Image Gently® and CT scans 

https://www.imagegently.org/Procedures/Computed-
Tomography 

• Image Gently/FDA Digital Radiography Safety Checklist: 
https://www.imagegently.org/Portals/6/Procedures/Attachme
nt%20D.CR.DR%20%20checklist.pdf 

 Click the colored orb corresponding to the appropriate body part.  

  
 Figure 163: Anatomical orbs 

 Click the protocol you will Build From in the Protocol list. The Build 
From button will become active. 

https://www.aap.org/
https://www.fda.gov/search
https://www.acr.org/Clinical-Resources/Clinical-Tools-and-Reference/Appropriateness-Criteria
https://www.acr.org/Clinical-Resources/Clinical-Tools-and-Reference/Appropriateness-Criteria
http://www.imagegently.org/Procedures/Computed-Tomography
https://www.imagegently.org/Procedures/Computed-Tomography
https://www.imagegently.org/Procedures/Computed-Tomography
http://www.imagegently.org/Procedures/Digital-Radiography/Quality-Improvement
https://www.imagegently.org/Portals/6/Procedures/Attachment%20D.CR.DR%20%20checklist.pdf
https://www.imagegently.org/Portals/6/Procedures/Attachment%20D.CR.DR%20%20checklist.pdf
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Figure 164:  Build from protocol selected 

 Click the Build From button. 

 
Figure 165: Build From button 

6. The New Protocol dialog box appears. 
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Figure 166: New Protocol dialog box 

 
 Modify the protocol parameters to meet your needs.  Click the 

Update button on the Edit Series dialog box to save your changes.  

See “Creating a new protocol” on page 186 to learn how the fields 
and options perform to make informed choices on what to change. 

Note  Be sure to assign the Build From  protocol  a new 
Protocol Description  before you make your additional 
changes.  

 When all required series have been modified click the Save button on 
the New Protocol dialog box.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 167:  Build from save 

 Click the Close button to exit.  
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Figure 168:  Build from close 

Editing an Existing Protocol  

The Edit button is used in Protocol Manager when you want to modify 
the parameters of an existing protocol.    

 Click Tools >Protocol Manager from the main menu. 
The Protocol Manager dialog appears. 

 Click one of the following: 

Adult 
To edit adult scan protocols, which are stored by 
anatomical location. 

Pediatric 
To edit pediatric scan protocols, which are stored by 
anatomical location.  

Trauma  To edit protocols store in the Trauma orb. 

 Click the colored orb corresponding to the appropriate body part.  
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Figure 169:  Edit protocol orbs 

 Click the protocol you wish to Edit in the Protocol list. The Edit button 
will become active. 

Figure 170:  Edit protocol selected 

 Click the Edit button. 

 
Figure 171:  Edit button 
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 The Edit Protocol dialog box appears. 

 
Figure 172: Edit Protocol dialog box 

 Modify the protocol parameters to meet your needs.  Click the 
Update button on the Edit Series dialog box to save your changes.  

 
Figure 173:  Edit series update button 

See “Creating a new protocol” on page 186 to learn how the fields 
and options perform to make informed choices on what to change. 

Note  Be sure to assign the Build From  protocol  a new 
Protocol Description  before you make your additional 
changes.  
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 When all required series have been modified click the Update button 
on the Edit Protocol dialog box.  

 
Figure 174:  Edit protocol update button 

 Click the Close button to exit.  

 
Figure 175:  Edit protocol close button 

 

Copying and pasting protocols  

To copy and paste protocols from one body part orb to another, including 
the Trauma orb. 

 Click Tools >Protocol Manager from the main menu. 
The Protocol Manager dialog appears. 
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 Click one of the following: 

Adult 
To copy and paste adult scan protocols, which are stored 
by anatomical location. 

Pediatric 
To copy and paste pediatric scan protocols, which are 
stored by anatomical location.  

Trauma  To copy and paste protocols stored in the Trauma orb.  

 
Figure 176: Protocol Manager for Adult and Pediatric 

 Click the colored orb corresponding to the appropriate body part. 

  
Figure 177: Anatomical orbs, in this case the chest orb 

 Review the protocol you would like to copy.  

 Highlight the protocol, right-click to see the floating menu, and click 
Copy. 
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Figure 178: Copy right-click floating menu 

 Go to body part orb you want to paste the protocol to, which can 
include the Trauma orb. 

 Right-click to see the floating menu and click Paste. 

 
Figure 179: Paste right click floating menu 
 

 Click Close button to exit. 
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Deleting a protocol 

 Click Tools >Protocol Manager from the main menu. 
The Protocol Manager dialog box appears. 

 Click one of the following: 

Adult 
To delete adult scan protocols, which are stored by 
anatomical location. 

Pediatric 
To delete pediatric scan protocols, which are stored 
by anatomical location.  

Trauma  
To delete protocols that are stored in the Trauma 
orb.    

 Click the colored orb corresponding to the appropriate body part. 
Select the protocol from list to be deleted. 

 
Figure 180: Protocol Manager with a protocol selected 

 Click the Delete button. 
The Delete Confirmation popup appears. 

  
Figure 181: Delete Confirmation popup message – Yes or No to delete 
selection 
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 Perform one of the following in the Delete Confirmation popup: 
• Click the Yes button to delete the selected protocol. 
• Click the No button to return to the Protocol Manager dialog box. 
The Delete Confirmation dialog box disappears, and the Protocol 
Manager dialog box appears. 

 Click the Close button to exit. 

Adding breathing instructions to your protocol  

Default audio files are installed on the workstation.  Audio files can be 
attached to protocols and sent to the scanner.  Each audio file has an 
indicator whether it was sent to the scanner. 

 Click Tools >Protocol Manager from the main menu. 
The Protocol Manager dialog box appears. 

 Click one of the following: 

Adult 
To add breathing instructions to adult scan protocols, which 
are stored by anatomical location. 

Pediatric 
To add breathing instructions to pediatric scan protocols, 
which are stored by anatomical location.  

Trauma  
To add breathing instructions to protocols stored in the 
Trauma orb.   

 Click the colored orb corresponding to the appropriate body part. 

 Click the protocol you would like to add Breathing Instructions to. 

 Click the Edit button. 
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Figure 182: Edit button 

The Edit Protocol dialog box appears. 

 
Figure 183: Edit Protocol dialog box 

 Select the Protocol’s Series you want to add breathing instructions 
to. 
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The Edit button is enabled. 

 
Figure 184: Add breathing edit button 

 Click the Edit button. 
The Edit Series dialog box appears. 

 
Figure 185: Edit Series dialog box 

 Click the Use Breathe Indicator Audio option and click the Choose 
button. 
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Figure 186: Use Breathe Indicator Audio option 

The Breathe Indicator Audio Files popup appears. 

 
Figure 187: Breathe Indicator Audio Files popup 

 Select an audio file to use for the Breathe instruction. 
The Breathe and Hold buttons are activated. 
 
 Click the Breathe button to place the file with Breathe files. 

 Select an audio file to use for the Hold instruction. 

 Click the Hold button to place the file with Hold files. 

 Click the Apply button to keep the files you selected to use with 
protocols. 

 Click the Close button to exit. 
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Importing protocols from a storage device 

 Click Tools >Protocol Manager from the main menu.  
The Protocol Manager dialog box appears. 
 

 Click the Import button 

  
Figure 188:  Import button 

 The Select File popup appears.  

 
Figure 189: Select File popup 

 
 Double click the Drive Letter that contains the protocols you want to 

import. 
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Figure 190:  Select file 

 Click the file in the Select File popup. 

  
Figure 191: Import button active in Select File when file(s) selected 

 
  Click the Import button. 
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Figure 192: Protocols Imported popup message – Protocols imported 

 

 The Protocols Imported popup appears. 

 Click the OK button. 

 Check that the required files have been imported.  

 Click the Close button to exit.  

 
 

Exporting protocols to a storage device 

 Click Tools >Protocol Manager from the main menu. 
The Protocol Manager dialog box appears. 

 Click the Export button. 

 
Figure 193:  Export button 
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 The Select Directory dialog box appears. 

  
Figure 194: Select Directory popup 

 If more than one Media Device is available, select the device to use. 

 Click the Select button. 

 The Protocols Exported popup appears. 

 
Figure 195: Protocols Exported popup message – Protocols exported 

 Click the Ok button. 

 Check that the exported files are exported. 

 Click the Close button to exit. 
 

Changing the order of protocols in the list 

 Click Tools >Protocol Manager from the main menu. 
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The Protocol Manager dialog box appears. 

 Click one of the following: 

Adult 
To change the order of adult scan protocols, which are 
stored by anatomical location. 

Pediatric 
To change the order of pediatric scan protocols, which 
are stored by anatomical location.  

Trauma  
To change the order of protocols stored in the Trauma 
orb.   

 Click the colored orb corresponding to the appropriate body part. 

 Click the protocol to move up or down the list. 

 Click the Up arrow to move the protocol up the list; click the Down 
arrow to move the protocol down the list. 

 
Figure 196: Changing protocol order with Up and Down (arrow) buttons 

 When you are finished ordering your protocols, click the Save button 
to save the new ordered list. 
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Figure 197: Protocol Save button 

 Click the Close button to exit. 
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Chapter 7     Daily Calibration and Quality 
Assurance  

In this chapter, you will learn how to perform a daily air calibration and 
use the Quality Assurance (QA) tool that verifies the system is working as 
specified.  

Keep in mind that before using the BodyTom 64 system, you must 
conduct a Quality Assurance (QA) test to verify the system is working as 
specified.  Performing a daily (air) calibration 

Note  NeuroLogica recommends that an air calibration is 
performed every 6-8 hours.   If  the air freshness falls 
below 50%, or the scanner is moved to an area with a 
dramatic change in humidity or temperature, perform 
another air calibration to ensure optimum image 
quality during patient scanning.  

 If  room-temperature f luctuations have occurred, you 
may need to perform more than one air  calibration.  In 
addition, scanners can drift  out of alignment; make 
sure you perform a QA Test  with the test phantom 
before  scanning a patient.  

 

Note It  is recommended that the scanner is on for at least 
60-90 minutes prior to performing the air cal ibration.  

 It  is recommended practice that the scanner is plugged 
in and turned on even when it  is not in use.  

 Make sure that nothing is in the bore before starting the daily air 
calibration. 

 Click Tools > Perform Daily Cal from the main menu. 
The Perform Daily Cal popup appears. 
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Figure 198: Perform Daily Cal popup 

Colors identify previous air calibrations outcomes: 

Green 
Indicates the calibration was 
successful 

Yellow 
Indicates the calibration is soon 
to expire 

Orange 
Indicates the calibration has 
expired 

Red Indicates the calibration failed. 

 Select one of the following options: 
• Click Select All to perform all calibration steps.  
• Click Clear All and individually select the calibration step(s) to 

perform.  

 Click the Start button. 
The Perform Daily Cal popup appears, and the timer counts down. 
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Figure 199: Perform Daily Cal popup with count down 

A warmup period begins, and the countdown begins; when 
completed the daily calibration will perform the calibration(s) you 
selected. 

Note  To stop the calibration, c l ick the Cancel  button to 
end the daily (air) calibration(s).   

When the calibrations are completed the Daily Calibration Summary 
will display showing the status of the steps performed.  

 
Figure 200: Perform Daily Cal summary popup 
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The following are the status indicators: 

Green 
Identifies the calibration completed 
successfully. 

Yellow Identifies the calibration is in progress. 

Red Identifies the air calibration failed. 

 Click the Close button to exit the Perform Daily Cal popup. 
The Daily Cal icon will change to green when it reaches a 100% air 
freshness. 

 
Figure 201: Air freshness icon changes as the air quality drops from green to 
yellow to red 

The QA phantom overview 

The QA phantom is a device that measures parameters that characterize 
image quality; these parameters are as follows: 
• Uniformity 
• Noise 
• High-contrast resolution 
• Slice width  
• Low-contrast resolution  
• Sensitometry (contrast scale) 

 
Figure 202: QA phantom 

The QA phantom is a 20cm diameter disk consisting of a substrate made 
of poly methyl methacrylate (PMMA) containing specific inserts.  The 
uniform area of the disk is used to measure uniformity and noise.  Four 
other parameters are measured by the inserts in the substrate. 

The QA phantom goes onto the phantom holder when performing a QA.  
See “Storing the QA phantom” on page 349. 
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Figure 203: Phantom holder 

The Axial resolution wire, also called the Modulation Transfer Function 
(MTF) wire, is intended for measuring resolution in the Axial plane.  
Resolution is defined as the ability to distinguish small objects.  It is 
expressed in line pairs per millimeter. 

The slice width wires are the two inclined wires.  They are intended to 
determine scanner resolution along the Z axis, that is, in the direction 
that is perpendicular to the Axial plane.  Resolution along the Z axis is 
expressed in terms of slice width in millimeters.  Although one wire is 
sufficient to measure the Z axis resolution if its position is accurately 
known, a second wire is included to confirm the alignment.  If the 
alignment was incorrect, the results of the slice width test would not be 
accurate. 

The low-contrast insert is a compound insert.  It is made of two half 
cylinders of different materials with a known contrast difference 
between them.  The low-contrast insert is intended to measure the 
contrast resolution of the scanner.  The contrast resolution is the ability 
to measure slight differences in x-ray attenuation. 

The sensitometry inserts are an air bore and cylinder made of different 
materials.  They are intended to measure the contrast scaling of the 
scanner. 

The QA scan protocols appear in the following table. 

Table 29: Scan protocols used by the QA 

Scan voltage 120 kV 

Scan current 200 mA 

mAs  400 mAs 
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Scan time 2 second 

Kernel Pos. Fossa/Vessel 

Slice thickness 9.6mm 

Starting Quality Assurance 

To ensure the system is at its optimum, factory-specification level, the 
workstation provides QA tools to verify the system’s state and to 
perform image-quality verification.  To maintain consistent image quality 
over the system's lifetime, you should establish and maintain a regular 
Quality Assurance (QA) program.  QA results are stored in the Patient 
Browser.  Contact your local service representative to delete QA results. 

The QA protocol is shipped with the system and appears when you click 
Quality Assurance from the main menu.  You cannot customize or modify 
the QA protocol. 

Note  The QA test  should be conducted per hospital 
requirements .  

Before you begin this section, be sure to run a fresh Daily Calibration on 
the system.  See “Performing a daily (air) calibration” on page 216. 

Also, before you start the QA protocol, make sure the QA phantom is 
available and ready to install on the phantom holder.  The phantom serial 
number label should be facing the front of the scanner and be positioned 
at the top – as shown in the figure below.  The red insert should be on 
the bottom right when facing the scanner.  The position of the phantom 
will greatly affect the QA results. 

     
Figure 204: Phantom on the phantom holder 
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 Move the QA stand to the front of the gantry, so the prongs point 
into the bore as shown. 

  
Figure 205: Place QA phantom 

 Ensure the QA stand is centered in the bore using the sagittal laser as 
shown.  If needed, adjust the prongs side to side.  

 
Figure 206: Proper QA stand positioning 
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 Place the QA phantom on the prongs as shown. 

 
Figure 207:  QA phantom positioning 

 On the pendant, press the Laser button and align the internal laser to 
the etched line in the center of the phantom. 

 
Figure 208: Laser button 

See the laser precautions in “Laser safety” on page 56. 

 Click Tools > Quality Assurance from the workstation main menu. 

 The following Quality Assurance popup appears. 

1. The serial number label should be 
facing the front of the gantry and at 
the top. 

2. The red insert should be on the 
bottom right. 

3. The phantom should be in the middle 
of the carbon fiber post/prongs. 

4. The two wires in the phantom should 
be vertically straight. 
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Figure 209: Quality Assurance popup 

 Click the Prepare button to begin the QA procedure. 
 

 The System Ready to Scan popup appears.  

 
Figure 210: System Ready to Scan popup message – System is ready to 
begin 

 Go to the scanner and press the START button. 
The system will scan the phantom and display the QA Results image.   

 
Figure 211: QA results of QA image 
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Note  Items in green are passed results.  Items in red are 
failed results.  Often positional issues cause the failure; 
reposition your phantom and perform another scan.  If  you 
try multiple t imes and failures persist ,  cal l  your service 
representative or Technical Support .  

 Click the Close button on the QA Results popup when finished 
reviewing.  The image of the phantom appears. 

 
Figure 212: Phantom image 

 Click the Finalize button on the workstation to exit the protocol. 
 

 The QA appears in the Patient Browser; however, it is locked. 

 
Figure 213: Locked QA results shown in Patient Browser 

Note  See your service representative to remove locked QA 
results.  

Ensuring good image quality  

To produce consistent image quality over the system's lifetime, you 
should establish and maintain a regular Quality Assurance (QA) program.  
QA results are stored in the Patient Browser.  Contact your local service 
representative to delete QA results. 

 Compare the results to previous or optimum values and repeat these 
tests on a regular basis to detect changes in image quality values 
before any problem becomes visible. 
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Note  If  you notice degradation in image quality or a change 
in QA values, schedule a site vis it  and let  your service 
representative or imaging physicist run more detailed 
tests.  

 Early intervention could prevent a major breakdown.  

QA begins with baseline performance data that is acquired during system 
installation or after the repair or replacement of an x-ray generator-
assembly, collimator, detector, Data Acquisition System (DAS) or main 
power circuitry. 

 Compare subsequent QA results against the baseline. 
Baseline images can be saved for a visual comparison with QA checks, 
but measurement values provide a more objective way to monitor 
quality. 

 
Figure 214: Results of QA image after the QA test 

Identifying filtration accuracy 

Values of attenuation equivalent, half-value layer, and quality-equivalent 
filtration are expressed as a thickness of aluminum at the minimum of 
99.9% purity.  Attenuation of items in the x-ray beam should not be 
higher than 2mm of equivalent Aluminum (Al). 

 
CAUTION Do not put anything in the x-ray beam that exceeds 2mm of 

equivalent AL as it may produce adverse effects to the image. 
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Using Axial plane to determine image resolution 

The method to determine resolution in the Axial plane is to measure the 
modulation-transfer function of the scanner.  A planar section of the MTF 
wire provides a point, called an impulse.  The impulse is blurred by the 
imaging system, and the measurement of the blur quantifies the 
resolution.  The blur is quantified by the MTF amplitude, which provides 
a measure of gain for a given object size in line pairs per centimeter 
(lp/cm). 

The MTF is measured in two directions, called radial and tangential 
directions.  The radial direction is along the line that joins the wire to the 
scanner isocenter.  The tangential direction is perpendicular to the radial 
direction.  The MTF along each direction produces a curve.  The points at 
which each curve’s amplitude is 50% and 10% of its amplitude at zero 
lp/cm are reported. 

The expected results are given below. 

Table 30: Modulation Transfer Function (MTF) direction 

Direction  50% 10% 

Radial (lp/cm) 4.7 7.2 

Tangential (lp/cm) 4.7 7.2 

Table 31: QA results 

 Low limit  High l imit  

Slice width (mm) 9 11 

Noise (HU) 2.5 3.5 

Low-contrast resolution (mm) 4 6 

Uniformity (HU) 0 5 

CT of air (HU) -1030 -950 

CT of Teflon (HU) 924 1004 

CT of acrylic (HU) 75 155 

Measuring slice width 

The method for determining the slice width for the Axial mode QA is to 
take an image of the inclined wire.  The scanned section of the inclined 
wire is a line segment.  The scanner blurs a scanned object in the Axial 
plane as well as in the direction perpendicular to it.  The image of the 
inclined wire includes both the Axial plane blurring (MTF) of the scanner 
as well as the blurring in the z-direction.  The slice width is determined by 
removing the component of in-plane blurring, by measuring the length of 
the wire segment and by using the known angle of wire inclination.  The 
range is noted in QA results; see Table 31 on page 227. 
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Measuring noise 

Noise is measured as the standard deviation of pixel values in a 1cm 
Region of Interest (ROI) at the center of the phantom.  The ROI selection 
is automatic.  The CTDI100 center dose in a standard CTDI head phantom 
is 145 mGy for this scanning technique.  The BodyTom 64 noise 
measurement is performed on a 10mm slice. 

Measuring low contrast 

Low-contrast resolution is measured as the difference between the 
mean CT values in each half of the low-contrast insert.  An ROI is 
automatically selected around the low-contrast phantom and is 
automatically segmented into halves.  Within each ROI, the mean pixel 
value is computed.  The two mean values are subtracted. 

The expected difference in the mean values is given in the electronic 
report.  The low contrast should be: 5.0 ±1.0 HU. 

Finding uniformity 

A ROI is automatically selected in each of five locations in the phantom.  
One ROI is at the center.  Four outer ROIs are 60 to 70mm from the 
center of the phantom and spaced 90 degrees apart.  A mean value is 
calculated in each ROI.  The maximum difference between the means is 
calculated.  The maximum allowable difference between the means is 3 
HU. 

Identifying CT contrast scale  

Contrast scale represents the attenuation scaling of the scanner.  The 
mean CT numbers of each of the sensitometry objects is calculated and 
reported. 

Identifying load factors 

Table 32: Load factors 

Protocol 
description 

kV mA 
Time 

(seconds)  

Axial 80-140 30-300 1 

Helical 80-140 30-300 1 per rotation 

 

 
CAUTION When conducting multiple or repeat scans, ensure that the 

total exposure does not exceed 1Gy CTDI. 
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Note  The highest x-ray tube current is 300mA and the 
highest x-ray tube voltage select ion at this current is 
140kV.  

 The nominal x-ray output power is 42kW when 
operating at an x-ray tube voltage of 140kV and x-ray 
current of 300mA for 4 seconds.  

 The x-ray tube voltage/current tolerance is ±10%.  

The BodyTom 64 dose information (21 CFR 1020.33 c) 

Dose is measured using standard CTDI head and body phantoms.  Surface 
and center CTDIs were both measured.  Weighted CTDI is computed 
using surface and center CTDIs: 

 

Measured values are normalized to scan current, for example, CTDI 
values are in mGy/100 mAs.  For any given scan protocol CTDIw can be 
estimated using following equation and data from Table 33 and Table 34 
on page 230: 

 
CTDIw can also be computed using data from Table 35 and Table 36 on 
page 230, and the following equation: 

 

Where W is the kV relative dose ratio with respect to 120 kV.   𝒎 is the 

x-ray tube current in mA and 𝑺 is the scanning time in seconds.  If scan kV 
matches measured scan voltage, then W is equal to 1.0.  For Helical 
scans, 𝐶𝑇𝐷𝐼𝑣𝑜𝑙 is calculated as follows: 

 

For Axial scans, 𝐶𝑇𝐷𝐼𝑣𝑜𝑙 is calculated as follows: 
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Body CTDIw  phantom 

CTDIw using CTDI body phantom is listed in the following table.  Data was 
measured using the 64 rows collimation with the phantom placed on the 
phantom holder.  Dose measurements were taken using raw data 
acquisition in Service mode. 

Note  Performing scans in different Acquisition  modes can 
cause slight variations in measured dose.  

Table 33: Body CTDIw (mGy/100mAs) 

 140 kV 120 kV 100 kV 80 kV 

CTDI100 Center (C) 8.23 5.51 3.25 1.53 

CTDI100 Surface (S) 16.29 11.58 7.48 4.10 

CTDIw 13.77 9.56 6.02 3.25 

Head CTDIw  phantom 

Weighted average Computed Tomography Dose Index (CTDIw) using the 
CTDI head phantom is listed in the following table.  Data was measured 
using the 16 rows collimation.  Dose measurements were taken using raw 
data acquisition in Service mode using phantom holder. 

Table 34: Head CTDIw (mGy/100mAs) 

 140 kV 120 kV 100 kV 80 kV 

CTDI100 Center (C) 36.83 25.55 15.76 8.03 

CTDI100 Surface (S) 41.26 28.81 18.19 9.90 

CTDIw 39.68 27.50 17.38 9.28 

Normalized CTDI tables are listed below.  CTDI is normalized with respect 
to a typical 120kV scan protocol: 

Table 35: Normalized CTDI of body phantom 

 140 kV 120 kV 100 kV 80 kV 

CTDI100 Center (C) 1.494 1.000 0.589 0.277 

CTDI100 Surface (S) 1.406 1.000 0.645 0.354 

CTDIw 1.440 1.000 0.630 0.340 

Table 36: Normalized head CTDI 

 140 kV 120 kV 100 kV 80 kV 

CTDI100 Center (C) 1.442 1.000 0.617 0.314 

CTDI100 Surface (S) 1.432 1.000 0.631 0.344 

CTDIw 1.443 1.000 0.632 0.337 
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The BodyTom 64 dose in air  

Dose measurements were taken using raw data acquisition in Service 
mode. 
Table 37: CTDI air (mGy/100mAs) 

 140 kV 120 kV 100 kV 80 kV 

64 rows 35.4 25.8 17.3 10.2 

16 rows 54.2 38.6 25.7 15 

Dose is measured using a typical head protocol and a typical abdomen 
protocol.  Dose in air was also measured for repeatability over 10 scans.  
Average value and standard deviation are noted below: 

Table 38: Mean and standard deviation of CTDI air at 120kV 

 16 rows 64 rows 

Mean mGy 38.6 25.7 

Standard deviation mGy 0.0232 0.00396 

Additional QA measurements 

The QA phantom is typically used to monitor the scanner on site; 
however, the ACR or AAPM phantoms can be used for measuring the 
imaging performance of the scanner. 

Note  Actual results on installed units can vary 20% due to 
machine and test tolerances.  

ACR testing procedure 

Most sites use the ACR phantom for evaluating the QA parameters of the 
scanner. Furthermore, each scanner is evaluated using the ACR phantom 
prior to shipping. Due to the special tube filtration some of the limits for 
CT values may be different from those set by the ACR committee.  Table 
39 lists the NL limits for the CT number and linearity of each insert in the 
ACR phantom.  It also lists the limits set by ACR.  The difference in CT 
number is mainly due to the difference of the x-ray beam quality due to 
the tube filtration and the ACR committee acknowledge this in published 
papers2.  

 

 

2 The ACR committee will often change their limits, as such, the limits listed in Table 39 may have been 
changed. 
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Table 39: The CT number and linearity of the different inserts in the ACR 
phantoms 

Insert Material NL Limits ACR Limits 

Air -1005 to -970 -1005 to -970 

Polyethylene -110 to -85 -110 to -85 

Water -7 to 7 -7 to 7 

Acrylic 110 to 135 110 to 130 

Bone 1010 to 1110 850 to 970 

The scan protocols are typically selected by the site physicist or the CT 
manager. However, ACR recommends the use of standard head and 
abdomen protocols.  NeuroLogica uses the protocols listed in Table 40.  

Table 40: The NeuroLogica head and abdomen ACR scan protocols 

Protocol Head/Abdomen Abdomen 

kVp 120 120 

mA 200 250 

Time per rotation (seconds) 1 1 

Dose (Weighted) 45 to 50 mGy 22 to 25 mGy 

Scan FOV 59.5 cm 59.5 cm 

Display FOV (minimum) 25.0 cm 25.0 cm 

Reconstruction sharpness Soft tissue Soft Abdomen 

Scan type Axial Helical 

Z-axis collimation 9.6 mm 38.7 mm 

Table increment (mm) or Table 
speed (mm/rot) 

9.6 mm 30.7 mm/rot 

Slice thickness 4.8 mm 4.8 mm 

Scan time (seconds) 1 1 

Slice separation 4.8 mm 4.8 x 4.8 mm 

Number of images per scan 2 N/A 

Measuring high-contrast resolution 

The high-contrast resolution phantom is a wire placed at the center of a 
uniform disk.  The wire provides an impulse function in the Axial plane 
when it is placed parallel to the scanner-gantry axis-of-rotation.  The 
high-contrast resolution is measured from the Modulation Transfer 
Function (MTF).  Typical MTF curves are shown in the following figures.  
Variations of 10% may occur in measurements due to phantom 
placement error and measurement inaccuracies.   
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Figure 215: MTF 

Table 41 lists the 50%, 20% and 10% cutoffs of the most commonly used 
kernels on the scanner.  The cutoffs were measured using the MTF curve 
for each kernel like the one displayed in Figure 215. 

Table 41: The cutoffs of some of the common reconstruction kernels 

Scan Type Kernel MTF50% MTF20% MTF10% 

Axial Soft Tissue 3.4038 4.9538 5.7187 

Axial Pos. Fossa/Vessel 3.9930 5.7816 6.7455 

Axial Sharp 6.6819 8.2549 9.2587 

Axial Bone 7.7757 9.6942 10.9681 

Axial Sharp Lung 6.1620 8.9318 11.8802 

Axial High-Res QA 7.9286 10.5069 12.4050 

Helical Bone Head 5.2370 6.5734 7.1577 

Helical Soft Tissue-Abd 6.2422 7.2252 7.7846 

Helical Soft Tissue-Head 3.0327 4.4322 5.1328 

Helical Bone-Abdomen 5.5166 6.8081 7.4292 

Noise, uniformity, and mean CT number of water  

One of two phantoms may be used in these tests.  These are Catphan® 
412 or a cylindrical 20cm diameter water cylinder. 

The variation in standard deviation may be ±10% due to variations 
between systems. 

Noise is measured as the standard deviation at isocenter.  The value is 
around 3.5 ±4 HU when the imaging protocol is 120 kV, 400 mAs and 
standard Post-Fossa kernel.  This protocol gives a CTDI100 center dose of 
92 mGy. 

Noise is measured as the standard deviation of pixel values in a large ROI 
at the center of the phantom.  Using a slice thickness of 4.8mm the noise 
values are listed below.   
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Table 42: Uniformity and Mean CT Number using Water Phantom 

Description Noise (HU) 

Body 
(cp300 mm Water phantom) 

9.2285HU 

Head (cp200mm Water Phantom) 3.42HU 

Uniformity and mean CT number  

The mean CT number of air is -1000 HU and that of water is 0 HU.  The 
tolerance of the mean CT number will be ±3 HU.  For mean CT numbers 
measured at different points of the water phantom, the maximum 
difference in the means will be less than 4 HU3.  An ROI is automatically 
selected in each of five locations in the phantom.  One ROI is at center.  
Four outer ROIs are 60 to 70mm from phantom center and spaced 90 
degrees apart.  A mean value is calculated in each ROI.  The maximum 
difference between means is calculated.   

Maximum difference between peripheral ROIs and the center ROI mean 
CT values in an image is less or equal to 4 HU.  The maximum error in CT 
number of water is ±3 HU. 

Table 43: Uniformity and Mean CT Numbers using Water Phantom 

Description Uniformity (HU) Mean CT Number (HU) 

Body 
(cp300 mm Water phantom) 

1.91 0.32 

Head (cp200mm Water 
Phantom) 

1.45 -1.0 

Low-contrast resolution 

The phantom used for low-contrast resolution measurement is CTP 515 
section of the Catphan 600.  

The low-contrast resolution is 4mm rod at 0.3% contrast when the 
center CTDIw dose is 71 mGy.  The imaging protocol is 120 kV, 300 mAs 
with 1 rotation, 4.8mm slice thickness, and using the soft tissue filter. 

 

 

3 For States that required the sites to perform water phantom testing, please contact customer service for 
assistance. 
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Figure 216: Catphan 515 using 120kV, 300mA, 1 rotation, and 5mm slice 

Tube accuracy 

Table 44: Tube accuracy 

kV Tolerance 

140 ± 5% 

120 ± 5% 

100 ± 5% 

80 ± 5% 

 

Half-value layer 

Table 45: Half-value layer 

Scan voltage (kV) 100 120 140 

Half  value 6mm 7mm 8mm 

Allowable variations 

The following are allowable variations: 

Dose 
A ±5% variation in dose may occur due to 
variations between systems and measurement 
differences.  The maximum variation is ±10%. 

High Contrast 
Resolution 

The variation in values on the MTF curve may be 
±10%.  These will occur mainly due to phantom 
placement errors, measurement inaccuracies and 
system variations. 

Noise 
The variation in standard deviation may be ±10% 
due to variations between systems. 
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Uniformity 
The maximum difference between ROI means in 
an image is 4 HU.  The maximum error in the CT 
number of water is ±3 HU. 

Dose: Maximum variation is ±10%. 

Variation in values on the MTF curve may be ±10%.  These occur mainly 
due to phantom placement errors, measurement inaccuracies and 
system variations. 

Scatter radiation 

Reference the following radiation scatter plots identifying proper 
distances to protect from radiation exposure.  The scatter plots provide 
scattered radiation dose in air-kerma, per current-time product in both 
standard and SI units for nominal technique of 120kV (µRad/100mAs and 
µGy/100mAs respectively).  This information is given so the facility 
physicist and/or Radiation Safety Officer (RSO) can use these charts to 
calculate exposure with the following formula: 

 

In addition, per IEC 60601-2-44, 3rd Edition, “Particular requirements for 
the basic safety and essential performance of x-ray equipment for 
computed tomography”, scatter plots are provided as shown in Figure 
219 on page 238 and Figure 220 on page 239 for the maximum 
techniques settings of 140kV and 300mA (standard and SI units 
respectively). 

This information is specifically intended for the facility Physicist and/or an 
RSO to perform a safety and shielding analysis such as described in NCRP 
147, “Structural Shielding Design for Medical X-Ray Imaging Facilities.” 

 
WARNING Exposure to secondary radiation can be harmful, and scanner 

usage should only be done under the direct supervision of the 
facility’s qualified Radiation Safety Officer (RSO) in 
compliance with site, local, mode, provincial, and national 
regulations.  Only this RSO can perform the calculations 
necessary to determine what additional safety precautions 
are necessary, such as shielding, personal protections, and so 
on. 

Note  The BodyTom 64 scanners are compatible with IRR1999 
and EU Directive 96/29/EURATOM. 
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Typical application environment and radiation safety 

The BodyTom 64 is an advanced radiation protection mobile CT.  There is 
an effective x-ray shielding that is equivalent of 0.75mm of lead within 
the gantry.  The scanner can be used in a mobile environment and/or 
within an enclosed environment. 
 
The scatter plot below shows the dose map during a normal scan: 

 
Figure 217: Scatter plot (120kV, 100mA in µRad) 

Note In compliance with IEC 60601-2-44:2009, section 
203.11, the above f igure shows the scatter 
radiation measured at the edge of the gantry in the 
tomographic plane is  ≈20% of the scatter radiation 
measure at the same distance along the axis of 
rotation in the horizontal plane.  

 The black box (located at 0 on the X axis and -2 on 
the Y axis) represents an approximate (24 x 24 x 
79in. or 60 x 60 x 200cm) zone of occupancy.  The 
system in Scan  mode stands at 78.5in.,  which meets 
the 79in. (200cm) requirement.  
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Figure 218: Scatter plot (120kV, 100mA in µGy) 

 

 
Figure 219: Scatter plot (140kV, 300mA in µRad) 
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Figure 220: Scatter plot (140kV, 300mA in µGy) 

Note The anatomical body phantom was placed on a scan 
table inside the gantry to consider scatter through 
patient.  Measurements were made using the following 
scan protocol:  140kV, 200 mA, and 5 sec.  The 
following f igures show measurement points in vertical 
X—Y and perpendicular  Y—Z planes, followed by 
corresponding tables detail ing resulting data.  

  
Figure 221: Scatter measurements (X—Y plane) 
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Table 46: Scatter measurements (X—Y plane) (μRad/100 mAs) 

 A’  B’  C’  D’  E’  F’  

A 12.2 15.3 17.7 18.3 15.7 12.7 

B 11.9 14.8 16.4 16.7 16.0 12.6 

C 11.4 13.6 11.1 12.9 15.2 12.5 

D 9.40 10.4 8.87 9.57 12.4 10.4 

E 6.09 6.26 4.09 4.26 7.66 7.66 

 
Figure 222: Scatter measurements (Y—Z plane) 

Table 47: Scatter measurements (Y—Z plane) (μRad/100 mAs) 

 A’  B’  C’  D’  E’  F’  

A 300 676 852 591 870 437 

B 218 539 2320 2940 1090 465 

C 137 328 931 1120 461 233 

D 27.8 1080 2790 2240 765 282 

E 8.96 844 441 85.3 538 345 
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Dose profile/Geometric Efficiency 

A graphical presentation of the dose profile along a line – Z 
perpendicular to the tomographic plane and centered at the isocenter, 
determined in free air for one Axial scan, in the center location of the 
head-dosimetry phantom, and the center location of the body-dosimetry 
phantom – is given in the accompanying documents for each selectable 
value of N × T.  When more than three different values of N × T are 
available, the information is provided for at least the minimum, 
maximum and one mid-range value.  The dose profile is presented on the 
same graph and to the same scale as the corresponding sensitivity 
profile required by 203.111. 

Dose profile was measured for 64 rows by taking a stationary scan with 
the radio-chromic film, centered on top of the detector array.  The scan 
protocol was as follows: 120 kV, 200 mA, 5 sec.  After the scan was taken, 
the radio-chromic film was scanned, and the profile extracted.  The 
following figure shows the dose profile and detector array. 

Geometric efficiency was calculated as the ratio of the detector array to 
FWHM of dose profile using the following formula: 

𝐺𝑒𝑜𝑚𝐸𝑓𝑓𝑖𝑐𝑖𝑒𝑛𝑐𝑦 =
𝑁𝑟𝑜𝑤𝑠 · 𝑤𝑧 · 𝑀𝑓

𝐹𝑊𝐻𝑀
 

where 𝑁𝑟𝑜𝑤𝑠 is the number of detector rows; 𝑤𝑧is the width of the 
detector in the z-direction; 𝑀𝑓 is the magnification factor; 𝐹𝑊𝐻𝑀 is the 

full width at half maximum of the profile.  Table 48 on page 242 lists the 
measured geometric efficiencies for the two existing collimations of the 
BodyTom 64. 

 
Figure 223: Dose profile for 16 rows 
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Figure 224: Dose profile for 64 rows 

Table 48: The geometric efficiency of the two different collimations of the 
BodyTom 64  

Collimation Geometric Efficiency 

64 rows collimation 83 ± 5% 

16 rows collimation 60 ± 5% 
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Chapter 8     Patient Registration  

Patient Registration is the first step in the patient scan process. 
You can register a patient in the following ways: 
• Manually register a patient from the Patient Registration tab. 
• Perform a query to acquire already-entered patient data from the 

Hospital Information System (HIS) or Radiology Information System 
(RIS). 

It is assumed that the workstation is connected to the site’s HIS/RIS 
system.  If you are not connected, you can always manually register a 
patient. 

 
Figure 225: Activated Patient Registration tab 

Navigating the Patient Registration screen 

Make sure the Patient Registration tab is selected. 

Notice the buttons at the bottom of the Patient Registration dialog box.  
Many of these buttons are active only if you are already connected to the 
site’s HIS/RIS or if you clicked the Query button, and the list of patients 
populated in the Query Results list.  When a patient is selected, the 
buttons are active. 

Table 49: Patient Registration buttons 

Patient 
Registration 
button 

Action 

 

Searches the HIS/RIS server for scheduled patients.  
The population of patient information could take 
several minutes to appear, depending on the 
number of patient entries the query retrieves after 
clicking the Query button. 

 

Cancels the current query.  Entries retrieved prior to 
cancellation appear in the Query Results list and 
Stored Results if they are moved there. 

 

Registers the selected patient and takes you to the 
Acquisition tab to select a protocol to be used for 
scanning.   



BodyTom 64 User Manual Revision 04 

 

Chapter 8    Patient Registration  Page 244 of 412  

Patient 
Registration 
button 

Action 

 
Shows selected patient details. 

 

Searches queried patient entries for specific 
information. 

 

Selects patient(s) from query results and moves 
them into the Stored Results list. 

 
Removes patient(s) from the Stored Results list. 

 

Manually enters a new patient and, when 
completed, takes you to the Acquisition tab to 
select a protocol to be used for scanning.   

Registering the patient 

The following procedures show you how to register or enter patient 
information into the system before scanning a patient.  Patients are 
registered manually or queried from the Hospital Information 
System/Radiology Information System (HIS/RIS).  The system can be 
configured to add or create specific patient information when the patient 
is registered. 

Querying patient information 

 If necessary, click the Patient Registration tab on the main screen. 

 
Figure 226: Patient Registration tab 
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 Click the Query button at the bottom of the screen. 
The Query Information dialog box appears. 

 
Figure 227: Query Information dialog box 

 Click the HIS/RIS Server dropdown and select the worksite to pull 
data from. 
The default worksite appears at the top.  If there is no list, see your 
site administrator to set it up. 

 Double-click any of the named Query Fields you would like to use to 
query for patients by entering the value in the Value column. 
A popup associated with the Query Field you selected appears.  For 
example, if you double-click the Scheduled Start Date row, the Edit 
Value popup appears.  Enter the desired start date.   Another 
example would be to click the Patient Name value row.  Again, the 
Edit Value popup appears; however, this time Patient Name text 
boxes are provided so you can type the patient’s name to query.   You 
can click any of the Value rows to fill in data to help query for the 
patient you are looking for.  You can enter as much or as little 
information as needed.  If no information is available, leave the value 
blank. 
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Figure 228: Edit Value popup for name 

 When you are finished filling in query selections, perform one of the 
following: 
• Click the Update button to query based on the newly entered 

data to help narrow down your search. 
• Click the Close button to remove any changes and return to the 

previous Query Information popup. 

 A list of patients matching your selected criteria variables populates 
in the Query Results list on the Patient Registration tab. 

 
Figure 229: Patient Registration Query Results table 

 Select a patient and click the Register button to register the patient 
for the exam. 
The system enables and opens the Acquisition tab.  To perform the 
acquisition steps, see “Performing a scan” on page 255. 

Storing patients in the Stored Results list  

This list is helpful when multiple patients need to be scanned and a 
connection to a worksite like HIS/RIS is unavailable at the exam location. 
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 If necessary, go to the Patient Registration tab to query the 
patients(s). 

 Perform steps 2 through 5 in “Querying patient information” on page 
244. 

 Click the Query button. 
Let the criteria you selected populate into the Query Results list area. 

 Select one or more patient entries from the Query Results list. 
Select patients in the following ways: 
• To select one patient, click anywhere in the patient’s row. 
• To select more than one patient at a time, press and hold the Ctrl 

key and click patient entries until finished and release the Ctrl 
key. 

• To select all the patients, press and hold the Shift key, click the 
first patient in the list, then click the last patient to highlight all 
patients between the first patient selected and the last. 

 Click the Store button. 
The patient information you selected appear in the Stored Results list 
at the bottom of Patient Registration. 

 
Figure 230: Patient Registration Stored Results table 

 Click the patient you want to select from the Stored Results table. 

 Click the Register button to register the patient for the exam.  
The system enables and opens the Acquisition tab.  To perform the 
acquisition steps, see “Performing a scan” on page 255. 

Manually registering a patient 

You manually register a patient for examination when the HIS/RIS server 
is unavailable, the patient cannot be found, and/or was never entered 
into the system. 
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 If necessary, go to the Patient Registration tab. 

 
Figure 231: Patient Registration tab 

 Click the Manual button at the bottom of Patient Registration. 
The Exam Information dialog box appears with the Patient tab open. 

 
Figure 232: Exam Information dialog box 

 For Patient Name, double-click the Patient Name value. 
The Edit Value dialog box appears with patient name fields. 

 Enter patient name information in the fields provided and click one of 
the following buttons: 
• Click the Update button to save your entries and close the Edit 

Value dialog box. 
• Click the Close button to close the Edit Value dialog box without 

saving your work. 

Notice that the value appears with the last name first, separated by ^, 
the first name next, separated by ^, the middle name (if you supplied 
that information), and any other information you entered. 

Note  The Patient ID  is automatically generated by the 
system; you can replace this automated identif ier with 
your patient’s hospital ID number .  
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Figure 233: Patient ID field 

 For the Patient Date of Birth, perform the following: 
• Double-click the Patient Date of Birth field. 
• Enter the patient’s birth date in the Patient Date of Birth field. 

Be sure to move the cursor to the far left to ensure two digits are 
included for the month and the day; four digits are required for 
the year. 

• Perform one of the following: 
o Click the Update button to save your work and close the Edit 

Value dialog box. 
o Click the Close button to close the Edit Value dialog box 

without saving your work. 

 For the Patient’s Sex, perform the following: 
• Double-click the Patient’s Sex field. 
• Enter the patient sex in the field by entering the appropriate 

letter: 
o F for Female 
o M for Male 
o O for Other 

• Perform one of the following: 
o Click the Update button to save your work and close the Edit 

Value dialog box. 
o Click the Close button to close the Edit Value dialog box 

without saving your work. 

 Perform one of the following: 
• Click the Register button to register your patient data. 
• Click the Cancel button to exit without entering your data. 

When you click the Register button, the system enables and opens 
the Acquisition tab.   
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Figure 234: Patient data filled in 

After your patient is registered, you can view the Patient Exam 
Details to ensure your data is correct. 
If it is not correct, go to the next step to make the necessary changes. 

 Click the Expand link. 
The Exam Information popup appears. 

 
Figure 235: Expand link in context and close up 

 Make your changes in the Exam Information popup. 

 
Figure 236: Exam Information popup 

 Click the Update button to save changes. 

Viewing patient information 

This procedure lets you view, but not change, the patient information. 

 If necessary, click the Patient Registration tab on the main screen. 
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Figure 237: Patient Registration tab 

 Select a patient from the Query Results list or the Stored Results list. 

 Click the View button. 

 Review the patient’s information. 
This popup presents static information that you cannot change. 

 Click the Close button to exit the View Entry Information popup. 

Deleting patients from the Stored Result list  

Patient information can be manually deleted from the Stored Results list, 
you cannot delete patients from the Query Results list. 

 If necessary, go to the Patient Registration tab. 

 
Figure 238: Patient Registration tab 

 Select one or more patients from the Stored Results list to delete. 
Select patients in the following ways: 
• To select one patient, click anywhere in the patient’s row. 
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• To select more than one patient at a time, press and hold the Ctrl 
key and click patient entries until finished and release the Ctrl 
key. 

• To select all the patients, press and hold the Shift key, click the 
first patient in the list, then click the last patient to highlight all 
patients between the first patient selected and the last. 

 Click the Delete button. 
The patients you selected are removed from Stored Results list. 
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Chapter 9     Patient Scanning  

After you register the patient, the Acquisition tab automatically opens.  
The Acquisition tab lets you check that the selected patient information 
is accurate before you perform the scan.  The Acquisition tab is also 
where you select protocols for the scan before you scan the patient.  A 
protocol determines the parameters used to acquire patient images.  

 
Figure 239: Active Acquisition tab 

After the protocol is selected, you can scan the patient.    See 
“Performing a scan” on page 255. 

The following table provides information on the buttons on the 
Acquisition tab and what they are used for.  Later you will learn how to 
set protocols for the scan. 

 
CAUTION When conducting multiple or repeat scans, make sure the total 

exposure does not exceed maximum limit of 1Gy. 

Table 50: Acquisition buttons 

Acquisit ion 
button 

Action 

 

Allows you to modify the protocol selected or 
choose a new protocol.  

 

Authorizes the scanner to move to the next step if 
applicable. 

 

Begins any post-reconstructions that were defined 
during the protocol setup. 

 
Allows you to repeat a portion or all the scan.  

 
Allows you to pause the scan acquisition.  

 

Allows you to pause the entire multi-step protocol 
acquisition. 

 
Cancels the current scan within a protocol. 

 
Cancels the entire exam. 
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Acquisit ion 
button 

Action 

 
Completes the examination. 

The following shows what appears in Acquisition: 

  
Figure 240: What appears on Acquisition 

Identifying Scan Types 

Scan types identify how images are acquired during a scan.  The following 
Scan types are available.  

Axial 

The Axial scan type lets you scan in the Transverse plane.  Data is 
acquired as the x-ray tube rotates around the patient.   

Helical 

The Helical scan type acquires data continuously as the x-ray tube rotates 
around the patient and the scanner translates over the patient in the Z 
axis. 

Dynamic 

The Dynamic scan type acquires data at multiple time points over the 
same anatomic location while the scanner remains stationary; x-ray 
exposure can be continuous or intermittent. 
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Reference 

The Reference scan type acquires a single 10mm slice to review 
anatomical position or place the Region of Interest (ROI) for Bolus 
Tracking scans.  Reference scanning can only be used in conjunction with 
Helical and Dynamic scanning during a CT Angiography (CTA) or 
Perfusion protocol. 

Scout 

The Scout scan type acquires data continuously as the x-ray tube remains 
stationary at a designated angle and the scanner translates over the 
patient in the Z axis.  The resulting 2D projection is used during scan 
planning. 

Performing a scan 
 

You cannot complete this procedure without a registered patient.   

Note  If  the scan needs to be stopped , perform the 
following:  

 For an immediate or  hard stop ,  press the E-STOP  
button.  This stops x-ray, centipede movement, and 
gantry rotat ion immediately.  

 For a controlled stop, press the Cancel Scan  button.  

Note  Be sure the scanner is calibrated for the room you wil l  
scan in.  See “Selecting a room for the BodyTom 64 ” 
on page 184 and "Performing a daily (air)  calibration” 
on page 216. 

 From the workstation, go to the Patient Registration tab to assign the 
patient to the scan in one of the following ways: 
• Query an already existing patient from the HIS/RIS. 
• Manually register the patient. 

See “Chapter 8    Patient Registration” on page 243. 
The Acquisition tab will be activated when the patient is registered. 

 From the Acquisition tab, click the Protocol button to open the Exam 
Planner dialog box. 

 Move scanner and align patient as needed. 
See “Positioning the scanner before a scan” on page 93. 
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 On the pendant, press the Laser button to turn on the laser and use it 
to align the patient to the scanner. 
See “Positioning the patient using the laser lights” on page 94. 

 On the workstation screen, click the appropriate option: 

Adult 
To scan with adult scan protocols, which are stored by 
anatomical location. 

Pediatric 
To scan with pediatric scan protocols, which are stored 
by anatomical location.  

Trauma  To scan with protocols stored in the Trauma orb.    

Note  Protocol parameters are customized to meet your 
requirements in conjunction with local and nationally 
recognized published guidelines.  These prot ocols 
must be approved by your faci l ity physicist before the 
system’s acceptance.  

   
Figure 241: Exam Planner for Adult and Pediatric 

 Click the colored orb corresponding to the appropriate body part you 
will scan. 

  
Figure 242: Anatomical orbs, with the Chest orb selected 

 Click the appropriate protocol from the list. 
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 Click the Edit button to review the selected protocol. 

 
Figure 243: Protocol selected and Edit button active 

The Edit Protocol dialog box appears. 

 
Figure 244: Edit Protocol dialog box 

The Protocol Information tab displayed on the left and the Protocol’s 
Series boxes displayed on the right show the series that are already 
created.   The Patient Position appears identical whether it is for an 
adult, pediatric, or trauma patient. 
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Note  You can modify a protocol ;  however, changes you 
make from Acquisition  wil l  not be saved permanently.   
Permanent changes to protocols can only be made by 
in Protocol  Manager .   

          Assuming you have the proper user privileges, y ou   
can modify protocol parameters such as, kV, mA, and 
coverage at the time of the scan, but the modificat ions 
will  not be saved for future use.  

 To edit an existing protocol, perform the following: 
• In the Edit Protocol dialog box, go to the Protocol’s Series list and 

select the series to modify.  
• Click the Edit button. 

The Edit Series dialog box appears. 

 
Figure 245: Edit Series dialog box 

• Make desired changes. Select the Update button in the Edit 
Series dialog box. 

• Alternatively, click the Reset button to remove any changes and 
return to the previous settings or click the Cancel button to return 
to the previous dialog box.  

 Click the Update button on the Edit Protocol dialog box. 
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Figure 246: Update button 

 Click the Begin button from the Exam Planner dialog box. 

 When the Is Scanner Properly Positioned? popup appears, click the 
Continue button. 

 
Figure 247: Is Scanner Properly Positioned? popup 

Note  If  zero reference is not selected when starting your 
scan, the scanner considers the last  known zero 
reference point  to be the origin and start -point for the 
next scan.  Always  make sure to zero reference the 
scanner, when you set up a scan . 

The system state orb will change color from yellow to green.  The 
System Ready to Scan popup appears. 
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Figure 248: System Ready to Scan  

 
WARNING Do not stand in either the forward or reverse paths of the 

scanner during the scan. 

Note  The scanner’s s ide panels permit a low radiation 
exposure rate of <0.01mR/sec/100mAs –  when x-ray is 
emitted.  

The START button on the scanner control panel turns green when it is 
enabled. 

 
Figure 249: Scanner control panel – START button 

 Press the START button on the scanner control panel to acquire your 
scan. 
The pre-set scan delay countdown begins.  The green light turns off 
when the START button is pressed. 

 
Figure 250: Countdown popup 
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You can press CANCEL on the scanner to end the current scan 
operation.  If pressed when lit, the system cancels the current 
scanning operation.  If pressed during scanning, 1 current scan 
rotation, or 1 second, completes and then the scan is terminated.  
Alternatively, you can press the Cancel Scan button on the screen to 
cancel the entire scan or Cancel Exam button to cancel the entire 
exam. 

 
Figure 251: Scanner control panel – CANCEL button 

Note  During the scan, observe the following:  

 Yellow lights on top of the scanner, and an audible 
beep identify that radiation is being emitted.  

 The patient’s scan results appear; approximately one 
image per second.  

 When scanning begins, the Continue ,  Repeat ,  Extend ,  
Pause Scan ,  Pause Exam ,  and Cancel  buttons are 
enabled.  

 When you cl ick the CANCEL  button, the message “Scan 
is terminated” appears on both scanner and 
workstat ion.  

 If applicable, set your parameters and Field Of View (FOV) on your 
scouts. 

Note  FOV can only be adjusted when two scouts are 
acquired.  
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Figure 252: Scouts and FOV button 

Scan coverage can be modified by selecting the drag boxes and 
adjusting the lines and can be centered by clicking on the small green 
circle and dragging the plan box. 

 Click Continue to proceed with your planned scan.  

 
Figure 253: Continue button 

The Pending Scanning Movement popup appears. 

 
Figure 254: Pending Scanner Movement popup message 

 Click the Continue button to scan. 
Click the Cancel button to cancel the scan. 
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 The System Ready to Scan popup appears. 

 
Figure 255: System Ready to Scan popup message – System is ready to 
begin scan 

 The START button on the scanner control panel turns green when it is 
enabled.   

 
Figure 256: Scanner control panel – START button 

 Press the START button on the scanner control panel to acquire your 
scan. 
The pre-set scan delay countdown begins.  The green light turns off 
when the START button is pressed. 

 
 If the Perform Reconstructions popup appears, do one of the 
following:   
• Click the Yes button to perform post reconstructions now. 
• Click the No button to pause the reconstructions until a later 

time.  When ready, click the Start Recons button. 

 
Figure 257: Perform Reconstructions popup message – To perform post 
reconstructions 

 

 Use the Viewing tools to review the scan. 
See “Examining the scanned image with tools” on page 291. 
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 Click the Finalize button when finished. 
The dose report if Show Dose Report in System Configuration is 
enabled appears.  In addition, the examination details are saved. 

Note  You must press the Finalize button before you can 
send the patient’s data to PACS .  

 
Figure 258: Dose report 

Repeating an image 

The Repeat function can be used to repeat a scan if necessary.  The 
entire scan be repeated, or after reviewing the images, a new start 
position and coverage can be selected if only a portion of the scan needs 
to be repeated.  

 While the Acquisition tab remains active, click the Repeat button. 
The Protocol Viewer dialog box appears. 
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Figure 259: Protocol Viewer dialog box 

 Review the protocol parameters. 

 Click the Repeat button from the Protocol Viewer dialog box. 
 

 The Repeat Protocol popup appears. 

  
Figure 260: Repeat Protocol popup 

Note  You can change the start and end position or use what 
appears.  

 Click the Repeat button on the Repeat Protocol popup. 
Scout lines appear in blue, which indicates the second scan and 
modifications of the start and end points – if made. 
The scanner will move to the start position. 
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 Press the START button on the scanner’s control panel to begin the 
repeat scan. 

Scanning with special features 

The following features are available for use in protocols.   

Using the step-and-shoot option 

The Step & Shoot option in the protocol lets the user control the start of 
the scan acquisition.  This is helpful in the case of an uncooperative or ill 
patient where motion is an issue. 
 

 If necessary, change the Scan Type to Axial. 

 Click the Step & Shoot option in the Edit Series dialog box. 

  
Figure 261: Step & Shoot option in the Edit Series dialog box 

 Click the Update button in the Edit Series dialog box. 

 Click the Update button in the Edit Protocol dialog box. 

 Click the Begin button in the Exam Planner dialog box to begin the 
scan. 
The system state orb will change color from yellow to green. The 
System Ready to Scan popup appears. 
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Figure 262: System Ready to Scan popup 

 To continue the scan, go to the scanner and press the Scan button on 
the screen. 
The first set of images are acquired at this position. 
The Step & Shoot popup appears for you to control the next 
acquisition. 

 
Figure 263: Step & Shoot popup 

 Click the Shoot button to start the scan. 
To cancel the scan, click the Cancel button. 

 Continue for the length of the scan. 

 Click the Finalize button when finished. 

Performing a scan with Automatic Exposure Control  

Note Depending on system’s configuration, not all  functions 
may be available to perform this procedure.  

Computed Tomography (CT) is responsible for the largest contribution to 
the collective effective dose to patients in radiology.  The challenge to 
radiologists and medical physicists is to establish adequate image quality 
with the lowest radiation exposure to the patient.   
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Tube current (mA) is one of the key technical scanning parameters for 
adjusting radiation dose in CT.  To optimize radiation dose in CT, users 
can adjust mA either with manually selected values or with the 
application of Automatic Exposure Control (AEC).  AEC refers to the 
automatic adaption of mA based on user specified image quality and 
attenuation characteristics of the scanned body region. 

Scout scans provide a graph of mA values based on object density and 
desired noise level.  Axial or Helical scans in the protocol can utilize AEC, 
limiting the mA value of each slice to the minimum necessary to achieve 
the desired image quality.  This ability to modulate the mA throughout 
the scan to achieve the desired noise level can reduce patient dose. 

When using AEC, it is vitally important that the patient is well-centered in 
the gantry.  AEC aims to deliver the specified image quality across a range 
of patient sizes.  The use of AEC may change the planned CTDIvol and DLP 
values.  It tends to increase CTDIvol for large patients and decrease it for 
small patients relative to a reference patient size. 

Note: Ensure patient is accurately centered in the gantry.  

 Do not use AEC when any type of metal is going to be 
scanned.   

 Do not  use AEC  with a small FOV ,  that is,  t iny neonatal 
patients.  

 An automatic adjustment of the tube ’s  current cannot 
occur when the tube potential is changed.  

 AEC can only be used with the following Sharpness 
options:  

  Helical Soft Tissue –  Head  
  Helical Soft Tissue –  Abdomen 
  Axial Soft Tissue  
  Axial Pos.  Fossa/Vessel  
  Axial Sharp  

 Under AEC, click the Enable AEC option.  
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Figure 264: Edit Series dialog box with AEC options selected 

 Select the Minimum mA dropdown to set the minimum allowed mA 
value to be used for scanning. 

 
 Select the Maximum mA dropdown to set the maximum allowed mA 

value to be used for scanning.  The available range is 30 to 300.  

 Select the Noise Level to set the standard deviation of noise value for 
the acquired images.  The noise range is 1-200. 

Note  Consult with the site’s physicist for guidance specif ic 
to the department.  

 Click the Update button in the Edit Series dialog box. 

 Click the Update button in the Edit Protocol dialog box. 

 Make sure your patient and scanner are properly positioned. 

 Click the Begin button to begin the scan. 

 Press the START button on the scanner control panel. 

 After the scouts are acquired and the scan region is set, click the AEC 
tab. 

 Click the Toggle Graph button to view the graph on the scout. 
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Figure 265: Toggle Graph button 

The graphs will now appear on the scout(s).  Review the mA 
modulation to ensure it meets your clinical needs. 

 
Figure 266: Graphs on the scout(s) 

 
Figure 267: AEC modulation graph 

 To return to the scout parameter view, click the Toggle Graph button, 
again. 

 If changes to the mA or Noise levels are required, you can modify the 
Minimum, and Maximum mA and noise as needed on the image. 

 
Figure 268: Minimum mA and maximum mA; noise level 

 When the desired level is achieved according to your department 
policy, click the Continue button to start the scan. 
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 Press the START button from the scanner. 

Note  While reviewing the scan you will  see mA modulation 
as per your graphs.  

 Click the Finalize button. 

Performing a CT angiography scan with Bolus Tracking 

CT angiography is a technique that uses contrast to visualize arterial and 
venous vessels throughout the body.  This ranges from arteries serving 
the brain to those bringing blood to the lungs, kidneys, arms, and legs. 

Table 51: Bolus tracking parameters and tools 

Option Description 

 The amount of time allowed to monitor the bolus. 

 

Begins the scan after the specified bolus scan time 
if no bolus is detected. 

 
Stops the scan after the specified bolus scan time 
if no contrast is detected. 

 

A small amount of contrast is injected, and a 
timing graph is displayed after specified bolus 
scan time. 

 

Hounsfield Unit detection at the area being 
monitored – ROI. 

 

When performing the test bolus, click the Use 
Calculated option to use the bolus timing 
calculated from the test bolus scan. 

 

Allows you to select a manual timing of bolus 
after the test bolus has calculated a timing. 

 Perform steps 1 through 8 in “Performing a scan” on page 255. 

 Click the Bolus Tracking option and set parameters, such as Auto-
Start, Auto-Stop, Bolus Scan Time, and Threshold. 



BodyTom 64 User Manual Revision 04 

 

Chapter 9    Patient Scanning  Page 272 of 412  

 
Figure 269: Bolus Tracking option 

 Click the Update button in the Edit Series dialog box. 

 Click the Update button in the Edit Protocol dialog box. 

 Click the Begin button to acquire the scout(s). 

 Acquire the scout(s). 

 To move the scout or reference line go to the Viewing tools and 
select Active Scan Region. 

 
Figure 270: Active Scan Region – Bolus Reference or Helical CTA 
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Note  If  the protocol contains one or more scouts, the 
system places the scan region for each series on the 
scout based on start and end positions that were 
entered for each series in the protocol.  The Active 
Scan Region  dropdown populates the data with the ID 
that corresponds to each region.  You can adjust the 
scan region prior to continuing the exam , as described 
below. 

 On the scout, use the Blue lines to plan the helical scan.  

 
Figure 271: Scout line (blue) and Reference line (green) 

Note  The distance between the Reference  and Bolus 
Tracking  scans cannot exceed 100mm.  
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 Position the green Reference line at the desired anatomical location.  

 Click the Continue button. 
The scanner will move to the reference line noted on the scout. 

 Go to the scanner and press the START button on the scanner control 
panel. 

 Click the ROI tool and draw the ROI on the Reference image. 

 
Figure 272: Bolus ROI tool 

 
Figure 273: ROI on the Reference scan 

 Click Continue. 

 Load the injector and set your desired flow and rate and arm the 
injector. 

 When the scanner is ready, press START on the scanner and manually 
start the injector at the same time.  

 The Helical scan will trigger when the threshold value set for the ROI 
is exceeded.   
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Figure 274: Scan triggers when bolus enters reference point/ROI 

 Review the completed scan. 

 
Figure 275: Scan at peak enhancement 

 Press the Finalize button when complete. 

Performing Test Bolus 

Test Bolus evaluates the timing of the injected contrast.   
A small amount of contrast is injected, and a timing graph is displayed 
after the specified bolus scan time.  When the contrast is detected, the 
system stops scanning and a report on the recommended delay-time for 
CTA protocols appear. 

 Perform steps 1 through 8 in “Performing a scan” on page 255. 

 Click the Bolus Tracking option, click the Test Bolus option and set 
parameters. 
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Figure 276: Test Bolus option 

 Click the Update button in the Edit Series dialog box. 

 Click the Update button in the Edit Protocol dialog box. 

 Click the Begin button to acquire the scout(s). 

 Acquire the scouts(s). 

 To move the scout or reference line go to the Viewing tools and 
select Active Scan Region. 

 
Figure 277: Active scan region 

 On the scout, use the blue lines to plan the helical scan. 
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Figure 278: Scan planning lines 

 Position the green Reference line at the desired anatomical location. 

 Click the Continue button. 
The scanner will move to the reference line noted on the scout. 

 Go to the scanner and press the START button on the scanner control 
panel. 
The reference image will be scanned and displayed. 

 Click the ROI tool and draw the ROI on the Reference image. 

  
Figure 279: Bolus ROI 

 
Figure 280: ROI on the Reference scan 

 Click Continue button. 
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 Load the injector and set your desired flow and rate and arm the 
injector. 

 When the scanner is ready, press START on the scanner and manually 
start the injector simultaneously. 

 The Bolus Timing graph appears and shows the calculated, bolus-
tracking time. 

  
Figure 281: Bolus timing graph 

 Select from one of the following: 
 

 Click the Continue button. 
Review completed scan. 

 Press the Finalize button when complete. 

Performing a CT Perfusion Scan 

CT perfusion (CTP) is a technique used to evaluate cerebral perfusion of 
the level of blood flow in the brain, by monitoring the initial phase of 
iodinated contrast media through the vasculature of the brain. 

1. Perform steps 1 through 8 in “Performing a scan” on page 255. 

Use 
Calculated 

Uses the bolus timing calculated from the Test 
Bolus scan. 

Use Manual 
Allows you to manually set the delay time prior to 
the start of the helical scan.   

Auto Start 
Begins the scan after the specified bolus scan time 
if no bolus is detected. 

Auto Stop 
Stops the scan after the specified bolus scan time 
if no contrast is detected. 
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2. After selecting CTP protocol, review the Dynamic CTP options 
including Scan Time and make your selections. 

 
Figure 282: Edit Series CTP Scan Time  

3. Click the Update button in the Edit Series dialog box. 

4. Click the Update button in the Edit Protocol dialog box. 

5. Click the Begin button to acquire the scout(s). 

6. Perform scout and set Dynamic CTP scan location.  

7. To move the Dynamic CTP location use the green circle inside the 
reference line.  

8. Click the Continue button. 
The scanner will move to the reference line noted on the scout. 

9. Load the injector and set your desired flow rate.  When the scanner is 
ready, press Start on the scanner and manually start the injector at 
the same time. 

10. Review completed scan. 
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Figure 283:  Brain Perfusion Image 

11. Select Finalize. 

Calculating and creating perfusion maps  

 Select a perfusion patient from Patient Browser and select the series 
to view. 

 To open the image, click the View Images button or double-click the 
series. 
The Viewing tab is enabled, and the CTP tab automatically opens. 

  
Figure 284: CTP tools 
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Table 52: CTP Tools 

CTP Viewer tools  

 

Perfusion 
Artery/Vein 
Selection 

Select to place the arterial and 
venous ROIs on the images. 

 

Calculate CBF, 
CBV, MTT Map 

Select to calculate the CT 
Perfusion maps. 

 

Clear 
Perfusion Map 

Cancels the calculations and 
returns to Calculation mode. 

 

Show 
Artery/Vein 
Flow Graph 

Displays the Arterial Venous Flow 
graph. 

 

 
Peak Image 

Displays the image that has the 
highest HU value based on the 
arterial ROI placement.  

 

 Click the Perfusion Artery/Vein Selection tool. 

 Place an Arterial ROI. 

 Place a Venous ROI. 

 Click the Calculate CBF, CBV, MTT Map tool. 

 The Perfusion Maps are calculated and displayed: 

 
Figure 285: Perfusion maps 

The calculations produce three maps and the perfusion image: 

Perfusion Images Top, left corner 

Cerebral Blood Flow (CBF) Top, right corner 

Cerebral Blood Volume (CBV) Bottom, left corner 

Mean Transit Time (MTT) Bottom, right corner 



BodyTom 64 User Manual Revision 04 

 

Chapter 9    Patient Scanning  Page 282 of 412  

 
 Clicking the Artery/Vein Flow Graph displays the following:  

 
Figure 286: Arterial Venous Flow  

 
This graph displays arterial and venous flow rates with respect to 
time.  

 Click the Peak Image tool to display the peak image. 
The peak image displays the image that has the highest HU value 
based on the arterial ROI placement.  
 
 Click the Clear Perfusion Maps tool to cancel calculations and return 
to Calculation mode. 

 Click the Reset button to reset images back to the original setting(s). 
You cannot undo this action. 

Using the Interventional Package  

The Interventional Package is designed to make Interventional 
procedures quick and easy for the technologist and physician.  When 
activated the gantry will spin continuously to make the transition to a 
scan as fast as possible.  

When enabled, the Interventional Tab will be displayed as seen below.  

 
Figure 287: Interventional Tab 

When activated, the Interventional Tab provides a streamlined workflow 
specifically for interventional cases.  
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Figure 288: Interventional Tab - Patient exam details 

 
The Interventional Tab includes the following options: 

Table 53:  Interventional Tab options 

Option Description 

 

Allows a typed in value, when Move is 
clicked the scanner goes to that location 

 Moves the scanner to the Laser location 

 
Toggles the laser lights on or off 

 
Allows protocol parameters for the 
Interventional procedure to be modified 

 
Initiates X-Ray when the user is ready 

 
Repeats the last scanned protocol 

 

Allows a selected raw data set to be Post 
Reconstructed without leaving the 
Interventional workflow 

 
Stops the gantry rotation 

 
Cancels the currently planned scan 

 
Ends the current examination 

 
Allows you to archive the series selected in 
the Scan Tree to any archive device 

 
Performs a 38.4mm axial scan at the current 
scanner location 

 
Moves the scanner to the last scanned 
position and performs a 38.4mm axial scan 
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Exits the system from the Instant Repeat 
Feature 

The tab also includes a Scan Tree, Current Scan, and an updated Dose 
Gauge.   

 
Figure 289: Scan Tree, Current Scan, and Updated Dose Gauge 

The Scan Tree allows access to acquired scans for quick image loading or 
repeat scanning using those parameters. 

• When a series in the Scan Tree is selected, the images associated 
with it will be displayed, allowing them to be reviewed to ensure the 
proper start and end locations as well as the thickness and spacing 
are selected for repeat scans.  

• Clicking any of the scans in the Scan Tree, then clicking ‘Repeat’, 
moves the scanner to the Start location from the selected series and 
automatically initiates scanning. 

  
The Current Scan box shows the protocol parameters used for the most 
recent active scan. 
  
The Dose Gauge displays the accumulated CTDI and DLP in mGy for the 
current procedure and is updated each time a new scan is initiated. 
 
Viewing Tools, Windowing, and Zoom options are available by clicking 
the appropriate line below the Dose Gauge.  

   
Figure 290: Viewing Tools, Windowing, and Zoom options 

A right click menu on the active image, also allows access to a full array of 
viewing and measuring tools. 
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Figure 291: Interventional Workflow 

Interventional Workflow 

Any protocol can be used as an Interventional protocol. 
 
1. Register a patient 

 
2. Click ‘Protocol’ 

 
3. Select the desired protocol 

 
4. Ensure the ‘Interventional Scan’ box is selected.  

 
Figure 292: Interventional Workflow - Protocol Information dialogue box 

5. Click ‘Begin’ to accept the protocol and perform the scout scan(s). 
 

6. Plan your scan over the region of the procedure and acquire that 
scan. 

Note  NeuroLogica suggests the use of a Grid position ed on 
the patient in the area of the procedure to be 
performed.  
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7. Once the scan has been acquired the system will automatically move 
to the Interventional tab and show the following:  

 
Figure 293: Interventional Workflow - Scan acquired 

8. Review the acquired images from the previous scan to determine the 
location of the procedure to be performed.  

Note  To make viewing of the axial images easier, you can 
select the ‘Toggle Scouts’ button, which will  display only the 
axial image on screen.  

 
Figure 294:  Toggle Scouts Button 

 
9. Enter the procedure location in the ‘Go To Position’ box, and click 

‘Move’. 

• This will move the scanner to the selected location and allow the 
physician to mark the patient.  Make a note of this location as you 
will use it to center the scanner over this area for future scans. 

• You can use the ‘Laser On/Off´ toggle button to enable the laser 
light if it is not already on to allow the physician to mark the 
patient.   
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Figure 295:  Go To Position 

 
10. After the physician has marked the procedure location on the patient, 

enter a value in the ‘Go To Position’ box and click ‘Move’ to move the 
scanner out of the procedure field and allow the physician to prep 
the skin and administer local anesthetic.  In the example below we 
are using a scanner location of 500.  

   
Figure 296:  Go To Position for Patient Prep 

 
11. When the physician has completed prepping the patient and is ready 

to image the procedure area, enter the location noted in Step 9 
above into the ‘Go To Position’ box and click ‘Move’. 

 
Figure 297:  Move to procedure location 
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12. Wait for scanner to stop at the correct location, then Click ‘Protocol’ 

 
Figure 298: Interventional Protocol Parameters 

 
13. Place a check in the ‘Stay in Instant Repeat Mode’ 

• This will automatically modify the protocol to an Axial scan with a 
set 38.4mm coverage. 

• You can modify any of the available parameters, like kV, mA, 
Sharpness etc., on screen to meet your needs.  

 
Figure 299:  Stay in Instant Repeat Mode 

 
14. Once parameters  are selected click ‘Begin’ 
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15. Click the ‘Instant Repeat’ button to initiate the scan set in the 
protocol. 

 
Figure 300: Initiate Scans - Interventional protocol 

16. When satisfied the anatomy of interest is included in the images, you 
can enter a location in the ‘Go To Position’ box and click ‘Move’. 
• This moves the scanner out of the way to allow the physician 

access to the patient.  

 
Figure 301: Move the Scanner 

17. When ready to perform another scan in the original position, click 
‘Move/Repeat’ 
• The scanner will move back to the previously defined start 

location and perform additional scans as defined in the protocol.  

 
Figure 302: Repeat Scans - Interventional protocol 

18. You can now use the ‘Move´ and ‘Move/Repeat’ options to move the 
scanner back and forth to allow the physician access to the patient 
and perform repeat imaging to confirm needle position in the patient. 
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Note  If  the physician needs to modify the needle location, 
you can move the scanner to that new location and click the 
‘ Instant Repeat’ button.  This wil l  acquire one axial rotation 
of 38.4mm using the parameters previously set in the 
protocol at this new location.  This will  a lso be saved as the 
new ‘Move/Repeat’ location.  

19. If changes to the protocol are necessary, click ‘Exit Instant Repeat’. 
 

20. Click ‘Protocol’ 
 

21. Modify the parameters to the desired values, ensure the ‘Stay in 
Instant Repeat Mode’ is selected and click ‘Begin’. 
 

22. You must then click ‘Instant Repeat’ to initiate the new scan. 
 

23. When the procedure is completed, click the ‘Exit Instant Repeat’ 

 
Figure 303:  Exit Instant Repeat 

 
24. Click ‘Finalize’ 

 
Figure 304: Finalize 

Note  If  the scanner has been idle in the ‘ Instant Repeat’ 
mode for f ive minutes a message will  be presented on 
the screen stating that ‘ Instant Repeat’ will  be 
disabled in two minutes.  Clicking the ‘OK’ button will  
prevent the system from disabl ing ‘ Instant Repeat’ for 
an additional f ive minutes, at which time the message 
would be presented again.    
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Figure 305:  Instant Repeat will be disabled 

Examining the scanned image with tools 

The image tools can only be used when the Acquisition tab is enabled 
and an image is displayed, or when images are loaded to the viewer from 
the Patient Browser tab.  

From the Acquisition tab, you can zoom, pan, modify window width, and 
center, and change layout; see the table below to understand the basics 
of what each tool looks like and how it performs. 

Using tools on the Acquisition tab  

The following table describes some of the tools available to you when the 
Acquisition tab is active.  For a comprehensive list, see Table 57: 2D, 
MPR, 3D, and CTP image tools.  

Table 54: Image tools 

Image tool  Tool name Action 

 

Clear Tool 
Resets the tool to the default 
pointer. 

 

Window 
Width/Center 

Adjusts window width and center 
of image.  

 

Zoom Magnifies the image. 

 

Pan Adjusts image on X or Y axis 
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Image tool  Tool name Action 

 

Toggle Scouts 
Display’s or removes scouts from 
Acquisition. 

 

Toggle Layout 
Changes the layout to 2x2.  Repeat 
process to return to 1x1. 

 

Scan Region 
Re-Draw 

If scout lines and the scan region is 
deactivated, allows you to 
reactivate. 
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Chapter 10     Patient Browser  

The Patient Browser lets you view patient information and images 
associated with the patient information after the patient’s scan. 

 
Figure 306: Active Patient Browser tab 

The following table identifies the buttons found on the Patient Browser. 

Table 55: Command buttons 

Button Action 

 

Selects the archive destination for selected 
information. 

 
Imports exam information from PACS or Media. 

 

Deletes the selected exam information from the 
Patient Browser tab. 

 
Reregisters a patient who is already in the system.  

 

Generates a Dose Report and Dose SR for the 
selected patient. 

 

Shows patient, study, series, and image 
information. 

 
Displays selected patient images in Viewing.  

 
Allows you to compare two series. 

Navigating the Patient Browser 

The Patient Browser lets you perform tasks on existing series, for 
example archiving and previewing the series.  This section will introduce 
you to Patient Browser and identify the symbols, areas, and buttons you 
can use. 

The Patient Browser can be broken down into the following sections: 
• Exam table 
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• Series table 
• Selected protocol table 
• Patient Browser’s active buttons 
• Preview window 

 
Figure 307: Patient Browser sections 

Identifying symbols on Patient Browser 

Symbols may appear next to series in the exam and/or series tables.  
These symbols are more vivid when active; they are identified below as 
active symbols. 

Locked 

 
Indicates the series is locked and cannot be deleted.   

Read/Mark

 

Indicates the series is marked to be read or read by the 
physician.   

PACS 

 
Indicates the series has been sent to PACS.   

Stored 

 

Indicates the series has been sent to PACS; the 
archived series appear below the initial table 

Media 

 

Indicates the series has been sent to a media device, 
for example USB.  
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Figure 308: Patient Browser locked, read, PACS and Stored (archived), and 
media symbols 

Using the vertical and horizontal scroll bars on Patient 
Browser 

Navigation scroll bars let you move the lists in the Patient Browser 
sections up, down, and horizontally to view all available exam 
information.  

 
Figure 309: Patient Browser horizontal and vertical scroll bars 

Locking a study 

 Click the Patient Browser tab. 

 Select the study to lock. 
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 Right-click the mouse button. 

 Click Lock on the floating menu. 

  
Figure 310: Floating menu - Lock 

The Lock symbol appears for any selected series. 

  
Figure 311: A locked series 

A series cannot be deleted while in the Lock mode. 

 To unlock right-click and click Unlock. 

Note All QA  series are locked to prevent delet ion.  The QA  
series can only be unlocked by your f ield service 
representative.  

Marking a series to read 

 Click the Patient Browser tab. 

 Select the study to mark. 

 Right-click the mouse button. 
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 Click Mark on the floating menu. 

 
Figure 312: Floating menu - Mark 

The Mark symbol appears for any selected series. 

 To unmark any series, right-click Unmark. 

Using the preview window 

 Click a patient in the exam table. 

 Click a series in the series table. 

 Click the Preview button to the right of the Series Protocol Table. 

  
Figure 313: Preview Button 

 
 The selected series will appear in the Preview window.  

 
Figure 314: The series appears in the preview window 
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Archiving patient series  

You can archive patients and studies (or series) to PACS, media (USB or 
CD), or surgical navigation devices.  

Archiving to PACS 

 Click the Patient Browser tab. 

 Select the patient study for PACS in the following way: 
• To select one patient and all associated series, click the patient, 

and click the Archive button. 
• To select specific series for a patient, press and hold the Ctrl key, 

then click each individual series from the Series table, and click 
the Archive button. 

The Archive Destination popup appears. 

 
Figure 315: Archive Destination popup 

 Click the PACS button. 
The Archive to Server popup appears. 

 Click the Select Archive Location dropdown and select a site. 

 
Figure 316: Archive To Server popup 
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 Review the Image Range items to make sure all those items you 
selected in step 2 are captured. 

 Click the Archive button to begin the archive process. 

If enabled the Store/Print Queue dialog box will appear to show the 
status of your image transfer.  You can also activate the Store/Print 
Queue dialog box by clicking Tools > Store/Print Queue from the 
main menu.  

 

 

 

 

 

 

 

 

Figure 317: Store/Print Queue dialog box 

 Watch the status of each series: 

• Pending informs you that the series is paused because you clicked 
the Pause button. 

• Connecting informs you that the series is in process of archiving 
to its targeted location.   

• Each series will move from the top portion of the popup to the 
bottom portion of the Store/Print Queue popup when it has been 
processed. 

 While the archiving is in process, you can perform one of the 
following from the buttons in the Store Print Queue dialog box.  

Table 56: Store and Print Queue buttons 

Store and Print 
Queue button 

Action 

 

When you select one or more series, 
temporarily stops the series from being 
stored.  This is a toggle button with the 
Resume button. 

 

When you select one or more series, 
deletes either a series to be stored, or a 
series that failed to store. 
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Store and Print 
Queue button 

Action 

 
Stops the archive to USB or a drive. 

 

When you select one of more series, tries 
to archive the selections. 

 

When you select one of more series, 
displays an explanation of why a series 
failed to store. 

 
Closes the Store/Print Queue popup. 

  

 If the series is not successfully stored to its targeted destination, the 
“Store Failed” message appears in the Failure column.  This means 
the series was not successfully archived.   

 If there are failed archived series; click the Retry button to attempt to 
archive the series you selected. 

Note  Any Storing Failure  status appears in the bottom of 
the popup to inform you why the failure occurred.  If  
an archive job fai ls,  i t  wil l  be sent to the Failed 
Store/Print Jobs  l ist.  

 When the archiving is complete, click the Close button to exit the 
Store/Print Queue. 

You can also click the Close button, and the archiving process will 
continue as you do other tasks. 

Archiving to Media 

 Click the Patient Browser tab. 

 Select the patient study to archive following way: 
• To select one patient and all associated series, click the patient 

and click the Archive button. 
• To select specific series for a patient, press and hold the Ctrl key, 

then click each individual series from the Series table, and click 
the Archive button. 

The Archive Destination popup appears. 
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Figure 318: Archive Destination popup 

  
 If you are archiving a USB device, insert the USB drive into the USB 

port. 

 Click the Media button. 
The Archive to Media popup appears. 

  
Figure 319: Archive to Media popup 

 
 Click the targeted drive and path destination. 

 The Archive button is active. 
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Figure 320: Archive Button active 

 Click the appropriate check boxes for your archive process: 

Anonymous Patient 
Makes the patient’s information 
anonymous for HIPAA standards. 

Anonymous Institution 
Makes institutional information 
anonymous for HIPAA standards. 

Include CD Viewer 
(requires CD viewer 
software installed) 

Includes a CD viewer application to 
view images from the media. 

Export as JPEGS Exports image files in .JPG format. 

Show Demographics 
Includes the demographic 
information in archive if you clicked 
the Export as JPEGS check box. 

 Click the Archive button to begin the archive process.  
• The Cancel button is active after clicking the Archive button; click 

the Cancel button to stop the archive. 

 The Archive to Media dialog will update the status when archiving is 
complete. 
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Figure 321: Archiving complete 
 

• Click the Refresh button to remove any messages that appear 
in the Message box. 

• Click the Minimize button to continue working in other areas 
while the archiving process runs.   
o A disk appears at the bottom; click it to maximize the 

Archive to Media popup. 
• Click the Close button to exit the Archive to Media popup 

after the archive process is complete. 

Archiving to Navigation 

 Click the Patient Browser tab. 

 Select the patient study or series. 

 Click the Archive button. 

 Click the Navigation button. 

 Click the Select Archive Location dropdown and select the location. 
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Figure 322: Archive to Server popup 

 Under Image Range, select the image(s) you want to send to 
navigation. 
To return to the default selections, click the Reset button. 

 Perform one of the following: 
• Click the Archive button to send the image to Navigation. 
• Click the Cancel button to return to Patient Browser. 

Import 

Import allows you to add patient images to the Patient Browser.  

Importing from PACS 

 Click the Patient Browser tab. 

 Click the Import button to import data. 
The Import Location popup appears. 

 
Figure 323: Import Location popup 

 Click the PACS button. 
The Import from PACS dialog box appears. 
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Figure 324: Import from PACS dialog box 

 Click the Query button. 
The Query Information dialog box appears. 

 
Figure 325: PACS Query Information dialog box 

 Perform the following: 
• Select a HIS/RIS server from the dropdown. 
• Set the values to search in your query. 
• Click one of the following buttons: 

o Click Query to save the search results. 
o Click Reset to clear the query information. 
o Click Cancel to exit the Query Information popup. 

 From the Queried results, select a patient and click the Get Series 
button.  



BodyTom 64 User Manual Revision 04 

 

Chapter 10    Patient Browser  Page 306 of 412  

 
Figure 326: Import PACS dialog box with active Get Series button 

 Click the Import button. 

 Click the Close button to exit the Import from PACS dialog box. 

Importing from media 

 Click the Patient Browser tab. 

 Click the Import button on Patient Browser. 
The Import Location popup appears. 

 
Figure 327: Import Location popup 

 Click the Media button. 
The Import from Media popup appears. 
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Figure 328: Import from Media popup 

 Click the drive and path where images were previously stored.  
The Import button is active. 

 
Figure 329: Active Import button 

• If necessary, click Subfolders to see the entire path. 

 Click the Import button. 
The imported images appear in Patient Browser. 

Delete 

 Click the Patient Browser tab. 

 Select the study or the series to delete. 
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 Click the Delete button. 
The Confirm Deletion popup appears. 

 
Figure 330: Confirm Deletion popup 
 

 Click the Delete button on the Confirm Deletion popup. 
The patient data will be deleted from the Patient Browser. 

Registering a patient from Patient Browser  

If additional scans must be performed on a patient that is listed in the 
Patient Browser, you can register them by performing the following: 

 Click the Patient Browser tab. 
 

 Select the patient to register. 

 Click the Register button.  

 
Figure 331: Patient browser register button 

 The Create New Study popup appears. 

 
Figure 332: Create New Study popup 

 Perform one of the following: 
• Click the Patient/Study button to use all exam information 

selected, including the accession number. 
• Click the Patient button to use only patient information. 
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• Click the Cancel button to exit the Create New Study popup. 

Building dose from Patient Browser  

The Build Dose button in the Patient Browser, allows you to manually 
create a Dose Report and Dose SR image which will appear in the Series 
table when completed.  

 Click the Patient Browser tab. 

 Select the patient to use for the Build Dose.  

 Click the Build Dose button.  

 
Figure 333: Build dose button 

 The Build Dose Please Wait popup appears. 

  
Figure 334: Please Wait popup 

 The Dose Report and Dose SR image will be saved to the Series Table.  

  If the Dose Build Failed popup appears, click the OK button, make 
the necessary changes, and try again.  



BodyTom 64 User Manual Revision 04 

 

Chapter 10    Patient Browser  Page 310 of 412  

 
Figure 335: Dose Build Failed popup 

Note  Dose Structured Reports (Dose SR)  cannot be viewed 
in the BodyTom 64 system; Dose SR  can be viewed in 
PACS  with the appropriate viewer.  

Using Show Info to view, update, and move a series  

 Click the Patient Browser tab. 

 Select the patient. 

 Select the series. 
The Show Info button becomes active.  

 Click the Show Info button. 
The View/Update Information dialog box appears. 

 
Figure 336: View/Update Information dialog box 

The following tabs appear: 

Patient 
Data about the patient, such as patient name, 
date of birth, and sex of patient. 

Study 
Data about the study, such as date, time, and 
referring physician. 
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Series 
Data about the series, such as the position 
reference indicator, model, pixel-padding 
value, and series date and time. 

Images 
Data about the image, such as the instance 
number (sequential), exposure time. 

 Click the tab(s) to review and update the necessary information. 

 Double-click any editable field and make your change(s). 

 Click one of the following buttons 
• Click the Update button to save your changes. 
 

Note  If  information is invalid, you are prompted to correct 
the information and click Update again.  

 If  the f ield cannot be edited, a prompt appears tell  you 
the selected f ield is not editable.  

• Click the Move button to show the Move Series popup. 
 

Note  The Move Series  function is used when a scan has 
been acquired under the wrong patient f i le or to move 
a patient that was registered manually to the Patient 
Registration  tab.  Moving the patient to the Patient 
Registration  tab will  capture all  the patient's 
information.  

• Click the Registration button to move the patient into an existing 
patient or by manually creating a new patient using the Patient 
Registration process. 

• Click the Cancel button to exit the Move Series popup. 
• Click Browser to go to the Patient Browser tab and move the 

series. 
• Click the Move button to confirm moving the series. 
• Click the Cancel button to exit the Patient Browser tab and return 

to the View/Update Information popup. 

 Click the Close button to exit the View/Update Information popup. 

Note  An audit log of both old and new patient series, 
including the date and time of change and who 
performed it,  is generated.  
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Modifying a series scanned under the wrong patient  

If a patient has been scanned under the wrong identification, the series 
can be corrected. 

 Click the Patient Browser tab. 

 Select the series that was scanned with incorrect patient 
identification to modify the data. 

 Click the Show Info button. 
The View/Update Information dialog box appears. 

 
Figure 337: View/Update Information dialog box 

 Click the Move button. 
The Move Series popup appears, denoting where to retrieve patient 
information from. 

 
Figure 338: Move Series popup 

The following defines what each button performs: 

Registration 

If patient information is stored within hospital’s 
HIS/RIS server, click the Registration button, 
which will open the Register Patient tab to let you 
choose patient/study information. 

Browser 

If patient information is stored within system’s 
browser, click Browser button, which show the 
Patient Browser tab information to let you select a 
series with correct patient information. 

Cancel Returns you to the previous dialog box. 
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 Perform one of the following: 
• If you clicked the Registration button in the previous step, go to 

the next step. 
• If you clicked the Browser button in the previous step, go to step 

11. 

 Click the Manual button. 
The Exam Information dialog box appears. 

 Enter the corrected data in any of the fields. 
See “Registering the patient” on page 244. 

 Click the Update button to save the change(s). 

  Click the Move button. 
A prompt appears to review changes made to the patient and/or 
series information for changes to take effect. 

 Click the Ok button and then the Update button. 
The corrected patient and moved data will appear in the Patient 
Browser. 

 If you selected the Browser button, the Patient Browser tab is 
showing; select the correct patient and series. 

 Click the Move button. 
A prompt appears to review changes made to the patient and/or 
series information for changes to take effect. 

 Click the Ok button. 

 Review the patient to ensure it is the proper one. 

 Click the Update button. 

 Click the Cancel button to return to the Patient Browser. 

Loading a series into view 

 Click the Patient Browser tab. 

 Select the patient. 

 Select the series. 

 Click the View Images button or double-click the selected series. 
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The Viewing tab opens, and the series appears for viewing and 
manipulating. 

Appending a series 

Note  Regardless of how many series are appended, the 
series are l isted chronologically.  This tool can be used 
to put all  images from a patient together on a CD or to 
PACS .  

 Click the Patient Browser tab. 

 Select the study to append. 

 Select the first series. 

 Right-click the mouse to select the second series. 
The Append Images appears on the floating menu. 

 
Figure 339: Floating menu - Append Images 

 Click Append Images. 
The Please Wait popup appears. 

 
Figure 340: Please Wait popup 
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A new series is created with (Appended) at the end of the 
description. 

 
Figure 341: (Appended) series created 
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Chapter 11     Viewing Images  

Viewing lets you see already-scanned images from previous 
examinations.  To view images, select the patient in Patient Browser and 
then select the series to view.  To open the image, click the View Images 
button or double-click the series. 

 
Figure 342: Active Viewing tab 

The following tables identify the tools in the Viewing tabs that let you 
manipulate images.  Some image tools appear on specific viewing tabs, 
only.  The view tabs are 2D, MPR, 3D, and CTP (if enabled). 

Table 57: 2D, MPR, 3D, and CTP image tools 

Image tools  Tool name Action 

Common tools  

 

Clear Tool 
Resets the tool to the default 
pointer device. 

 

Window 
Width/Center 

Adjusts window width and center 
of image. 

 

Zoom Magnifies the image. 

 

Pan Adjusts image on X or Y axis. 

 

Invert 
Inverts black to white and white 
to black. 

 

Capture 
Saves a screen capture of a 
selected viewport. 

 

Capture All 
Saves screen captures of all 
visible viewports. 

 
Reset 

 
 
Reverts all images back to their 
original mode. 
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Image tools  Tool name Action 

2D and CTP tools  

 

Region of 
Interest (ROI) 

Defines a circular ROI and 
displays the ROI information. 

 

Arrow Draws an arrow on the image. 

2D, CTP, and MPR tools  

 
Line 

Draws a line on the image and is 
used for measurement.  

 

Angle 
Draws an angle on the image and 
displays the angle information. 

2D only tools  

 

Add 
Annotation 

Create text box for annotation. 

 

Rotate Rotates images. 

 

Reverse Image 
Stack 

Reverses the order in which 
images display. 

 

Flip Vertically Flips images up or down. 

 

Flip 
Horizontally 

Flips images right or left. 

 

Cine Reverse 
Cines backward through the 
images. 

 

Cine Forward 
Cines forward through the 
images. 

 

Stop Stops the cine loop. 

MPR only tools  

 

Tilt 
When selected a White ‘steering’ 
wheel allows you to correct a 
rotated image. 
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Image tools  Tool name Action 

3D only tool  

 
Color Preset 

Dropdown menu allows you to 
select from multiple color 
options. 

 
Render Mode 

Dropdown menu allows you to 
display images in Color, MIP, or 
Grayscale. 

 
Orientation 

Dropdown menu that allows you 
to select from multiple 
orientation options. 

 

Rotate Rotates the 3D image. 

 

Undo 
Reverses the most recent action 
taken. 

 

Redo 
Restores the most recent Undo 
action taken.  

CTP only tools  

 

Perfusion 
Artery/Vein 
Selection 

Select to place the arterial and 
venous ROIs on the images. 

 

Calculate CBF, 
CBV, MTT Map 

Select to calculate the CT 
Perfusion maps. 

 

Clear 
Perfusion Map 

Cancels the calculations and 
returns to Calculation mode. 

 

Show 
Artery/Vein 
Flow Graph 

Displays the Arterial Venous Flow 
graph. 

 

 
Peak Image 

Displays the image that has the 
highest HU value based on the 
arterial ROI placement.  

Using keyboard shortcuts 

Keys are a quick way to navigate around.  The table below provides 
keyboard shortcuts you can use to manipulate images in the Viewing tab. 
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Table 58: Arrow key navigation 

Arrow keys  Action 

 

To scroll through images. 

 
To adjust the window center. 

    
To quickly scroll through images. 

Setting window width and center 

Note Any modifications you make are not saved to the 
image.  

 Select a patient from Patient Browser, select the series to view. 

 To open the image, click the View Images button or double-click the 
series. 
The Viewing tab is enabled and the 2D viewer opens.  

 The following options allow you to adjust the window width and 
center of the image: 
• Click the Window Width/Center icon in the Tools menu, then 

while holding the left mouse button down drag up/down to 
modify Window Center and right/left to modify Window Width. 

• To adjust with a preset, click the Windowing dropdown and select 
a preset.  

 
Figure 343: Windowing preset dropdown list 
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• Type values in the Width and Center text boxes and click the 
Apply button. 

 
Figure 344: Windowing Width and Center text boxes, and the Apply 
button 

• Right click over an image and use the Activate Window Tool 
option then while holding the left mouse button down drag 
up/down to modify Window Center and right/left to modify 
Window Width.  

 
Figure 345: Right click menu  

Viewing images in 2D 

2D lets you view scanned images in a 2-Dimensional space.  Standard 2D 
mode is used when only one dataset is loaded.  The default layout is a 2 x 
2 grid. 

The Viewing tab and 2D viewer opens when you select a dataset from 
the Patient Browser. 

 Select a patient from Patient Browser and select the series to view. 

 To open the image, click the View Images button or double-click the 
series. 
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The Viewing tab is enabled and the 2D tab is opened. 

 
Figure 346: 2D tools 

 Use any of the image tools to manipulate your images. 

 Click the Reset button to reset images back to the original setting(s). 
You cannot undo this action. 

Comparing images 

You can compare images in two different ways:  

Note  You can compare two series from the same patient or 
two series from different patients.  

Using the floating menu to compare images 

 Select the patient in Patient Browser. 

 Select the first series from the series window. 

 Right-click and click Mark for Compare from the menu. 

 
Figure 347: Floating menu - Mark For Compare 
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 Select the second series or a series from a different patient. 

 Right-click and then click Compare With Selected Series from the 
floating menu. 

 
Figure 348: Floating menu - Compare with Selected Series 
 

Both series are loaded into Viewing to compare. 

 
Figure 349: Compared series 

 Click the Link button to link both images together to view. 

 
Figure 350: Link button 
 

The Unlink button replaces the Link button. 

 Click the Reset button to reset images back to the original settings. 

Using the Compare button to compare two images 

 Select the patient in Patient Browser. 
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 Select the first series. 

 Press and hold the Ctrl key. 

 Select the second series. 
Both series are highlighted. 

 Click the Compare button. 

 
Figure 351: Using the Compare button 

Comparing a scout and a scan 

 Select a patient from Patient Browser. 

 Select a scout from the series window. 

 Press and hold the Ctrl key on the keyboard. 

 
Figure 352: Scout and scan selected to compare 

 Select the scan from the series window. 
Both images are highlighted. 

 Click the Compare button. 
The scout and the scan will appear on screen at the same time.  A 
green localizer line appears on the scout. 



BodyTom 64 User Manual Revision 04 

 

Chapter 11    Viewing Images  Page 324 of 412  

 Compare the scout to the scan. 

 
Figure 353: Comparing a scout (1) and a scan (2) 

 

 To remove the scout, right-click on the scout and click Hide Scout 
Viewpoint. 
To return the scout to view, right-click in the viewing window and 
click Show Scout Viewport. 

Using the ROI 

 Select a patient from Patient Browser and select the series to view. 

 To open the image, click the View Images button or double-click the 
series. 
The Viewing tab is enabled and the 2D tab is opened. 

 Click the ROI tool. 

 Move the mouse pointer to the image where you want the ROI 
located. 

 Click the left-mouse button and drag the ROI diameter to the 
required size.  To lock the ROI in place, click the left-mouse a second 
time.  
• To change the location of the ROI or the details of the ROI, click 

the ROI or measurements you wish to move.  The ROI and its 
measurements will turn yellow, and the pointer becomes a hand.  
Click and hold the mouse button on either the ROI or it’s 
measurements and drag to a new location.  Click anywhere 
outside the ROI to freeze it in the new location.  
o When you move the ROI to a different location the 

measurements of the ROI are automatically updated based on 
the new location.   
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 To remove the ROI, left click anywhere on the ROI, right click to see 
the floating menu, and click Delete Annotation, or click on the ROI 
and when it turns yellow, press Delete on the keyboard.  

 
Figure 354: ROI 

Using Layout and Rotate in 2D view 

Layout lets you alter the number of images presented on the Viewing 
tab.  Rotate lets you turn the images.  Select a patient from Patient 
Browser, select the series to view. 

 Select a patient from Patient Browser and select the series to view. 

 To open the image, click the View Images button or double-click the 
series. 
The Viewing tab is enabled and the 2D tab is opened. 

 To adjust the layout of the viewing area, click the Rows and/or 
Columns dropdowns to select the number of rows or columns you 
want to show. 

 
Figure 355: Layout (viewing tools) 
 

 To rotate the image, click the Rotate dropdown and select the 
number of degrees to rotate the images.  
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Figure 356: Rotate dropdown  

 Click the Rotate button to see the images turn to the new angle.  

 
Figure 357: Rotate (viewing tools) 

Applying a grid to your images in 2D 

 Select a patient from Patient Browser and select the series to view. 

 To open the images, click the View Images button or double-click the 
series. 
The Viewing tab is enabled and the 2D tab is opened. 

 Change the size of the grid in the Grid (mm) text box. 

 
Figure 358: Grid (mm) 
 

 Click the Apply button to apply a grid over the image. 

 Perform one of the following to remove the grid: 
• Click the Reset button. 
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• Enter 0 in the Grid (mm) text box and click the Apply button. 

Viewing images in MPR 

Multi-Planar Reformation (MPR) allows images to be created from the 
original Axial plane into Coronal, Sagittal or Transverse (Axial) planes.  
MPR is fast, uses all the attenuation values in the dataset, and can be 
easily performed on the workstation.  MPR however, provides on a two-
dimensional (2D) display of the image data.   

Viewer layout is 2 x 2 as seen below.  

 Select a patient from Patient Browser and select the series to view. 

 To open the images, click the View Images button or double-click on 
the series. 
The Viewing tab is enabled and the 2D tab is opened. 

 Click the MPR tab. 
The MPR screen appears. 

 
Figure 359: MPR tools 

 
 Select the image reformat at the bottom of the screen. 

 
Figure 360: Image reformat selections 

 Use any of the image tools to manipulate the images.  
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 The tilt tool can be used to modify the rotation of the images. 

 Adjust the image angle by moving the circle. 

 
Figure 361: Tilt tool 

 Click the reset button to reset the images back to the original 
settings. 
You cannot undo this action. 

 

Understanding and using slab 

Through the reformation process, axial images are stacked creating a 
volume, or slab, which can be assessed in different planes.  The thickness 
and spacing of each slab can be varied to meet the needs of the viewer.  
The reformations can be displayed in an average, maximum or minimum 
projection. 

MPR’s should be created using 1.2mm slices with a spacing of 0.6mm 
whenever possible. 

Creating the slab 

 Select a patient from Patient Browser and select the series to view. 

 To open the images, click the View Images button or double-click the 
series. 
The Viewing tab is enabled and the 2D tab is opened. 

 Click the MPR tab. 
The MPR screen appears. 

 Click the Sagittal, Coronal, or Transverse plane to create your slab. 
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Figure 362: Image formats 

 
 The Secondary Series option is enabled. 

 Select Enable Slab. 

  
Figure 363: Enable Slab option 
 

The Enable Slab option is inactive if no MPR view is selected. 

 
Figure 364: Enable Slab option under Secondary Series 

 Set the Cyan lines to determine the beginning and end of the slab. 

  
Figure 365: Cyan Line and cyan circle to drag for FOV 
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 Use the Cyan circle to drag the planned slab if required. 

 Define the Slab Thickness and Slab Spacing in the text boxes.  

  
Figure 366: Slab Thickness and Slab Spacing text boxes 

You can also use the yellow squares found on the slab thickness 
display to modify the Slab Thickness. 

  
Figure 367: Small yellow boxes to manually drag for desired slab thickness 

 
 Click the Slab Rendering Options dropdown to select the appropriate 
option. 

 
Figure 368: Slab Rendering Options dropdown 

The following options are available in MPR Slab mode: 

Slab Thickness The thickness of the MPR slab.  

Slab Spacing 
The space between the start of one slab and 
the next. 

Slab Rendering 
Options 

Where you define the pixel values that will be 
displayed in each slab: options include, 
Average, Maximum Intensity and Minimum 
Intensity. 

Maximum 
Intensity 

The highest pixel values for all slices within 
the slab is displayed. 

Minimum Intensity 
The lowest pixel values for all slices within the 
slab is displayed. 
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Average 
The pixel values of all slices within the slab 
are combined and the average value for each 
pixel is displayed. 

Series Description 
Text field for naming the series of images 
created when clicking the Generate button. 

Yellow lines 
Define the slab thickness.  The boxes on the 
lines allow you to adjust the thickness using 
the mouse.   

Cyan lines 

Define the slab FOV and dictate the range of 
the new series to be generated.  The cyan 
lines are adjustable by clicking and dragging 
on the lines themselves; both lines are moved 
by clicking and dragging the central circle 
marker. 

Red, blue, and 
green lines 

Define the cross sections of the anatomy 
being viewed. 

Generate 
Generates a new series with the name given 
in the Series Description field, based on the 
selected MPR view pane. 

 

 Select the Tilt Tool to correct any rotation on the image.  

  
Figure 369: Tilt tool 

 Use the mouse pointer to move the white Tilt circle. 

Note  The circle does not represent the Field of  View  
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Figure 370: Tilt white circle 

 Enter the slab name in the Series Description text box. 

 The slab can be previewed in the bottom right viewport. 

Note  Make sure Zoom  is at 100% or below.  

  Ensure all  expected anatomy is included when 
previewing the created MPR.  

 When you are ready to save, click the Generate button. 
A Saving Series popup appears. 

When the series is complete, the Capture Complete pop-up appears. 

 
Figure 371: Capture Complete popup message – Series saved 

 Click OK to close the Capture Complete popup message. 

 The new MPR images appear in the Patient Browser with the 
description in the Series Description text box.  

  
Figure 372: MPR images in Patient Browser 
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 To create additional MPR’s. select the Reset button in MPR mode, 
select the MPR view you want to create and perform the steps above 
to create the new view. 
 

  

Viewing images in 3D 

In 3D viewing, a 3-Dimensional image is created by stacking all the 
images of a scan on top of one another to create a 3D-volume.  The initial 
display shows the 3D volume and a box appears around it.  MPR planes 
also appear.  

 Select a patient from Patient Browser and select the series to view. 

 To open the images, click the View Images button or double-click the 
series. 
The Viewing tab is enabled and the 2D tab is opened. 

 Click the 3D tab. 

 
Figure 373: 3D tools 

 To rotate the image up to 360o, click Rotate and move the image with 
the mouse pointer to the rotation of choice.  

 You can change the Color Presets from the dropdown menu: 

 
Figure 374: 3D Color Presets  

 You can change the Render Mode from the dropdown menu:  
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Figure 375: 3D Render modes 

 Click the Orientation drop-down box to assign an orientation: 

  
Figure 376: 3D Orientation options 

 
 Click the Reset button to reset images back to the original settings. 

You cannot undo this action. 
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Chapter 12     Post Reconstruction  

The system stores multiple patient series of raw data to allow post 
reconstruction of images. Post Reconstruction allows reconstructing of 
the acquired data using different algorithms, slice thicknesses, or use of 
image enhancement algorithms, such as Metal Artifact Reduction, Noise 
Reduction and Windmill Correction.  

Reconstruction Overview 

 

Metal artifact reduction 

Streak artifacts are often seen around metal leads, prostheses, 
applicators, bone, or metal screws.  Numerous factors can contribute to 
these streaks including under-sampling, photon starvation, patient 
motion, beam hardening, and scatter.  You can use Metal Artifact 
Reduction (MAR) to reduce these streaks.  MAR removes the metal from 
the image to reconstruct the soft tissue only; then it adds it back, to 
reduce the artifacts.  This is currently used only on Axial scans. 

Noise reduction 

Noise appears as grain on the image and is caused by a low signal to 
noise ratio.  This occurs more commonly when a thin-slice thickness is 
used.  It can also occur when the radiation dose is insufficient to 
penetrate the anatomy being scanned.  

Note  Noise reduction applies to post -processing f i lters that 
reduce the amount of noise in the images.  In clinical 
practice, using noise reduction may allow for a 
reduction in CT patient-dose depending on the clinical 
task, patient size, anatomical location, and clinical 
practice.  Consult with the site’s radiologist and 
physicist to determine the appropriate dose to obtain 
diagnostic image quality for a particular cl inical task.  

Windmill Correction 

The Windmill Correction reduces artifacts that are common in Helical 
scans due to the nature of the cone-beam reconstruction. 
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Figure 377: Active Post Reconstruction tab 

 
The tools available to Post Reconstruction are identified in the table 
below. 

Table 59: Reconstruction tools 

Image tools  Tool name Action 

 

Load Images 
Loads images from selected series into 
viewing. 

 

Stop 

Cancels the current, post-
reconstruction request.  All images are 
generated until you click the Stop 
button. 

 

FOV 
Adjusts the FOV prior to 
reconstruction. 

 

Clear Tool  Resets tool to default pointer device. 

 

Window 
Width/Center 

Adjusts the width and center of 
selected image. 

 

Zoom Magnifies the image. 

 

Pan Adjusts the image on X or Y axis. 

 

Reset 
Resets the display to default viewer 
settings. 

 
Start Begins your Post Reconstruction.  

 
Resend  

Sends the last acquired scan from the 
recon workstation to the Patient 
Browser.  

 



BodyTom 64 User Manual Revision 04 

 

Chapter 12    Post Reconstruction  Page 337 of 412  

Performing Post Reconstruction 

The following figure identifies parts of Post Reconstruction: 

 
Figure 378: Post Reconstruction areas 

 Click the Post Reconstruction tab. 

 Select a study in the Exam Table. 
When you select a study, all the scanned series for that study appear 
in the Series Table. 

 Select the series to reconstruct. 

 
Figure 379: Post Reconstruction study and series tables 

 Click the Load button. 
The scan or series will load into the viewer.  The series protocol table 
and the Reconstruction Parameters and Options tabs are active.  The 
scan will appear in the Image Viewing Area. 

 View the study in the Image Viewing Area. 
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Figure 380: Post Reconstruction viewing image area 

 To modify the FOV, perform the following: 
• Click the FOV tool, click and drag the mouse to form a square on 

the image in the Image Viewing Area. 
o The size of the square appears in the Width box in the 

Reconstruction Parameters and Options tab. 
• Click the circle in the middle of the FOV square and drag to move 

the FOV. 
• Click one of the two drag boxes on the corners to adjust the size 

of box. 
o The Width dimension, and X/Y coordinates are adjusted as 

the size changes.    
o The FOV size cannot exceed the range of 50 - 600mm square. 

 
Figure 381: FOV resizing boxes 
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Note You can also enter a number in the Width  or X and Y 
box to define a specif ic FOV .  

 Alternatively, c l ick the Use FOV Max  option to use the 
maximum FOV .  

 Click the Sharpness dropdown to select a reconstruction algorithm 
from the Reconstruction Parameters tab. 

 
Figure 382: Sharpness on the Reconstruction Parameters tab 

 
Figure 383: Reconstruction Parameters Sharpness dropdown 

 Click the Slice Thickness/Spacing dropdown to select.   

 
Figure 384: Reconstruction Parameters Slice Thickness/Spacing dropdown 

The slice thickness and spacing options available are determined by 
the type of scan that was acquired (Axial vs. Helical).  

 The # of Expected Images text box shows the calculated number of 
images that will be reconstructed based on the parameters used for 
the reconstruction.  

 
Figure 385: # of Expected Images 
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 Click the Options tab.  The following are only available during Post 
Reconstruction. 

 Perform the appropriate action: 
• If desired, select Noise Reduction for an Axial or Helical scan. 

 
Figure 386: Noise Reduction on the Options tab for a Helical scan 

• If desired, select Perform Windmill Correction for a Helical scan. 

 
Figure 387: Perform Windmill Correction and/or Noise Reduction on the 
Options tab for a Helical scan 

• If desired, select Metal Artifact Removal for an Axial scan. 

 
Figure 388: Metal artifact removal   

 Click the Start button to generate a new dataset. 
When you click the Start button, the reconstructed images appear in 
the viewing pane. 

 
Figure 389: Please wait while the system performs data reconstruction 
message 

 
 When the reconstruction is complete, the images appear in Patient 
Browser. 
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Resending images from the scanner to the workstation  

Pressing the Resend button lets you send the last acquired scan from the 
recon computer to the Patient Browser.  This may be necessary when 
you have wireless interruptions and/or workstation shuts down 
unexpectedly. 

 
Figure 390: Resend button 
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Chapter 13     Accessories and Options  

In this chapter you will learn how to convert a bed, stretcher, or any type 
of adjustable surface into a scanning platform using the Universal 
Transfer Board. 

To request the catalog(s) to reference product descriptions/details and 
part numbers for the available accessories/options that are used with the 
BodyTom 64, see “Contact information” on page 24: 

When using a fixed scanner, the table moves from one portion of 
anatomy to another while the gantry remains stationary.  With the 
BodyTom 64, an in-place scanning platform remains stationary while the 
gantry or scanner translates from one point to the other to cover the 
anatomy. 

The universal transfer board can be used for most beds or stretchers.  It 
is placed under the patient and secured to the bed or stretcher with 
straps.   

 
WARNING NeuroLogica Corp. recommends that the weight of the 

patient being positioned on the scan board does not exceed 
the bed manufacturer’s safe, recommended, operating 
patient load.  Realizing patient safety is of the utmost 
importance, it is recommended that safe judgment be 
exercised at all times when it comes to the clinical care of 
patients.  There are a number of varying factors, such as the 
condition of the bed being used, unique patient anatomy, as 
well as the proper scan board and positioning of the patient, 
per NeuroLogica Corp.’s clinical training guidelines and 
product labeling.  If any excessive wear or damage is noticed 
to any scan board, do not use it for a patient scan; contact a 
qualified service technician to assess, repair, and/or replace 
the device. 

Using the Universal Transfer Board  
 The universal transfer board is a carbon-fiber, radiolucent board that is 
designed to work with any ICU bed or stretcher.  The carbon-fiber board 
comes with a 0.5-inch-thick headboard and 2-inch x 5-foot straps to strap 
the board to the ICU bed or stretcher. 
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You can use the universal transfer board on any bed, table, or stretcher.  
Because you can attach the universal transfer board to almost any type 
of surface, it is used anywhere throughout the hospital including the ICU, 
OR, and ER.  The universal transfer board is placed on the mattress and 
secured with a strap or placed directly on a surgical table under the 
cushions.  The patient lies on the board with the patient’s head in the 
head holder.  The BodyTom 64 is moved into position and the scan is 
performed.   

The universal transfer board is always used with mattress stiffeners.   

The mattress stiffeners provide a solid surface at the head of the bed to 
prevent the mattress from sagging when a scan is performed.  There are 
usually four mattress stiffeners stored with the BodyTom 64 for easy 
transport.  

The universal transfer board is used for adults. 

Note  The universal transfer board is an optional accessory 
that does not come with the system.  

Table 60: Universal Transfer Board weight-bearing restrictions 

The weight limit of the Universal Transfer board is equal to the 
weight limit of the patient bed.  The weight limit on the portion 
of the Universal Transfer board that supports the patients head 
is 7.5 kg / 17lbs.  The universal transfer board is used to support 
and scan the patients head, only. 

See also “Parts that potentially come into contact with the patient” on 
page 86. 

 
WARNING The weight limit for the superior portion of the Universal 

Transfer Board is 7.5kg or 17lbs. 

  
Figure 391: Universal transfer board and stiffeners 
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Figure 392: Four types of mattress stiffeners  

 

Note:  Tipping of the board is a major concern. The universal 
transfer board MUST be securely fastened to the 
surface prior to placing the patient on the board.  

 Obey all warning labels when using the scan board. 

 Select the appropriate mattress stiffener for the mattress size and 

insert.  

 
Figure 393: Mattress stiffener in place 

 

 The universal transfer board requires mattress stiffeners that provide 

a solid surface at the head of the bed to prevent the mattress from 

sagging with the weight of the patient when a scan is performed. 

 With the proper mattress stiffener properly inserted, apply the 

universal transfer board on top. 

 Position the board in accordance with the yellow, safety-warning 

stickers to avoid a tipping hazard. Do not extend the board beyond 

the mattress for proper placement. 
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Figure 394: Universal transfer board properly positioned on the bed on a 
mattress stiffener 

 When the board is properly positioned on the bed, secure it by using 

the safety strap. 

 The safety strap must be attached to the board, passed completely 

under the bed, and secured on the other side. 

 
 

 

 
 

 
Figure 395: Universal transfer board with safety strap installed 

 When the universal transfer board is securely fastened to the bed, 

transfer the patient to the board and secure the upper strap to the 

patient and the scan board. 
 

 When the patient is positioned and securely strapped in, position the 

scanner over the patient. 

 Initiate the scan. 
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Chapter 14     Cleaning and Storing the System and 
Workstation Specifications  

Be familiar with this section before using the cleaning or storing the 
system. 

Cleaning the scanner and workstation 

When the system is between uses, NeuroLogica recommends keeping it 
clean as described below.  This will help remove body fluids to prevent a 
health risk and damage to internal parts.   

Note  NeuroLogica recommends a solution of ≥99% pure 
Isopropyl Alcohol (IPA) to sufficiently clean the 
equipment.  

 
WARNING Do not use flammable or potentially explosive disinfecting 

sprays, since resultant vapor could ignite, causing personal 
injury and/or damage to the equipment. 

 
WARNING To prevent short-circuiting or possible electrical shock, do not 

spray cleaning agents or spill liquid cleaning agents directly 
onto the machine. 

 
WARNING Always electrically isolate this equipment from the main 

electrical supply before cleaning and disinfecting it to prevent 
short-circuiting or possible electrical shock. 

 
CAUTION The unit surfaces may be cleaned with a soft cloth and the 

recommended solution or a similar mild non-abrasive 
cleaning solution.  General purpose liquid disinfectant may 
also be used as necessary.  Apply the cleaning solution to the 
cloth, not directly to the unit. 

 
WARNING Before cleaning the workstation (drive system), be sure to 

disconnect the workstation from the wall outlet (power 
source).  Failure to do so could result in electrical shock and 
cause severe injury to you and/or damage to electrical 
components. 

 
CAUTION Do not allow electrical components to become wet.  For eye 

and hand protection, it is important to wear safety glasses 
and rubber gloves, respectively. 
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CAUTION Do not spray cleaning agents directly on the system. Spray a 

clean cloth with the solution and then wipe down the 
scanner and workstation. 

Cleaning the outside of the scanner and workstation  

 Prepare detergent/disinfectant (regulated by EPA as hospital 
disinfectant) solution according to instructions on label for correct 
usage. 
• Use a basin or spray bottle (with product label). 
• Use a pump (usually on detergent/disinfectant containers) to 

dispense the concentrate in the basin or spray bottle, then fill 
with correct amount of tap water. 

• If using a spray bottle, empty and rinse out after use. 

Note  The stabil ity of the solution is unknown after 24 hours; 
therefore,  a fresh preparation of cleaning solution 
must  be prepared for each day of cleaning .  

 Use general purpose germicidal cleaner on the external covers and 
rails.  Do not use cleaners on the screens. 

 Use swabs moistened with cleaning solution, clean and remove any 
dust, soil, dried contrast media, or foreign matter; allow all 
components to air dry. 

 Wipe down and clean the frame of device and allow to air dry; return 
to its storage area. 

Note  Wash (at 25°C) with neutral detergents , only ;  
softening agents are not allowed .  

The following recommended products are registered by the EPA as 
hospital disinfectant; these solutions are quaternary ammonium 
compounds and are used in environmental sanitation of non-critical 
surfaces: 

• TB Quat™ is a cleaning solution manufactured by ABC 
Compounding Co. 

• Wex-cide™ is a disinfectant manufactured by Wexford Labs, Inc., 
product number Wexcide128. 
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Maintenance of the workstation 

 
WARNING Maintenance checks and all service must be performed by 

service personnel trained by NeuroLogica Corp.  See 
“Contact information” on page 24. 

Storing the system 

Storing the scanner and workstation 

Store the scanner in a dry, well ventilated, climate-controlled area.  You 
can use the key to lock the scanner when not in use.  See “Identifying 
operator control panel buttons” on page 78 to locate the lock. 

 
CAUTION When the scanner is not in use and stored, it must be plugged 

in a 120V or 250V outlet to charge the batteries. 

 
CAUTION When the workstation is not in use and stored, it must be 

plugged in a 120V (or other compatible) outlet to charge the 
batteries. 

Store the scanner on its centipedes or castor wheels (feet). 

Note  If  the f loor surface is soft (sp ongy) store the system on 
its centipedes to disperse the weight of the system 
evenly.  

 After transporting the scanner to an acceptable storage location, you 
can either store the system in Transport mode (on its caster wheels) 
or Scan mode (on its centipedes). 

 
Figure 396: BodyTom 64 castor wheels 

 Turn off the scanner and workstation. 
The system is now ready to be stored. 



BodyTom 64 User Manual Revision 04 

 

Chapter 14    Cleaning and Storing the System and Workstation Specifications  Page 349 of 412  

See “Powering the workstation” on page 101. 

Note  It  is recommended practice that the scanner is plugged 
in and turned on even when it  is not in use.  

Storing the QA phantom 

Store the phantom in a secure location with easy access for the daily QA 
procedure. 

Workstation specifications 

Table 61: Workstation specifications 

Phase Single 

Voltage Range 100-240VAC ± 10% 

Factory Outlet 
Recommendations  

NEMA 5-20R NEMA 6-30R 

Frequency 50 or 60Hz 

Battery Capacity  
Fully Charged/ 
12 hrs. (Typical) 

Typical Usage  
110-120 VAC 60 
Hz 

230-240VAC 
50 Hz 

Wiring 
125V, 2 Pole, 3 
Wire Grounding 

250V, 2 Pole, 3 
Wire 
Grounding 

Battery Operat ing Voltage  51.8VDC 

Overall  width 41in. (104cm) 

Overall  height 79in. (199cm) 

Overall  length 101in. (256.5cm) 

Weight EST  3510 lbs. (1592kg) 

Battery power (2) 12 VDC 
(l ithium polymer) 

800W 

Max programmed speed fwd. 1.6 MPH 

Max recharge time ~ 8hrs. 

Max continuous operation  8hrs. 

Locking and unlocking cycles  20 

Hrs transport over f loors  2hrs. 

Hrs system locked no 
external power  

2hrs. 

Max slope holding angle with 
scanner 

7º C (44.6º F) 

Max doorway threshold  1in. (2.54cm) 
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Max elevator threshold  ¾in. (1.905cm) 

Height to locking adapter  8.59in. - 8.69in. 

Min/Max storage 
temperature  

-25º C to 70º C (-13º F to 158º F)  

Min/Max operating relative 
humidity  

20% to 80% (non-condensing) 

Min/Max storage relative 
humidity  

20% to 85% (non-condensing) 

Min/Max ambient operating 
temperature  

15º C to 35º C (59º F/95º F) 

Understanding the symbols and product-marking plate 

Table 62: Symbols  

Symbol  Description 

 Alternating current. 

 
Protective earth (ground). 

 

Functional Earth 

 
Caution: consult accompanying documents. 

 
Caution: risk of electrical shock. 

 
Electrostatic sensitive devices. 

 

Type B equipment 

 
X-ray warning 

 
 X-ray source assembly emitting 

 
Non-ionizing radiation 

 
Warning: laser in use 

 

Warning:  Laser Radiation Do Not Stare into 
Beam Class 2 Laser Product 

Laser Output and Standards Information Label 
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Warning: FDA Laser Information 

 
Warning: high temperature 

 
Emergency switch 

 
Crush warning 

 
Foot/toe crush warning when lowering machine 

 System up 

 System down 

 

Indicates temperature limits. 

 
Indicates mechanical deactivation device. 

 

Indicates a radiation precaution; may be 
affected by radiation from other sources; may 
produce interference that affects other 
equipment. 

 
Indicates a coil power cord. 

 

Indicates a chain hazard could cause severe 
personal injury. 

 
Keep away from rain for packaging. 

 
Humidity limit for packaging. 

 
Warning: battery charging. 

 Fuse usage. 

  

Refer to instruction in user manual/booklet   

 
Medical Device Symbol 

 
Legal Manufacturer Symbol 
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Intertek ETL (Edison Testing Laboratories) Mark  

 
European Authorized Representative Symbol 

 

CE Mark or Conformité Européenne ; number 
below CE represent Notified Body number 

Note  Disregarding information on safety is considered 
abnormal use .  
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Locating the product-marking plate on the workstation 

 

 
 Figure 397: Product-marking plate on side of the workstation 

Listing of replacement parts for workstation 

To ensure proper compliance requirements of replacement parts, (for 
example, cables and accessories), parts must be purchased through 
NeuroLogica Corp. 

 
WARNING Using other manufacturer cables and accessories may affect 

EMC performance.  Unauthorized use of these items will 
void warranty and may cause harm to patient, others and/or 
equipment. 
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Product Safety and Electromagnetic Comparability  

Tested by: Intertek Testing Services NA, Inc., 70 Codman Hill Road, 
Boxborough, MA 01719 
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Appendix A  Glossary  

A 

Algorithm  Mathematical filter applied to raw data 
during CT image reconstruction to remove 
blurring artifact inherent to back-projection.  
Also referred to as a kernel. 

Annotation  User comments or text added to an image. 

Anterior Front of the patient’s body 

Application Entity (AE) An end point of a DICOM information 
exchange, including the DICOM network or 
media interface software; that is, the 
software that sends or receives DICOM 
information objects or messages.  A single 
device can have multiple AEs. 

Attenuation The reduction in intensity of a radiation 
beam as it passes through a substance. 

Automatic Exposure Control 
(AEC) 

Software used to adjust or modulate the 
mA throughout an acquisition to reduce 
patient radiation dose to a minimum. 

Axial scan mode Data acquisition while the scanner remains 
stationary.  The scanner position may be 
incremented between exposures to collect 
data over a longer Z axis range.  Also 
referred to as step and shoot. 

B 

Bolus Tracking Monitors flow of contrast media in vessel 
and triggers scan at optimal timing.  This is a 
scanner feature to automatically initiate a 
prescribed Axial, Helical or Dynamic scan 
when a threshold level of contrast 
enhancement is reached at a specified 
region of interest. 

C 

Collimation Restricts x-ray to only the selected 
anatomy, minimizing dose to patient and 
reducing scatter. 
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Computed Tomography 
Angiography (CTA) 

A test that uses x-rays to provide detailed 
pictures of the heart and the blood vessels 
that go to the heart, lung, brain, kidneys, 
head, neck, legs, and arms.  A CT angiogram 
can show narrowed or blocked areas of a 
blood vessel. 

Computed Tomography 
Dose Index (CTDI) 

An approximate measure of the radiation 
dose received in a single CT section or slice. 

Computed Tomography 
Dose Index Volume (CTDIvol) 

Represents the dose for a specific scan 
protocol, which considers gaps and overlaps 
between the radiation-dose profiles from 
consecutive rotations of the x-ray source.  It 
is not patient dose.  The CT dose index 
volume is noted as CTDIvol.  It is reported in 
units of mGy.  The CTDIvol is based on 
measurements made by the manufacturer 
in a factory setting.  The CTDIvol is calculated 
differently for both the Axial and the Helical 
mode: 

For Axial scan mode:   CTDIvol = [(N x T)/I] x 
CTDIw. 

For Helical scan mode: CTDIvol = 1/pitch x 
CTDIw. 

See also dose and patient dose. 

Computed Tomography 
Dose Index (CTDIw) 
weighted average 

The measure of ionizing radiation exposure 
per slice of data acquisition.  CTDI 
represents the integrated dose along the Z 
axis from one axial CT scan (one rotation of 
the x-ray tube).  The CT Dose Index is noted 
as CTDIw. 

Computed Tomography (CT) 
number 

Relative value assigned to each pixel to 
quantify the attenuation occurring in each 
voxel in comparison with the attenuation of 
water.  The calculated CT number for a 
given pixel is given in Hounsfield units (HU). 

Computed Tomography 
Perfusion (CTP) 

Evaluates cerebral perfusion or level of 
blood flow in the brain by monitoring the 
initial passing of iodinated contrast media 
through the vasculature of the brain. 

Contrast media Used to improve sensitivity and specificity 
of clinical diagnoses.   



BodyTom 64 User Manual Revision 04 

 

Appendix A    Glossary Page 357 of 412  

Contrast resolution The ability of a CT system to detect an 
object with a small difference in linear 
attenuation coefficient from the 
surrounding tissue.  Also referred to as low-
contrast detectability or sensitivity. 

D 

Digital Imaging 
Communication in Medicine 
(DICOM) 

Digital Imaging and Communications in 
Medicine, or DICOM, is a standard that 
helps people doing work in the field of 
radiology.  The DICOM standard is designed 
to promote communication and integration 
between a variety of radiology imaging 
systems and equipment used in filmless 
radiology. 

Digital tilt The ability to correct the image post-
acquisition and correct positional 
inaccuracies prior to sending to PACS. 

Dose The generic term that refers to the CTDIvol, 
the standardized parameter to measure 
scanner radiation output – or the amount 
of amount of ionizing radiation absorbed 
by patient per unit mass. 

Dose Length Product (DLP) The measurement of dose for an entire 
series of CT images.  DLP is equal to the 
calculated dose per section multiplied by 
the length of a CT acquisition along the Z 
axis. 

Dynamic Host Control Protocol 
(DHCP) 

A standardized network protocol used on 
Internet Protocol (IP) networks.  The DHCP 
is controlled by a DHCP server that 
dynamically distributes network 
configuration parameters, such as IP 
addresses, for interfaces and services. 

Dynamic scan mode (multiple 
detector widths) 

Data acquisition at multiple time points 
over the same anatomic location(s). 
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E 
Electromagnetic 
Compatibility (EMC) 

The branch of electrical sciences that studies 
the unintentional generation, propagation, 
and reception of electromagnetic energy with 
reference to the unwanted effects 
(Electromagnetic interference (EMI)) that 
such energy may induce. 

Electromagnetic 
Interference (EMI) 

A disturbance generated by an external 
source that affects an electrical circuit by 
electromagnetic induction, electrostatic 
coupling, or conduction.  The disturbance may 
degrade the performance of the circuit or 
even stop it from functioning. 

F 

Field of View (FOV) The diameter of the acquired attenuation 
data displayed across the image matrix. 

H 

Helical scan mode 
 

A CT acquisition whereby an x-ray 
acquisition whereby the x-ray tube and 
scanner move continuously during 
scanning, yielding a data set in the form of 
a helix.  Also referred to as spiral. 

Hospital Information 
System/Radiology 
Information Systems 
(HIS/RIS) 

A Radiology Information System (RIS) is the 
core system for the electronic 
management of imaging departments.  The 
major functions of the RIS can include 
patient scheduling, resource management, 
examination performance tracking, 
examination interpretation, results 
distribution, and procedure billing.  RIS 
complements Hospital information systems 
(HIS) and Picture Archiving and 
Communication System (PACS) and is 
critical to efficient workflow to radiology 
practices. 

Hounsfield Unit (HU) The unit of the CT number scale assigned 
to each pixel to quantify relative 
attenuation. 
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I 

Interscan delay time Minimum amount of time that must 
transpire between end of one scan and 
initiation of next scan.  Interscan delay 
times include idle time between scans to 
allow tube cooling. 

Iterative Bone Correction 
(IBC) 

A feature build into the reconstruction 
software, which performs a correction on 
every single Axial image the scanner 
produces, including both primary series 
from a scan as well as secondary 
reconstruction images.  Current IBC 
settings were chosen to provide optimal 
correction for standard medical imaging; 
however, the setting can be customized as 
needed. 

K 

Kernel A mathematical filter applied to raw data 
during CT image reconstruction to remove 
blurring artifact inherent to back-
projection.  Also referred to as an 
algorithm. 

M 
mAs Tube current-time product: The product of 

tube current and exposure time per 
rotation, expressed in units of milliampere 
seconds (mAs). 

Matrix Two-dimensional (2D) grid numbers 
arranged in rows and columns. 

Maximum Intensity 
Projection (MIP) 

The multiplanar reformation technique 
that displays only the maximum pixel value 
along a ray traced through the object to 
the viewers assumed perspective in front 
of the scanner display screen. 

Mean Transit Time (MTT) A common measurement during CTP 
studies of the brain.  Refers to the average 
transit time, in seconds, needed for blood 
to pass through a given region of brain 
tissue. 
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milli amperage (mA) Tube current: the number of electrons 
accelerated across an x-ray tube per unit 
time, expressed in units of milliampere 
(mA). 

Modality Performed 
Procedure Step (MPPS) 

A mechanism for modalities to pass 
information about the imaging performed 
back to the HIS/RIS or PACS. 

Modality worklist manager Scheduled (but not yet scanned) patient 
list. 

motion artifact Voluntary and involuntary patient motion 
during CT scan, appearing as a streak 
artifact on image; ghosting or blurring of 
image. 

Multi-Planar Reformation 
(MPR) 

The process of displaying CT images in a 
different orientation from the one used in 
the original reconstruction.  Allows for 
reformation of images in planes that would 
otherwise be difficult or impossible to 
acquire with CT.  Requires only image data.  
Raw data is not utilized.   

N 

Noise Random statistical variations in the signal.  
Can be quantum noise, electronic noise 
due to lost signal, or artifact noise.  
Manifests itself as overall graininess of the 
reconstructed image. 

P 

Partial volume artifact Occurs when an object is only partly 
positioned within a voxel or is much smaller 
than the overall voxel volume.  The object’s 
attenuation is not accurately represented 
by the pixel value.  Overlapping 
reconstructions further reduce partial 
volume artifacts. 

Patient Browser, local 
database  

Where the already-scanned patient list is 
stored. 

Patient coordinates References are as follows: 
• X    left to right. 
• Y    anterior to posterior. 
• Z    head to feet. 
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Patient dose  The absorbed dose to a patient. 
See also CTDIvol. 

Peak kiloVoltage (kV) The penetrating power of the photons 
coming from the x-ray tube. 

Picture Archive and 
Communications Systems 
(PACS) 

Stores medical information, including 2D 
images, and 3D medical images.  All modern 
PACS setups will work with DICOM. 

Pitch In Helical mode, refers to the speed of the 
scanner movement over the table as the 
scanner rotates. 

Pixel A single, picture element of image matrix. 

Post reconstruction Prescribing the reconstruction parameters 
after scan acquisition. 

Projection View of anatomical cross-section from a 
particular vantage point. 

Prone Patient lying on stomach. 

Protocol Prescribes the acquisition and 
reconstruction parameters to be used for a 
scan.  

Q 

Quality Assurance (QA) Procedure of performing periodic specified 
tests or measurements to assure that a set 
quality level, as specified by system 
manufacturer, has not been compromised. 

R 

Radiation Safety Officer 
(RSO) 

The person within an organization 
responsible for the safe use of radiation and 
radioactive materials as well as regulatory 
compliance. 

Radio Frequency 
Interference (RFI) 

Also called Electromagnetic Interference 
(EMI), is an unwanted disturbance that 
affects an electrical circuit due to 
electromagnetic radiation emitted from an 
external source. 

Raw data A transmission measurement obtained by 
the detectors used to mathematically 
reconstruct the CT image. 

Reconstruction filter Used to ensure accurate anatomical 
reconstruction.  Also allows for either 
spatial resolution or low-contrast-resolution 
enhancement. 
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Region Of Interest (ROI) Provides a quantitative analysis of the 
Hounsfield values of a specific anatomic 
area.  A graphic outline in the shape of a 
circle is placed over an area on the image.  
Software calculates the average CT number 
in HU within the ROI. 

Resolution A scan time, per slice, in Axial mode, only.   

Retrospective reconstruction Reconstruction performed after the initial 
prospective reconstruction.  Multiple 
retrospective reconstructions of raw data 
are possible, with changes to display FOV, 
kernel, slice thickness etc.  

S 

Scan delay The time between the initiation of contrast 
agent administration and CT data 
acquisition.  The chosen scan delay 
determines the phase of contrast 
enhancement for a given CT acquisition. 

Scan protocol A list of scanner-load parameters used to 
perform an x-ray exposure. 

Scan types Axial, Helical, Dynamic, Reference, and 
Scout. 

Scout Digital survey radiograph acquired by the CT 
system for the purpose of prescribing the 
cross-sectional acquisition.  Like a 
conventional radiograph, the scout is 
produced by translating the scanner over 
the patient without tube or detector 
rotation.  Also referred to as topogram or 
scanogram. 

Series A set of images acquired in a scan. 

Size Specific Dose Estimate 
(SSDE) 

Not dose to any specific organ but rather 
the mean dose in the center of the scanned 
volume.  That is, SSDE is not the exact 
patient dose, as factors such as scan length 
and patient composition can differ from the 
assumptions used to calculate SSDE, for 
example conversion factors based on 
patient size provided to estimated patient 
dose for a patient of a particular size. 

Slice spacing (Spacing) The distance between the center of one CT 
slice and the center of the next slice. 
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Slice thickness The dimension of a constructed CT slice 
along the longitudinal direction of 
acquisition (Z axis). 

Spatial resolution The ability of a CT imaging system to display 
fine details, separately.  Given in units of 
line pairs per centimeter (lp/cm). 

Supine Lying on back. 

T 

Temporal resolution The ability of a CT system to freeze motion 
and provide an image – free of blurring. 

Test Bolus Scan mode used to measure the contrast 
transit time using a small injection of 
contrast media. 

Threshold The CT number (Hounsfield Unit (HU)) 
where Bolus Tracking tool will trigger the 
system to begin the scan. 

Time Attenuation Curve 
(TAC) 

A graph of the contrast enhancement 
versus time.  TAC is used to determine 
blood flow rate in seconds for contrast 
timing. 

Time delay Monitoring delay: Time from injection to 
the start of monitoring scans. 

Transverse plane Perpendicular to direction of Z axis. 

V 

Volume Rendering (VR) 
image or object 

A 3D modeling technique that utilizes the 
entire acquired dataset but adjusts the 
opacity of the voxels included in the 3D 
image according to their tissue 
characteristics. 

Voxel Abbreviation of volume element.  Refers to 
the volume of tissue represented by a pixel 
in the matrix used to display the CT image. 

W 

Window Center (WC) The pixel value given in Hounsfield Units 
(HU) at the center of the window width.  
Window Center controls the brightness 
(density) of the CT image. 
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Window Width (WW) The range of pixel values assigned a shade 
of gray in the displayed CT image.  Window 
width controls the contrast of the CT 
image. 



BodyTom 64 User Manual Revision 04 

 

Appendix B    Listing of All Buttons, Tools, and Icons Page 365 of 412  

Appendix B  Listing of All Buttons, Tools, and Icons  

Status bar icons 

Table 63: Status bar icons 

Status bar 
icon 

Status bar icon 
name 

Status descript ion  

 
X-ray status 

Identifies x-ray as on or off. 
The icon changes from a 
gray/black icon when x-ray is off 
to a rotating yellow/black icon 
when x-ray is on. 

 
System state 

Identifies the system’s current 
state. 
The orb changes color 
depending on the state the 
system is in. 
See Table 26 on page 114 for a 
list of the different orb colors 
and system states they identify. 

 
Scanner position 

Identifies the system’s current 
position relative to its zero 
reference.  

 

System E-STOP 
status 

Identifies when E-STOP is 
engaged.  The icon will flash 
when E-STOP is pressed. 
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Status bar 
icon 

Status bar icon 
name 

Status descript ion  

 

System tube heat 
status 

Indicates the current X-Ray tube 
heat status. The values are color 
coded as follows: 
Blue          0% - 19% 
Yellow         20% - 50% 
Orange        51% - 75% 
Red          76% - 100% 
 
NOTE: The scanners tube heat 
must be below 20% before the 
scanner powers down. If the 
tube is too hot, a message will 
display on the LCD scanner 
control panel instructing you to 
wait until the tube heat is low 
enough to safely power off the 
scanner. 

 

Scanner battery 
capacity status 

Indicates the remaining scanner 
battery percentage available. The 
capacity values are color coded 
as follows:  
Green           100% - 51% 
Yellow          50% - 25% 
Red               24% - 0% 

 
System air 
freshness status 

Indicates the air freshness status; 
it is recommended that an air 
calibration be performed:  

• Every eight (8) hours. 

• When the air freshness 
status falls below 50%. 

• If the scanner is moved to an 
area with a dramatic change 
in humidity and/or 
temperature. 

The calibration status values are 
color coded as follows: 
Green          100% - 51%  
Yellow         50% - 25%  
Orange        24% - 0%   

After calibration it returns to 
100%. 
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Status bar 
icon 

Status bar icon 
name 

Status descript ion  

 

Workstation 
battery capacity 
status 

Indicates the remaining 
workstation battery capacity 
available. The capacity values are 
color coded as follows:  
Green           100% - 21% 
Yellow          20% - 11% 
Red           10% - 0% 

You will be prompted to plug the 
workstation into an outlet to 
charge if the battery capacity is 
low; a scan cannot complete 
when the battery capacity is 10% 
or lower.  

When the workstation reaches 
the red capacity range, the 
system will shut down.  A 
message informs you that the 
system will shut down due to low 
battery. 
The lightning bolt icon signifies 
that the workstation is currently 
charging and goes away when 
unplugged. 

 
Image storage 
space status 

Indicates the available disk space 
for image storage. The available 
space values are color coded as 
follows: 
Green           100% - 51%  
Yellow           50% - 20%  
Red           19% - 0% 

 

 

System state orbs 

Table 64: System state orbs 

Orb Color State  

 
Dark gray The system is in an unknown state. 
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Orb Color State  

 
Light gray The system is powering up or down. 

 
Dark purple The system is busy. 

 
Purple The system is completing air calibration. 

 
Light purple The system is archiving. 

 
Blue The system is idle. 

 
Green The system is ready to perform a scan. 

 
Light yellow The system is planning. 

 
Dark yellow The system is preparing. 

 
Light orange The system is reconstructing. 

 
Dark orange The system is scanning. 

 
Pink The system is not ready. 

 
Red The system is in fault. 

Workstation buttons 

Table 65: BodyTom 64 workstation buttons 

Workstation 
button 

Action  

 

In Protocol Manager – adds a new protocol from 
the list. 

 

In Patient Browser – selects the archive destination 
for selected information. 



BodyTom 64 User Manual Revision 04 

 

Appendix B    Listing of All Buttons, Tools, and Icons Page 369 of 412  

Workstation 
button 

Action  

 
In Patient Browser – used to begin a protocol. 

 

In Protocol Manager – used to create a new 
protocol from a previously saved protocol.  

 

In Patient Browser – generates the dose for the 
selected patient. 

 

In Patient Registration – cancels the current query.   
In Patient Browser – cancels any series being 
imported.  

 

In Acquisition – cancels the entire exam being 
performed. 

 

In Acquisition – cancels the current scan within a 
protocol. 

 

In System Configuration – clears information in 
fields. 

 

In Protocol Manager – closes popup. 
In Store/Print Queue – closes the Store/Print 
Queue popup. 
In System Configuration – closes System or User 
Configuration dialog boxes. 

 

 In Patient Browser – allows you to select multiple 
series of patient images to compare in Viewing.  

 

In Acquisition – authorizes the scanner to move to 
the next step.  

 

In Patient Registration – deletes patient(s) from the 
Stored Results list. 
In Patient Browser – deletes selected exam 
information from Patient Browser. 
In Store/Print Queue – deletes a series to be stored 
or a series that failed to store. 
In Protocol Manager – deletes a saved protocol. 
In System Configuration – clears a saved dose 
setting to remove the restriction. 
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Workstation 
button 

Action  

 

In System Configuration – deletes saved dose 
settings to remove all restrictions.  

 

In Store/Print Queue – when you select one or 
more series, displays an explanation of why a series 
failed to store. 

 

Move selected item down the list. 

 
In Patient Registration – used to modify protocols. 

 

In System Configuration under DICOM Servers – 
echoes the selected server to test the connection. 

 

While in Interventional Mode, exist the system from  
the Instant Repeat Feature. 

 

In Protocol Manager – exports protocols to a media 
device. 

 

In Acquisition – completes the examination.  
Completes all protocols, builds Dose SR and images, 
and directs user to Patient Browser. 

 

In Viewing - generates a new series with the Series 
Description field information – based on the 
selected MPR. 

 

In Patient Browser – imports the exam information 
from PACS or Media. 
In Protocol Manager – imports previously exported 
protocols to the workstation. 

 

Performs a 38.4mm axial scan at the current 
scanner location while in the Interventional Mode 

 

In Patient Registration – manually enters a new 
patient and, when completed, takes you to the 
Acquisition tab to acquire the data for a scan. 

 

In Patient Browser – used to select the destination 
for patient data to media. 



BodyTom 64 User Manual Revision 04 

 

Appendix B    Listing of All Buttons, Tools, and Icons Page 371 of 412  

Workstation 
button 

Action  

 

In Patient Browser – minimizes the Import for 
Media popup. 

 

While in Interventional Mode, move the scanner to 
the last scanned position and performs a 38.4mmm 
axial scan. 

 

In Protocol Manager – used to create a new 
protocol. 

 
To accept the selections you make. 

 

In Patient Browser – used to select the destination 
for patient data to PACS. 

 

In Patient Browser – used to select only patient 
information for a patient when using Register 
feature. 

 

In Patient Browser – used to select all exam 
information for a patient when using Register 
feature. 

 

In Store/Print Queue – when you select one or 
more series, temporarily stops the series from being 
stored.  This is a toggle button with the Resume 
button. 

 
In Acquisition – pauses entire protocol. 

 

In Acquisition – pauses current scan within a 
protocol. 

 

In System Configuration under Audio Configuration 
– used to play audio files. 

 

For Quality Assurance – used to prepare 
workstation to run a Quality Assurance test. 

 

In Acquisition – selects an existing protocol for the 
current study. 
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Workstation 
button 

Action  

 

In Patient Registration – searches the HIS/RIS 
server for scheduled patients.   

 

In Patient Registration – registers the selected 
patient and then takes you to the Acquisition tab to 
acquire the data for an examination (scan). 
In Patient Browser – opens the Create New Study 
dialog box and moves selected patient to 
Acquisition. 

 

In Patient Registration – used to take patient 
information stored in HIS/RIS server to Patient 
Registration to choose the patient and study. 

 

In Acquisition – repeats the last scan that was 
performed. 

 

In Post Reconstruction, sends the last acquired scan 
from the recon workstation to the Patient Browser. 

 

In Viewing – reverts all images back to original 
state. 
In System Configuration – resets information back 
to default or clears information in fields. 

 

In Store/Print Queue – when you select one or 
more series, continues to store previously paused 
series.  This is a toggle button with the Pause 
button. 

 

In Store/Print Queue – when you select one of 
more series, tries to archive the selections. 

 

In System Configuration – saves updated 
information. 

 

In Patient Registration – searches queried patient 
entries for specific information. 

 

In Patient Browser – shows patient, study, series, 
and image information; used to modify series 
scanned under a wrong patient. 

 

For Daily Calibration – begins the daily (air) 
calibration. 
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Workstation 
button 

Action  

 

In Acquisition – begins any post-reconstructions 
that were defined during the protocol setup. 
In Post Recons – begins a manual reconstruction 

 

In System Configuration under Audio Configuration 
– stops audio files from playing. 

 

In Patient Registration – selects patient(s) from 
query results and moves them into the Stored 
Results list. 

 

In System Configuration under User Accounts – 
used by administrators to unlock a user’s account. 

 
Move selected item up the list. 

 

In Protocol Manager – updates information on an 
existing protocol. 
In System Configuration – updates information. 

 

In Acquisition – prompts the application to send the 
selected protocol to the scanner and verify that the 
scanner has tube and battery capacity to perform 
the protocol. 

 

In Patient Registration – shows selected patient 
details. 
In System Configuration – shows information. 

 
In Viewing – to load and views images. 

Viewing tools  

Table 66: Viewing tools 

Tool Tool name Action  

 

Angle 
2D, CTP, and Viewing tool – draws 
an angle on the image and 
displays the angle information. 

 

Arrow 
2D, CTP, and Viewing tool – draws 
an arrow on the image, which can 
be repositioned. 
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Tool Tool name Action  

 

Calculate CBF, 
CBV, MTT Map 

CTP only tool – calculates the 
Cerebral Blood Flow (CBF), 
Cerebral Blood Volume (CBV) and 
Mean Transit Time (MTT) maps. 

 

Clear 
Perfusion Map 

CTP only tool – cancels the 
calculations and returns to 
Calculation mode. 

 

Capture 
Common tool - saves a screen 
capture of selected viewport. 

 

Capture all 
Viewports 

Common tool - saves screen 
captures of all visible viewports. 

 

Cine Reverse 
2D only tool – cines backward 
through the images. 

 

Cine Forward 
2D only tool – cines forward 
through the images. 

 

Clear Active 

Common tool (Acquisition, Post 
Reconstruction, Viewing) - resets 
the tool to the default pointer 
device. 

 

Field Of View 
Post Reconstruction tool – adjusts 
the Field Of View (FOV) prior to 
reconstruction. 

 

Flip Horizontal 
2D only and Viewing tool – flips 
images right or left. 

 

Flip Vertical 
2D only and Viewing tool – flips 
images up or down. 

 

Invert 
Common tool (Viewing) - inverts 
black to white and white to black. 

 

Load 
Viewing tool – loads images from 
selected series into viewing. 

 

Measure (Line) 
2D, CTP, and Viewing tool – draws a 
line on the image and displays 
length information. 
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Tool Tool name Action  

 

Pan 

Common tool (Acquisition, Post 
Reconstruction, Viewing) - click 
and move pointer over image.  
Left click and hold down the 
mouse button and drag the image 
in the chosen direction.  Release 
mouse button to position image in 
new location. 

 
Peak Image 

CTP only tool – displays the image 
that has the most visible contrast 
(based on arterial ROI placement). 

 

Perfusion 
Artery/Vein 
Selection 

CTP only tool – selects the artery 
and vein to be used for performing 
perfusion calculations. 

 

Redo 

Axial and Helical Viewing tool – 
restores the last text editing or 
resizing and positioning of controls 
– if no other action occurred since 
last time the Undo button was 
clicked. 

 

Redo 

Viewing tool – performs the most 
recent action, again.  The button is 
disabled if the application cannot 
redo the application. 

 

Region of 
Interest (ROI) 

2D, CTP, and Viewing tool – defines 
a circular ROI and displays the ROI 
information (5mm diameter by 
default). 

 

Reset 
Post Reconstruction and 
Acquisition tool – resets the 
display to default viewer settings. 

 

Reverse Image 
Stack 

2D only and Viewing tool – 
reverses the order in which 
images display. 

 

Rotate 
MPR only and Viewing tool – 
rotates the image. 

 

Scan Region 
Re-Draw 

Acquisition tool – if scout lines 
and the scan region is deactivated, 
allows you to reactivate. 
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Tool Tool name Action  

 

Show 
Artery/Vein 
Flow Graph 

CTP only tool – displays the 
Arterial Venous Flow graph. 

 
 

 

Stop 

Post Reconstruction tool – cancels 
the current, post-reconstruction 
request.  All images are generated 
until you click the Stop button. 

 

Stop Cine 2D only tool – stops the cine loop. 

 

Text 
(Annotation) 

2D only and Viewing tool – 
creates text box for annotation. 

 

Tilt 
MPR only tool – corrects a rotated 
image. 

 

Toggle Layout 
Acquisition tool – changes the 
layout to 2x2.  Repeat process to 
return to 1x1. 

 

Toggle Scouts 
Acquisition tool – removes scouts 
from Acquisition. 

 

Undo 

Axial and Helical Viewing tool – 
reverses the most recent action 
taken (a successful copy, cut, 
delete, undo or paste action). 

 

Undo 

Viewing tool – removes the most 
recent action performed on 
image.  The workstation 
remembers the last five 
adjustments made.  The tool is 
disabled if the workstation cannot 
redo the adjustment. 
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Tool Tool name Action  

 

 Window 
Width/Center 

Common tool (Acquisition, Post 
Reconstruction, Viewing) – click 
and move pointer over image.  
Left click and hold the mouse 
button and drag in chosen 
direction to adjust Window Width 
and Window Center.  Width and 
center values appear in the 
Width/Center status display. 
A pre-defined width/center setting 
can also be selected. 
Select the preset from the 
dropdown list below the 
Windowing Preset button. 
Width and center presets can also 
be saved or deleted. 

 

Zoom 

Common tool (Acquisition, Post 
Reconstruction, Viewing) - click 
and move the pointer over the 
image.  Left-click the mouse and 
hold down the left-mouse button 
and move in upward direction to 
zoom in (enlarge) and downward 
to zoom out (shrink). 
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Table 67: Pendant buttons 

Pendant  Button Descript ion  Action 

 

 
POWER 

Illuminates when 
power is supplied to 
pendant. 

 

LASER 

Turns on all three 
positional lasers.  
While the lasers are 
on, the scanner spins 
for the internal laser 
to be seen within the 
scanner opening. 

 

GO TO SCAN 
PLANE 

Moves the scanner 
forward 
approximately 30cm.  
This is the distance 
between the internal 
and external lasers. 

 

ZERO 
REFERENCE 

Sets the scanner to 
zero before starting a 
scout or a scan. 

 

MOVE 
BACKWARD 
(slow) 

Pressing and holding 
moves the scanner 
backward 10mm per 
second. 

 

MOVE 
FORWARD 
(slow) 

Pressing and holding 
moves the scanner 
forward 10mm per 
second. 

 

MOVE 
BACKWARD 
(fast) 

Pressing and holding 
moves the scanner 
backward 60mm per 
second. 

 

MOVE 
FORWARD 
(fast) 

Pressing and holding 
moves the scanner 
forward 60mm per 
second. 

 

SET 
MEMORY 

Allows the user to 
program Scan and 
Rest positions for the 
scanner. 
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SCAN 
POSITION 

Moves the scanner to 
the Scan Position 
saved using the Set 
Memory feature.  

 

REST 
POSITION 

Moves the scanner to 
the Rest Position 
saved using the Set 
Memory feature.  
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Appendix C  Sample of Reference Protocols 
Provided  

Table 68: Sample of BodyTom 64 adult protocols and important estimates 

P r o t o c o l  
N a m e  

T y p e  k V  m A  
S l i c e  

T h i c k n e s s
/ S p a c i n g  

S h a r p n e s s  R e s o l u t i o n  C o v e r a g e  
C T D I v o l  
( m G y )  

D L P 4 
( m G y . c m )  

Adult Head 
Axial 

Axial 120 200 4.8 x 4.8 Soft Tissue 1 Sec. 250 47.32 1183 

C-Spine Helical Helical 120 250 1.2 x 1.2 
Soft Tissue - 

Abdomen 
Pitch = 0.8 400 24.16 966.4 

Adult Chest 
Helical 

Helical 120 150 1.2 x 1.2 Bone Pitch =0.8 450 14.49 652.05 

Adult 
Abdomen 
Helical 

Helical 120 250 2.4 x 2.4 
Soft Tissue - 

Abdomen 
Pitch = 0.8 500 24.16 1208 

Table 69: Sample of BodyTom 64 pediatric protocols and important estimates 

P r o t o c o l  
N a m e  

T y p e  k V  m A  
S l i c e  

T h i c k n e s s
/ S p a c i n g  

S h a r p n e s s  R e s o l u t i o n  C o v e r a g e  
C T D I v o l  
( m G y )  

D L P 5 

( m G y . c m )  

Pediatric Head 
Axial 

Axial 100 175 4.8 x 4.8 Soft Tissue 1 Sec. 200 32.02 640.4 

 

 

4 DLP is based on length from coverage column 

5 DLP is based on length from coverage column 
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Appendix D  Automatic Exposure Control  

1 Introduction: 

Automatic Exposure Control (AEC) is a feature which allows the 
exposure to automatically be modified based on the attenuation of the 
scanned object. The main objective of AEC is to optimize the x-ray 
current based on prior knowledge of the scanned objects profile. AEC is 
used to optimize patient exposure while attempting to maintain 
acceptable diagnostic quality of the reconstructed images. 

AEC uses image noise to optimize the scan current. The image noise on 
CT scanners can be traced to two sources: Electronic Noise and 
Quantum Noise. Electronic Noise is generated by the electronic 
components of the Data Acquisition System (DAS). Quantum Noise is 
related to x-ray generation. Currently Quantum Noise is the major 
component of noise on CT images, the contribution of Electronic Noise 
has become less significant since the early days of CT scanners. 

2 Image Noise:  

2.1 Electronic Noise: 

 

The DAS is composed of the crystals, the photodiodes, the Analog to 
Digital Convertors (ADC) and other electronic components known as 
“converter cards” since they convert x-rays into a quantifiable current.  

Thermal Noise is the most common source of electronic noise in the CT 
system.  As the scanners internal temperature increases thermal noise 
becomes the dominant component of the DAS’s electronic noise.  
Imperfections in the semiconductor chips used in the DAS also 
contribute to the Electronic Noise. However, with the advance in 
semiconductor crystals this has become less relevant. Currently 
Electronic Noise has no significant impact on image quality when using 
proper scan parameters, i.e., scan voltage, current and exposure. 

 

2.2 Quantum Noise: 

 

The generation of x-ray photons can be described by a Poisson random 
process. Poisson random processes are used to describe event 
generation over a fixed time interval. A Poisson random process is used 
to describe Queues in general. In a queue the number of new arrivals to 
the queue over a fixed time interval follow a Poisson distribution.  
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The Quantum Noise is related to the standard deviation of the Poisson 
distribution which inversely proportional to the square roots of the 
number of events: 

 
Where σ is the image noise and N is the number of detected photons. 
The above equation can help relate the image noise to the scan current, 
I, the scan time, t, and the slice thickness, Sw, since the number of 
photons is proportional to either one: 

𝑁  ∝ 𝐼𝑡  𝑎𝑛𝑑 𝑁   ∝ 𝑆𝑤 

The image noise of a given scanner can be written as a function of the 
scan parameters: 

 
To reduce the image noise, we can either increase the scan current, the 
scan time or the slice width, or any combination thereof.  K is constant 

that is dependent on the image reconstruction process. It follows, for 

two different scan currents I1 and I2 over the scan times t1 and t2 and 
using the same slice thickness, the image noises for the two scans can 
be related using the following equation: 

 

The same relation exists between the image noise and the slice thickness 

 
As a result, doubling the slice thickness can reduce the image noise by 
almost 40%. Figure 1 shows the Noise as a function of the scan current 
(left) and the inverse of the scan current (right). The scan done for the 
same slice thickness of 2.5 mm and same scan time of 1 second. 
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3 AEC working instructions: 

3.1  AEC input parameters:  

AEC requires three different input parameters: Minimum mA, 
Maximum mA, and the Noise Level. 

Minimum mA: The Minimum mA is set to prevent an unacceptable 
amount of noise in the reconstructed images.  

Maximum mA: The Maximum mA value is used to prevent over-
exposure of the patient being scanned. This is typically set to reduce the 
chances of over exposure which may lead to radiation sickness. 
However, in the case of the BodyTom 64, the maximum scan current is 
set to protect the x-ray tube. 

The noise level: The first step of AEC is to build an equivalent stack of 
cylindrical water phantoms or Water Equivalent Diameter (WED). The 
WED is created based on the measured attenuation from the scout. The 
noise level represents the noise in each section of the stack of water 
equivalent phantoms. The selected noise level should be within an 
acceptable range, and it should be dictated by the scan protocol. 

One of the key features of the scanners AEC is the ability the user has to 
re-adjust the noise level based on the estimated mA until the desired 
mA profile is attained. The feature works as follows: 
 
1. A protocol is created with the AEC feature enabled, and a 

Minimum mA, Maximum mA, and Noise Level are defined.  
 
2. The above-mentioned protocol is used to create a Scout 

image.  
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3. The user can toggle the AEC graph to view the scan current profile. 
The profile will be overlayed on top of the scout. 

 
4. If the scan current profile is acceptable, then the user will initiate 

the diagnostic scan as desired.  
 
5. If the scan profile is not acceptable, the user can adjust the noise 

level and recalculate the scan current. 
 

6. The process can be repeated as many times as needed until the user 

is satisfied with the current profile. The AEC tool will allow the user 

to view the scan current before initiating the actual scan. 

3.2  The scan parameters:  

The scan protocol parameters are not needed for AEC however 
they do affect the current estimation: 

1. kV: the scan kV is used to select the appropriate noise table used 
for estimating the scan mA. 

 
2. Slice Thickness: The noise is measured at a slice thickness of 5.0 

mm; however, the scan protocol slice thickness can be any of the 
allowable thickness values. The selected slice thickness is then used 
to adjust the noise table using the equation in section 2.2. The 
entire noise table will be multiplied by the square root of the slice 
thickness ratio. The multiplication factor is: 

 
3. The reconstruction kernel: The noise image depends on the 

reconstruction kernel.  AEC is limited to SoftTissue and PostFossa 
Kernels. AEC will be disabled if the user selects a different 
reconstruction kernel. 

3.3  Notes 

When AEC is selected the user should be aware of: 

1. Patient Positioning: The patient should be properly positioned as 
close as possible to the scanner iso-center. Failure to do so can 
lead to an over-estimate of the scan current leading to an increase 
in patient dose. 

2. Presence of metal implants: AEC should not be used if the patient 
has metal implants in the region to be scanned.  
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3. The measured noise: the final noise in the image depends on the 
size of the scanned patient. AEC assumes that the patient is 
cylindrical, as such the measured noise level could be different 
then the selected noise level. 

 
4. Anatomical features: AEC should be used when the region to be 

scanned includes significant differences in attenuation, such as 
the chest and abdomen.  Anatomical regions with slight 
differences in attenuation like the head, will not benefit from AEC 
use.  

 

3.4  Sample protocols:  

Below are some suggested protocols. The noise levels depend on the 
size and weight of the patient. The noise levels in the table below are 
for illustration purposes. The site physicist and CT manager should 
dictate the final noise levels. 

 

 Noise Level Minimum mA Maximum MA Slice thickness 

Chest scanning 15 50 250 1.2 

Chest/Abdomen 13 50 280 2.4 

 

4 AEC algorithm description:  

AEC uses the measured attenuation of the scanned object and the 
selected noise level to estimate the scan current at each planned scan 
location during the scan. The mA is typically estimated using different 
water phantom diameters.  

 

The BodyTom 64 uses Z-modulated AEC where each planned scan 
location is modeled using a cylindrical water phantom, or WED. The 
WED is calculated using the scout profile.  Once the WED is estimated 
a specific mA value is assigned to each planned scan location.  The 
Flowchart (Figure 2) below describes the basic steps for using AEC: 

 
1. Select the appropriate AEC parameters to be used, those 

values are: 
a. Minimum mA 
b. Maximum mA 
c. Noise Level 

 
2. Acquire a Scout using the same kV that will be used for the 

Axial or Helical acquisition.  



BodyTom 64 User Manual Revision 04 

 

Appendix D    Automatic Exposure Control Page 386 of 412  

a. An AP or Lateral Scout can be used; however, AP scouts are 
preferred.  

 
3. For each planned slice, the system calculates the WED and 

assigns a specific mA value to that location.  Figure 3 shows 
the WED of the equivalent water phantoms as calculated 
based on the scout image (left). The estimated diameters 
(right) shows that the water portion of the phantom match 
the true diameter of the phantom. 

 
4. Using the measured noise in different diameters water 

phantoms at different mA levels, find the mA that 
generates the selected noise level. 

 
5. Adjust the mA based on the scan mode.  Figure 4 shows 

the estimated mA as well as the adjusted mA for the axial 
scan mode. 
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5 The Noise measurements:  

The noise tables used for predicting the scan current is measured for 
each scan voltage. For each scan voltage the noise is measured using a 
set of predefined scan currents of 50, 100, 150, 200, 250 and 300 mA. 
The noise is measured using different water phantoms. In our case we 
have used 150, 200 and 300-mm water phantoms.  Table 70 shows a 
sample of the noise table at 120 kV.  

Table 70: The measured noise at 120 kV 

Phantom 
Diameter 
(mm) 

Scan 
Currents 

(mA) 

50 100 150 200 250 300 

100 7.5868 5.4078 4.4009 3.8519 3.4769 3.1679 

150 10.76 7.6690 6.2493 5.4768 4.8741 4.4806 

200 17.41 12.3721 10.1349 8.8315 7.8699 7.1964 

250 28.400 20.2000 16.4000 14.3000 12.7000 11.6000 

300 49.952 35.6299 28.7523 24.9660 22.3726 20.2553 

 

For example, if we desired to determine scan current in a 175mm water 
phantom that has 10 HU noise at 120 kV using the above table. The 
Noise is modeled using a 2-dimensional function of the current and the 
scan current. The scan current is then extracted from the 2D model. The 
noise is measured using a nominal slice width, typically 5.0 mm. The 
noise table will then be normalized based on the selected slice thickness 
of the scan protocol. 
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Appendix E  Rotating Anode X-Ray Tube  

 

 



BodyTom 64 User Manual Revision 04 

 

Appendix E    Rotating Anode X-Ray Tube Page 390 of 412  
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Appendix F  Error Code  

Table 71: Error code list 
Error 
code  

Error code 
description  

Popup description  Cause  

0 ABORT_EXAM 

Exam has been aborted.  Please 
try again.  If problem persists, 
contact customer service with 
code: 

Generic message whenever 
a scan/exam has been 
terminated 
abnormally.  User would 
not typically see this 
because a more specific 
error should be posted. 

1 
CAN_DEVICE_DISCON
NECT_CENT1 

Communications fault.  Please 
contact customer service with 
code: 

Cannot communicate with 
centipede 1 device. 

2 
CAN_DEVICE_DISCON
NECT_CENT2 

Communications fault.  Please 
contact customer service with 
code: 

Cannot communicate with 
centipede 2 device. 

3 
CAN_DEVICE_DISCON
NECT_ROTATE 

Communications fault.  Please 
contact customer service with 
code: 

Cannot communicate with 
rotate device. 

4 
CAN_DEVICE_DISCON
NECT_BIB 

Communications fault.  Please 
contact customer service with 
code: 

Cannot communicate with 
BIB device. 

5 
CAN_DEVICE_DISCON
NECT_OIB1 

Communications fault.  Please 
contact customer service with 
code: 

Cannot communicate with 
OIB1 device.  Note that this 
alone will not cause a Fault 
state but Start and Cancel 
buttons on one side of 
scanner will not operate. 

6 
CAN_DEVICE_DISCON
NECT_OIB2 

Communications fault.  Please 
contact customer service with 
code: 

Cannot communicate with 
OIB2 device.  Note that this 
alone will not cause a Fault 
state but Start and Cancel 
buttons on one side of 
scanner will not operate. 

7 
CAN_DEVICE_DISCON
NECT_POWER 

Communications fault.  Please 
contact customer service with 
code: 

Cannot communicate with 
CCB device. 

8 
CAN_DEVICE_DISCON
NECT_TRANS 

Communications fault.  Please 
contact customer service with 
code: 

Cannot communicate with 
Transport device. 

9 
CAN_DEVICE_DISCON
NECT_DCB 

Communications fault.  Please 
contact customer service with 
code: 

Cannot communicate with 
DCB device. 
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Error 
code  

Error code 
description  

Popup description  Cause  

10 
CAN_DEVICE_DISCON
NECT_HVG 

Communications fault.  Please 
contact customer service with 
code: 

Cannot communicate with 
HVG device. 

11 
HVG_LATCH_ERROR_
ENABLE 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

There was a problem with 
x-ray Enable signal. 

12 
HVG_LATCH_ERROR_
INTERLOCK 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

An interlock condition was 
asserted. 

13 
HVG_LATCH_ERROR_
110_TIMER 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

The 110% timer has 
expired and forced x-rays 
off. 

14 
HVG_LATCH_ERROR_
XRT_THERM_SW 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

X-ray tube thermal switch 
asserted. 

15 
HVG_LATCH_ERROR_
HE_FLOW_SW 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

Heat exchanger flow switch 
asserted. 

16 
HVG_LATCH_ERROR_
WDT 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

The watchdog timer has 
timed out and forced x-rays 
off (WD timer is controlled 
by the DCB firmware), this 
error would be unusual. 

17 
HVG_LATCH_ERROR_
ARC_FAULT 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

Arcs occurred. 

18 
HVG_LATCH_ERROR_
HVG_FAULT 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

A generic HVG fault 
condition occurred (look at 
HVG_ERROR_ code). 

19 
HVG_LATCH_ERROR_
STARTER 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

Anode (starter) device 
reported and error. 

20 
HVG_LATCH_ERROR_
DAS_OVER_RANGE 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

DAS (detector) data values 
are out of range. 
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Error 
code  

Error code 
description  

Popup description  Cause  

21 
HVG_ERROR_MA_RE
GULATION 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

There was a problem with 
mA regulation. 

22 
HVG_ERROR_KV_REG
ULATION 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

There was a problem with 
kV regulation. 

23 
HVG_ERROR_ANODE
_STARTER 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

Anode (starter) device 
reported and error. 

24 
HVG_ERROR_INV_OV
ER_TEMP 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

Inverter over temp 
condition. 

25 
HVG_ERROR_UNCO
MMANDED_EXP 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

An exposure happened 
without being commanded. 

26 
HVG_ERROR_ANODE
_OVER_VOLTAGE 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

Anode over voltage 
condition. 

27 
HVG_ERROR_CATHO
DE_OVER_VOLTAGE 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

Cathode over voltage 
condition. 

28 
HVG_ERROR_ANODE
_OVER_CURRENT 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

Anode over current 
condition. 

29 
HVG_ERROR_CATHO
DE_OVER_CURRENT 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

Cathode over current 
condition. 

30 
HVG_ERROR_FILAME
NT_OVER_CURRENT 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

Filament over current 
condition. 

31 
HVG_ERROR_ARC_DE
TECTED 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

Arcs occurred. 
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Error 
code  

Error code 
description  

Popup description  Cause  

32 

HVG_ERROR_CURRE
NT_RET_WIRE_DISCO
N 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

Current return wire 
disconnect. 

33 
HVG_ERROR_MA_OV
ER_PROG 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

The actual mA was higher 
than programmed. 

34 
HVG_ERROR_KV_OVE
R_PROG 

High voltage fault.  Please retry 
task.  If problem persists, please 
contact customer service with 
code: 

The actual kV was higher 
than programmed. 

35 
HVG_ERROR_FILAME
NT_REGULATION 

High voltage failure, retry 
protocol, if problem persists 
contact customer service with 
code 

There was a problem with 
filament regulation. 

36 
DCB_ERROR_BAD_DE
TECTORS 

Data acquisition fault.  Please 
contact customer service with 
code: 

DCB reported a bad 
detector condition. 

40 

RECON_PROTOCOL_R
EJECTED_INVALID_PR
OTOCOL_TYPE_OR_U
SAGE_PARAMETER 

Recon Protocol Rejected due to 
invalid Type or Usage 
parameter 

Recon rejected protocol 
because of invalid 
parameters. 

41 

RECON_PROTOCOL_R
EJECTED_INVALID_PR
OTOCOL 

Recon Protocol Rejected due to 
invalid Protocol 

Recon rejected protocol 
because of invalid 
parameters. 

42 

RECON_PROTOCOL_R
EJECTED_INVALID_PR
OTOCOL_IMAGE_CO
ODINATES 

Recon Protocol Rejected due to 
invalid Image Coordinates 

Recon rejected protocol 
because of invalid 
parameters. 

43 

RECON_PROTOCOL_R
EJECTED_INVALID_PR
OTOCOL_ROI_COODI
NATES 

Recon Protocol Rejected due to 
invalid ROI Coordinates 

Recon rejected protocol 
because of invalid 
parameters. 

44 

RECON_PROTOCOL_R
EJECTED_HELICAL_Q
A_FAILED 

Recon Protocol Rejected due to 
Helical QA Failure 

Recon rejected protocol 
because of invalid 
parameters. 

45 

RECON_PROTOCOL_R
EJECTED_RECON_BU
SY 

Recon Protocol Rejected due to 
Recon Busy  

Recon is in an invalid state 
to perform a protocol. 

46 

RECON_PROTOCOL_R
EJECTED_SERIAL_LIN
K_DISCONNECT_OCC
URRED 

Recon Protocol Rejected due to 
Serial Link Disconnect 

Recon rejected protocol 
because the serial link is 
not connected. 
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Error 
code  

Error code 
description  

Popup description  Cause  

47 

RECON_PROTOCOL_R
EJECTED_INSUFFICIE
NT_MEMORY 

Recon Protocol Rejected due to 
Insufficient Memory 

Recon rejected protocol 
because of insufficient 
memory necessary to 
perform requested 
protocol. 

48 

RECON_PROTOCOL_R
EJECTED_INVALID_PR
OTOCOL_SLICE_COO
DINATES 

Recon Protocol Rejected due to 
invalid Slice Coordinates 

Recon rejected protocol 
because of invalid 
parameters. 

50 
RECON_DATA_CORR
UPTED 

System has encountered an 
unexpected error.  Please 
contact customer service with 
code: 

The Recon app reported 
data corruption (view 
headers not correct). 

51 
RECON_OFFSET_CAL_
FAILED 

System failed to properly 
perform protocol 
calibration.  Please try again.  If 
problem persists, please 
contact customer service with 
code: 

The Recon app reported 
Offset Cal failure. 

52 
RECON_AIR_CAL_FAI
LED 

System failed to properly 
calibration system.  Please try 
calibration again.  If problem 
persists, please contact 
customer service with code: 

The Recon app reported Air 
Cal failure. 

53 
RECON_OFFSET_CAL_
TIMEOUT 

System failed to properly 
perform protocol 
calibration.  Please try again.  If 
problem persists, please 
contact customer service with 
code: 

Scanner control app timed 
out waiting for an offset cal 
to complete. 

54 
RECON_OFFSET_PRO
TOCOL_TIMEOUT 

System failed to properly 
perform protocol 
calibration.  Please try again.  If 
problem persists, please 
contact customer service with 
code: 

Scanner control app timed 
out waiting for Recon app 
to acknowledge a protocol 
request (offset or image). 

55 
RECON_PROTOCOL_T
IMEOUT 

System is unable to perform 
protocol.  Please try again.  If 
problem persists, please 
contact customer service with 
code: 

Scanner control app timed 
out waiting for a scan to 
complete. 

56 
RECON_PROTOCOL_R
EJECTED 

System is unable to perform 
protocol.  Please try again.  If 
problem persists, please 

The Recon app rejected a 
scan protocol request. 
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Error 
code  

Error code 
description  

Popup description  Cause  

contact customer service with 
code: 

57 
RECON_POST_NO_SC
AN_INFO 

System is unable to perform 
post reconstruction.  Please try 
again.  If problem persists, 
please contact customer service 
with code: 

The image data was not 
found for a Post Recon or 
Resend Images command 
(where image data could 
be scan info file, .dcm files, 
.cor files, or entire 
directory). 

58 
RECON_POST_RECON
_FAILED 

System is unable to perform 
post reconstruction.  Please try 
again.  If problem persists, 
please contact customer service 
with code: 

A Post Recon or Resend 
Images command could not 
be run due to scanner 
state. 

60 PREPARE_FAILED 

The scanner encountered a 
fault preparing for scan.  Please 
contact customer service with 
code: 

A generic Prepare error 
occurred.  This should be 
accompanied by a more 
specific error.  See scanner 
log for detail. 

61 
DISK_PREPARE_ERRO
R 

Communications fault.  Please 
contact customer service with 
code: 

Disk subsystem reported 
an error during prepare. 

62 
CENTIPEDE_MOVE_TI
MEOUT 

The scanner failed to move to 
the correct location.  Please 
check for obstructions or debris 
on the floor that could impede 
the movement and try again.  If 
problem persists, please 
contact customer service with 
code: 

Scanner Control app timed 
out waiting for scanner to 
reach requested position; 
OR scanner did not reach 
required velocity for a 
scout or helical scan. 

63 
ANODE_STARTUP_TI
MEOUT 

X-ray power sequence 
fault.  Please contact customer 
service with code: 

Scanner Control app timed 
out waiting for anode 
device to report anode 
rotation is at speed. 

64 
DISK_NOT_IN_TICK_
MODE 

Rotational speed fault.  Please 
contact customer service with 
code: 

Scanner Control app timed 
out waiting for disk to get 
to tick mode (during 
prepare for scans that 
specify disk rotation). 

65 
COLLIMATOR_POSITI
ON_TIMEOUT 

Failure to position 
collimator.  Please contact 
customer service with code: 

Scanner Control app timed 
out waiting for collimator 
to get to requested 
position. 



BodyTom 64 User Manual Revision 04 

 

Appendix F    Error Code Page 403 of 412  

Error 
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Error code 
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Popup description  Cause  

66 
DCB_READY_TIMEOU
T 

DCB communication 
fault.  Please contact customer 
service with code: 

Scanner Control app timed 
out waiting for DCB to 
report "ready" state. 

67 
HEAT_EXCHANGER_E
RROR 

X-ray cooling fault.  Please 
contact customer service with 
code: 

Heat exchanger did not 
come on during prepare. 

68 FILAMENT_ERROR 

X-ray filament fault.  Please 
contact customer service with 
code: 

Scanner Control app timed 
out waiting for DCB to 
report "filament on"; OR 
for filament monitor to 
report > 10. 

69 
SERIAL_LINK_NOT_U
P 

Communications fault.  Please 
contact customer service with 
code: 

Scanner Control app timed 
out waiting for serial link to 
come up; OR serial link was 
lost before start Acq. 

70 
ROTATE_COMMAND
_FAILED 

Rotation communication 
error.  Please contact customer 
service with code: 

Unused error code. 

71 
TRANSLATE_COMMA
ND_FAILED 

Translate fault.  Please contact 
customer service with code: 

Move command to 
centipede device failed. 

72 
COULD_NOT_START_
SSP 

Software initialization 
fault.  Please contact customer 
service with code: 

SSP software (Scanner 
State and Position GUI, the 
GUIs that are on the 
scanner displays) did not 
start up. 

73 
ROTATE_TO_ANGLE_
FAILED 

Rotational fault.  Please contact 
customer service with code: 

Scanner Control app timed 
out waiting for "Rotate to 
Angle" operation. 

74 
COULD_NOT_CLEAR_
ROTATE_FAULT 

Rotation fault.  Please contact 
customer service with code: 

The rotate device has 
reported a fault, and the 
fault cannot be cleared. 

75 
ENCODER_CONSISTE
NCY_FAULT 

Encoder consistency 
fault.  Please contact customer 
service with code: 

Unused error code. 

76 
INTERLOCK_TEST_FAI
LED 

Interlock Test Failed.  Please 
ensure that e-stop is not 
engaged.  If e-stop is not 
engaged, please contact 
customer service with code: 

The interlock circuit either 
remained continuous after 
a Software Interlock was 
applied; OR the interlock 
circuit was broken when it 
was expected to be 
continuous. 

77 
DCB_TRIPPED_WDT_
FAULT 

DCB has reported a Watchdog 
Timeout event.  Please restart 
the scanner and if the problem 

DCB is in a bad state and 
needs to power cycle to 
reset the watchdog timer.  
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Error 
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Error code 
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persists, contact customer 
service with code: 

78 
DCB_MIB_LINK_FAUL
T 

MIB has reported a fault and 
can't acquire DAS data.  Please 
contact customer service with 
code: 

MIB software not loaded or 
MIB not powered, or data 
cable connection issue. 

80 DISK_SPACE_LOW 

System disk space low, please 
contact customer service with 
code: 

Unused error code. 

81 
DISK_SPACE_QUERY_
FAILED 

System disk space low, please 
contact customer service with 
code: 

Unused error code. 

82 

 
NOT_ALL_BASE_DEVI
CES_PRESENT 

  
  
  
  
  
  
  
  

Base communications 
fault.  Please contact customer 
service with code: 

Not all devices were found 
on Base CAN bus (or a 
device has become 
disconnected).  This should 
be accompanied by 
another error code 
describing which device(s) 
disconnected.  You can 
look at Scanner Control GUI 
for a status of which 
devices are present. 

83 
NOT_ALL_DISK_DEVI
CES_PRESENT 

Disk communications 
fault.  Please contact customer 
service with code: 

Not all devices were found 
on Disk CAN bus (or a 
device has become 
disconnected).  This should 
be accompanied by 
another error code 
describing which device(s) 
disconnected.  You can 
look at Scanner Control GUI 
for a status of which 
devices are present. 

90 
CCB_BATTERY_OPER
ATIONAL 

Battery system fault.  Please 
contact customer service with 
code: 

CCB device reported a (not) 
Operational Alarm 
(scanning not possible). 

91 
CCB_BATTERY_INTER
LOCK 

Battery system communication 
error.  Please contact customer 
service with code: 

CCB device reported an 
Interlock Alarm (scanning 
not possible). 

92 
CCB_BATTERY_MAIN
_BREAKER 

Circuit breaker has been 
tripped.  Please reset and 
contact customer service with 
code: 

Battery main breaker 
turned off.  Scanner is 
running on wall power 
only.  (Scanning not 
possible.) 
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Error code 
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Popup description  Cause  

93 
CCB_LOW_BATTERY_
ALARM 

Low battery condition.  Please 
charge system as soon as 
possible. 

CCB device reported a Low 
Battery Alarm (scanning 
not possible). 

94 
CCB_DEAD_BATTERY
_ALARM 

Dead battery condition.  The 
system is shutting down.  Please 
charge system and report 
condition to customer service 
with code: 

CCB device reported a 
Dead Battery Alarm (auto-
shutdown of scanner is 
imminent) (scanning 
DEFINITELY not possible). 

95 
CCB_HIGH_BATTERY_
ALARM 

High battery condition has 
occurred.  Battery charging has 
been disabled. 

CCB device reported a High 
Battery Alarm 

96 
CCB_OVERCGARGED_
BATTERY_ALARM 

Please power down and unplug 
system and contact customer 
service immediately with code: 

CCB device reported an 
Overcharged Battery 
Alarm.  This is beyond a 
High Battery warning and is 
serious.  The system should 
be turned off and 
unplugged immediately. 

97 
CCB_BATTERY_HIGH_
TEMP_ALARM 

Battery system fault.  Please 
contact customer service with 
code: 

CCB device reported a High 
Temp Alarm (scanning not 
possible). 

98 
CCB_BATTERY_OVER
_TEMP_ALARM 

Over temperature battery 
condition.  Please power down 
and unplug system and contact 
customer service immediately 
with code: 

CCB device reported an 
Over Temp Alarm.  This is 
beyond a High Temp 
warning and is serious.  The 
system should be turned 
off and unplugged 
immediately. 

99 
CCB_BATTERY_MEAS
UREMENT_ERROR 

Battery system fault.  Please 
contact customer service with 
code: 

CCB device reported a 
Measurement Error Alarm 
(scanning not possible) 

100 
CCB_BATTERY_IMBAL
ANCE_WARNING 

Battery system fault.  Please 
contact customer service with 
code: 

One or more battery 
voltage levels are not the 
same as the others.  No 
action required.  System 
will try to correct itself. 

110 

RECON_PROTOCOL_R
EJECTED_INVALID_PR
OTOCOL_USAGE_PAR
AMETER 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon received invalid 
usage parameter in 
protocol. 

111 

RECON_PROTOCOL_R
EJECTED_INVALID_N
UMBER_OF_VIEWS_P
ARAMETER 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon received invalid 
number of views in 
protocol. 



BodyTom 64 User Manual Revision 04 

 

Appendix F    Error Code Page 406 of 412  

Error 
code  
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112 

RECON_PROTOCOL_R
EJECTED_RUN_DMA_
SETUP 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon failed to initialize 
DMA in preparation for 
scan. 

113 

RECON_PROTOCOL_R
EJECTED_UNDEFINED
_USAGE 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon received undefined 
usage parameter in 
protocol. 

114 

RECON_PROTOCOL_R
EJECTED_INVALID_RA
W_DATA_REPLAY 

Reconstruction fault.  Please 
contact customer service with 
code: 

Unused error code. 

115 

RECON_PROTOCOL_R
EJECTED_FILES_RETRI
EVE_FAILED 

Reconstruction fault.  Please 
contact customer service with 
code: 

Unused error code. 

116 

RECON_PROTOCOL_R
EJECTED_INVALID_PA
RAMETER_STRUCTUR
E_SIZE 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon received incorrect 
structure size. 

117 

RECON_PROTOCOL_R
EJECTED_INVALID_PR
OTOCOL_FLASH_IO_C
MD 

Reconstruction fault.  Please 
contact customer service with 
code: 

Unused error code. 

118 

RECON_PROTOCOL_R
EJECTED_PREPARE_A
ND_PRIME_POST_RE
CON_USAGE 

Reconstruction fault.  Please 
contact customer service with 
code: 

Unused error code. 

119 

RECON_PROTOCOL_R
EJECTED_INVALID_P
OST_RECON_STATE 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon received a protocol 
while still processing 
previous protocol/post 
recon. 

120 

RECON_PROTOCOL_R
EJECTED_INVALID_M
ESSAGE_BODY_LENG
TH 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon received incorrect 
structure size. 

121 

RECON_PROTOCOL_R
EJECTED_INVALID_RE
LOAD_PARAMETER_F
ILES 

Reconstruction fault.  Please 
contact customer service with 
code: 

Unused error code. 

122 

RECON_PROTOCOL_R
EJECTED_INVALID_U
NSUPPORTED_COM
MAND 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon was sent an 
unsupported command 
from scanner control. 

123 

RECON_PROTOCOL_R
EJECTED_INVALID_HE
LICAL_FILTER_KERNE
L_TYPE 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon was sent an invalid 
helical filter kernel from 
workstation/scanner 
control. 
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124 

RECON_PROTOCOL_R
EJECTED_INVALID_N
UMBER_OF_HELICAL
_IMAGES_FOR_WIND
MILL 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon received an invalid 
number of images for 
windmill. 

125 

RECON_PROTOCOL_R
EJECTED_GPU_FAILE
D_TO_START 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon failed to initialize 
GPU during preparation for 
scan. 

126 

RECON_PROTOCOL_R
EJECTED_RECON_BU
SY 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon received a protocol 
while still processing 
previous protocol/post 
recon. 

130 

RECON_AIR_CAL_FAI
LED_NON_AIR_IMAG
E 

Reconstruction fault.  Please 
contact customer service with 
code: 

Air image above threshold 
for air calibration. 

131 
RECON_AIR_CAL_FAI
LED_SEND_EVENT 

Reconstruction fault.  Please 
contact customer service with 
code: 

Air calibration failed to be 
performed. 

132 

RECON_AIR_CAL_IM
AGE_EXCEEDS_THRES
HOLD 

Reconstruction fault.  Please 
contact customer service with 
code: 

Air image above threshold 
for air calibration. 

133 
RECON_AIR_CAL_FAI
LED_NO_VIEW_DATA 

Reconstruction fault.  Please 
contact customer service with 
code: 

No view data received 
during an air calibration. 

134 

RECON_AIR_CAL_FAI
LED_CORRUPTED_VIE
W_DATA 

Reconstruction fault.  Please 
contact customer service with 
code: 

Corrupted views received 
during air calibration. 

135 
RECON_OFFSET_CAL_
FAILED_SEND_EVENT 

Reconstruction fault.  Please 
contact customer service with 
code: 

Offset calibration failed to 
be performed. 

136 

RECON_OFFSET_CAL_
FAILED_NO_VIEW_D
ATA 

Reconstruction fault.  Please 
contact customer service with 
code: 

No view data received 
during an offset calibration. 

137 

RECON_OFFSET_CAL_
FAILED_CORRUPTED_
VIEW_DATA 

Reconstruction fault.  Please 
contact customer service with 
code: 

Corrupted views received 
during offset calibration. 

138 

RECON_OFFSET_CAL_
FAILED_BAD_REFERE
NCE 

Reconstruction fault.  Please 
contact customer service with 
code: 

Offset calibration failed 
due to bad reference. 

139 

RECON_OFFSET_CAL_
80_PERCENT_BAD_R
EFERENCE 

Please contact Customer 
Service immediately and run a 
Quality Assurance (QA) 
Phantom test to verify image 
quality.  Error code: 

80% of reference detector 
values are above the 
acceptable threshold 
during an offset cal. 
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140 
UPS_LOW_BATTERY_
ALARM 

Workstation low battery 
condition.  Please charge system 
as soon as possible. 

UPS device reported a Low 
Battery Alarm. 

141 
UPS_DEAD_BATTERY
_ALARM 

Workstation dead battery 
condition.  The Workstation is 
shutting down.  Please charge 
cart and report condition to 
customer service with code: 

UPS device reported a Dead 
Battery Alarm. 

142 
UPS_HIGH_BATTERY_
ALARM 

Workstation high battery 
condition has occurred.  Cart 
battery charging has been 
disabled. 

UPS device reported a High 
Battery Alarm. 

143 
UPS_OVERCHARGED_
BATTERY_ALARM 

Please power down and unplug 
workstation cart and contact 
customer service immediately 
with code:  

UPS device reported an 
Overcharged Battery 
Alarm.  This is beyond a 
High Battery warning and is 
serious.  The cart should be 
turned off and unplugged 
immediately. 

144 
UPS_BATTERY_HIGH_
TEMP_ALARM 

Workstation battery system 
fault.  Please contact customer 
service with code:  

UPS device reported a High 
Temp Alarm. 

145 
UPS_BATTERY_OVER
_TEMP_ALARM 

Workstation over temperature 
battery condition.  Please 
power down workstation, 
unplug cart and contact 
customer service immediately 
with code: 

UPS device reported an 
Over Temp Alarm.  This is 
beyond a High Temp 
warning and is serious.  The 
cart should be turned off 
and unplugged 
immediately. 

146 
UPS_BATTERY_MEAS
UREMENT_ERROR 

Workstation battery system 
fault.  Please contact customer 
service with code:  

UPS device reported a 
Measurement Error Alarm. 

147 
UPS_BATTERY_IMBAL
ANCE_WARNING 

Workstation battery system 
fault.  Please contact customer 
service with code:  

One or more battery 
voltage levels are not the 
same as the others.  No 
action required.  UPS will 
try to correct itself. 

148 
UPS_CHARGER_FAUL
T 

Workstation battery system 
fault.  Please contact customer 
service with code:  

UPS device reported a 
Charger fault. 

149 
RECON_GENERAL_FA
ILURE 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon software 
experienced an unknown 
failure. 
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150 
RECON_LIVE_SCAN_S
TATE_ERROR 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon got a Live Scan 
request while a Live Scan is 
already in progress. 

151 
RECON_QA_PHANTO
M_NOT_FOUND 

Reconstruction fault.  Please 
contact customer service with 
code: 

The QA Phantom was not 
found in the reconstructed 
image. 

152 
RECON_TIMED_OUT_
WAITING_FOR_EOE 

Reconstruction fault.  Please 
contact customer service with 
code: 

The scanner did not get 
End of Exam event from 
recon.  Possible that recon 
did not get all its views, 
indicating a DRB/DMA 
issue. 

153 
RECON_DRB_CONNE
CTION_FAILED 

Reconstruction fault.  Please 
contact customer service with 
code: 

Recon software was not 
able to connect to DRB 
device.  Possible DRB 
device or DMA driver error. 
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Appendix G  Revision History  

Table 72: Revision History  

Revision  ECO number  
Effective 
date  

Author  Changes  

00 ECO-005397 2021/04/28 Stephen Lombadozzi New Release 

01 ECO-006571 2023/01/30 Keith A. Kaser 

Revised BodyTom Elite manual 1-
NL4000-060rev19 to include 
updates required for new BodyTom 
64 systems. Added error code 78 
and updated error codes 140-153. 

02 ECO-006643 2023/03/29 Keith A. Kaser 

Updated Laser Safety Section, page 
58 (Bug# 5763) 
Removed unnecessary sentence 
from Administrative privileges 
section, page 73 (Bug# 5765) 
Modified Window Center/Level 
inconsistencies to all say Window 
Center (Bug# 5767) 
Modified use of the term Cine 
Backward to Cine Reverse for 
consistency with UI (Bug# 5769) 
Corrected typographical error on 
page 239 (Bug# 5774) 
Added detailed Scanner Start-up 
Shutdown directions as well as note 
that scanner shutdown will not 
occur if Tube Heat higher than 19% 
(Bug# 5781) 
Added unit values to graph on page 
383 (Bug# 5772) 
Updated CTDI Values in Tables 32, 
33, 34, 35, 36 and 37. 
 

03 ECO-006933   Keith A. Kaser  

Update to Table 15 per Intertek 
review to match testing report. 
Replace I-Book symbol with Blue 
Man symbol per Intertek feedback.  
Updated Window Width/Center 
information in table 64: Viewing 
Tools to be more in line with UI. 
Updated Error codes to re-number 
Recon error codes and added Error 
code 77 which was missing from the 
document.  

2023/12/05
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Revision  ECO number  
Effective 
date  

Author  Changes  

Made minor grammar and spelling 
corrections throughout the 

document.  

04   Keith A. Kaser 

Added Warning in Safety 
Information section related to 
decommissioning system to remove 
health software. 
Updated trade name and device 
name for clarity.  
Updated missing cross reference on 
page 70. 
Updated Product Marking plate in 
Figure 1. 
Reformatted and updated Contact 
Information table to include CE 
mark for European distributer as 
well as updated address for Brazilian 
Distributer. 
Added CE mark to Table of Symbols. 
Updated Table 62: Symbols. 
Updated Tables 33, 34, 35, 36 and 
38 to resolve Bug# 6339. 
Updated the “Using the 
Interventional Package” section to 
include the new Instant Repeat 
functionality. 
Update Workstation Product 
Marking Plate to include proper  
“Refer to instruction in user 
manual/booklet” icon.   

2025/03/24ECO-007472
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